FAQs

Understanding NetScaler Insight Center

How NetScaler Insight Center is Deployed in a Network

Before You Begin

Planning a NetScaler Insight Center Deployment

Installing NetScaler Insight Center Single Server Deployment

Installing NetScaler Insight Center on XenServer
Installing NetScaler Insight Center on VMware ESX
Installing NetScaler Insight Center on Microsoft Hyper-V

Installing NetScaler Insight Center Scale-Out Deployment

Upgrading NetScaler Insight Center

Managing NetScaler Insight Center

NetScaler Insight Center Deployment Management
Managing System Settings
Configuring Authentication and Authorization Settings
Configuring the External Authentication Server
Working with SSL Files
Configuring Clock Synchronization
Change Adaptive Threshold Setting
Configure DNS Server

NITRO API

Obtaining the NITRO Package
How NITRO Works
Java SDK
.NET SDK
Python SDK
REST Web Service

Accessing NetScaler Insight Center

Adding Devices

Enabling Data Collection
Enabling Web Insight Data Collection
Enabling HDX Insight Data Collection
Enabling WAN Insight Data Collection

Viewing the Reports
Web Insight Reports
HDX Insight Reports
WAN Insight Reports
Exporting reports

Web insight

HDX Insight

Gateway Insight

Security Insight

Cache Insight

Diagnostics

Troubleshooting Tips
FAQs

Nov 24, 2016

What is NetScaler Insight Center?
NetScaler Insight Center is a reporting and monitoring tool that collects AppFlow traffic generated across NetScaler ADCs or CloudBridge appliances and generates reports.

Is NetScaler Insight Center hardware or software?
NetScaler Insight Center is a virtual appliance designed to be installed on a XenServer hypervisor, VMware ESX, or Microsoft Hyper-V.

What configurations do I have to verify on the XenApp or XenDesktop server?
On a XenApp or XenDesktop server running version 6.5, if you require RTT calculations for idle connections, then make sure that the ICA round trip calculations for Idle Connections option is enabled for NetScaler Insight Center. If the option is disabled, enable it and execute the `gpupdate` command.

Note: The RTT calculation interval should be less than 60 seconds. By default, it is set to 30 seconds.

What type of reports does NetScaler Insight Center generate?
NetScaler Insight Center generates analytical reports, from which users can view the performance of applications, identify problem areas, and intelligently troubleshoot issues with performance and access.

Is there any physical connection required between the NetScaler appliances to be monitored and the XenServer?
No.

How do I specify the devices to be monitored by NetScaler Insight Center?
You add the devices to the NetScaler Insight Center inventory list. To do so, you have to specify the IP address, user name, and password of the device.

After I add the device, does NetScaler Insight Center start collecting information?
No. You must fist enable AppFlow on CloudBridge devices or virtual servers managed by the NetScaler appliance. When you enable AppFlow on NetScaler ADCs, you should specify an expression to identify the traffic for which the NetScaler appliance will generate AppFlow records.

Should I access the individual NetScaler appliance for enabling AppFlow?
No. All configuration is done from the NetScaler Insight Center user interface, which lists the virtual servers for a specific NetScaler appliance. Except when the NetScaler appliance is deployed in a transparent mode. For more information, see NetScaler Insight Center in a NetScaler ADC Transparent Mode.

Are all virtual servers on a NetScaler appliance listed for enabling AppFlow?
Currently, the NetScaler Insight Center user interface lists the load balancing, content switching, VPN, and cache redirection virtual servers for enabling AppFlow.

Should the virtual server be UP when you enable AppFlow on it?
Yes. To verify that the virtual server is UP, you can view its operational status on the NetScaler Insight Center user interface.

After I integrate NetScaler Insight Center with Desktop Director, Desktop Director does not display any records in my Chrome browser. What should I do?
If Desktop Director does not display any records, make sure that both Desktop Director and NetScaler Insight Center have either HTTPS or HTTP enabled. For details about NetScaler Insight Center configurations, see “Configuring Security Settings” in Managing System Settings.

How do I attach an additional disk to NetScaler Insight Center?
To attach an additional disk to NetScaler Insight Center:

1. Shut down the NetScaler Insight Center virtual machine.
2. In the hypervisor, attach an additional disk of the required disk size to NetScaler Insight Center virtual machine.
   For example, for a NetScaler Insight Center virtual machine of 120 GB, if you want to increase its disk space to 200 GB, you then need to attach a disk space of 200 GB instead of 80 GB. Newly attached 200 GB of disk space will be used to store Database data, NetScaler Insight Center log files. The existing 120 GB disk space will be used to store core files, Operating system log files, and so on.
3. Start the NetScaler Insight Center virtual machine.

What to do when a Database node goes down?
If a Database node goes down, NetScaler Insight Center does not generate any reports. After all the database nodes and connectors are restored to service, reboot the NetScaler Insight Center Server, and then reboot the agents.

Is there any specification for a NetScaler appliance to be monitored?
Yes, only NetScaler nCore appliances running version 10.1 or later software can be monitored. In addition, for HDX Insight, only NetScaler appliances running version 10.1 software can be monitored.

Can I add NetScaler appliances running different licenses?
Any nCore appliances running software version 10.1 or later build can be monitored by NetScaler Insight Center. However, the full set of counters and reports are generated only for Platinum-licensed NetScaler 10.1 appliances.
Can NetScaler Insight Center monitor a NetScaler high availability setup?
Yes. NetScaler Insight Center can monitor appliances in a high availability setup. Citrix recommends that you add both the appliances (primary and secondary) to the NetScaler Insight Center appliance. When the primary appliance fails, the secondary appliance generates the performance reports. You do not have to explicitly enable AppFlow on the secondary appliance.

Can a NetScaler cluster be monitored by NetScaler Insight Center?
Yes. NetScaler Insight Center supports monitoring of NetScaler cluster nodes.

Which version of NetScaler Insight Center can I use to monitor CloudBridge appliances?
CloudBridge monitoring is supported on NetScaler Insight Center release 10.5 build 51.10 and later.

Which CloudBridge appliances can I monitor using NetScaler Insight Center?
Only CloudBridge datacenter appliances (CloudBridge 2000, 2000WS, 3000, 4000, and 5000) can be monitored by NetScaler Insight Center.

Which version of CloudBridge software is supported by NetScaler Insight Center?
The CloudBridge version supported is 7.3.0 build 194 and later.

Does NetScaler Insight Center monitor both CloudBridge datacenter appliances and branch office appliances?
NetScaler Insight Center only monitors the CloudBridge datacenter appliances. However, CloudBridge datacenter appliances aggregate information from the CloudBridge branch-office appliances.

What CloudBridge deployment modes are supported by NetScaler Insight Center?

<table>
<thead>
<tr>
<th>Supported Deployments</th>
<th>Unsupported Deployments</th>
</tr>
</thead>
<tbody>
<tr>
<td>• In-line Mode</td>
<td>Group Mode</td>
</tr>
<tr>
<td>• Virtual In-line Mode (WCCP mode and PBR mode)</td>
<td></td>
</tr>
<tr>
<td>• High-Availability Mode (Only the primary node sends records)</td>
<td></td>
</tr>
</tbody>
</table>

What are the minimum XenApp or XenDesktop versions and Citrix Receiver versions required by NetScaler Insight Center to monitor CloudBridge appliances?

<table>
<thead>
<tr>
<th>Product</th>
<th>HDX Insight</th>
</tr>
</thead>
<tbody>
<tr>
<td>XenApp</td>
<td>6.5, build 6682 with HRP01</td>
</tr>
<tr>
<td>XenDesktop</td>
<td>5.6, build 56060</td>
</tr>
<tr>
<td></td>
<td>7.0 and higher versions</td>
</tr>
</tbody>
</table>

Table 1. XenApp/XenDesktop Versions and builds

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Receiver version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 7</td>
<td>3.4 Enterprise Edition</td>
</tr>
<tr>
<td></td>
<td>4.0 Standard Edition</td>
</tr>
<tr>
<td>Windows 8</td>
<td>3.4 Enterprise Edition</td>
</tr>
<tr>
<td></td>
<td>4.0 Standard Edition</td>
</tr>
<tr>
<td>Mac</td>
<td>11.8, build 238301 and above</td>
</tr>
<tr>
<td></td>
<td>Note: Mac client does not support ICA RTT reports for CloudBridge version 7.3.0.</td>
</tr>
<tr>
<td>Linux</td>
<td>13 and above</td>
</tr>
</tbody>
</table>

Table 2. Operating systems and receiver details

Which appliance is monitored, when both NetScaler ADC (with ICA proxy mode enabled) and CloudBridge appliances are in the network path?
NetScaler Insight Center monitors NetScaler ADC.
Which IP address is used by NetScaler Insight Center to monitor CloudBridge appliances?

- For CloudBridge 2000, 2000WS and 3000 appliances, NetScaler Insight Center uses CloudBridge Instance IP address.
- For CloudBridge 4000 and 5000 appliances, NetScaler Insight Center uses CloudBridge Accelerator IP address.

What are the default credentials to access CloudBridge appliances?
The default credentials are:
- Username: admin
- Password: admin_passwd

Can Management Service IP address (running on CloudBridge 4000 and 5000 appliances) be used to discover CloudBridge appliances?

No.

Can I use a CloudBridge VPX to demonstrate how NetScaler Insight Center collects reports from CloudBridge appliances?

NetScaler Insight Center does not support CloudBridge VPX.

However, if you want to use CloudBridge VPX for demonstration purpose, make sure that the CloudBridge VPX has primary and accelerated pairs (apA) configured.

For details, see the section "Configuring Inline Mode" in CloudBridge 7.4 product documentation.

What are the prerequisites to monitor CloudBridge appliances?

Before you start using NetScaler Insight Center to monitor a CloudBridge appliance, make sure that you have met the following prerequisites:

- The NTP server must be configured on both the CloudBridge appliance and NetScaler Insight Center. To add an NTP server to NetScaler Insight Center, see Configuring Clock Synchronization. These NTP servers must be closely synchronized to each other.
- Make sure that the CloudBridge appliances can communicate with NetScaler Insight Center by using port 4739.
- When both NetScaler ADC and CloudBridge appliance is located in the same network path, you cannot configure a single NetScaler Insight Center to monitor both the appliances. NetScaler ADC and CloudBridge appliance should use different NetScaler Insight Center virtual appliances for generating HDX Insight reports.
- Make sure that the CloudBridge appliance should only use the primary interface for sending AppFlow records.
- Do not configure the CloudBridge appliance at the branch office to send AppFlow records to NetScaler Insight Center.
- Verify that the CloudBridge appliance, XenApp or XenDesktop, and Receiver versions are supported by NetScaler Insight Center.
- To monitor the CloudBridge appliance, NetScaler Insight Center must successfully discover the CloudBridge appliance.
- Enable HDX data set on the CloudBridge appliance. To verify, on the Configuration tab, navigate to Appliance Settings > AppFlow.
- Make sure that the Update Interval is set to one minute on the CloudBridge appliance. Also, make sure that the IP address and port values are not deleted. To verify, on the Configuration tab, navigate to Appliance Settings > AppFlow.
- Make sure that CloudBridge ICA connections are accelerated with Disk Based Compression (DBC) policy. To verify, on the Configuration tab, navigate to Optimization Rules > Service Classes and in the right pane, expand ICA and click Edit. The Acceleration policy must be Disk.

Does the CloudBridge appliance generate AppFlow reports for non-accelerated ICA connections?

No. NetScaler Insight Center reports are generated only when CloudBridge ICA connections are accelerated with Disk Based Compression (DBC) policy.

To verify, on the Configuration tab, navigate to Optimization Rules > Service Classes and in the right pane, expand ICA and click Edit. The Acceleration policy must be Disk ICA connections. The ICA Service class policies that are not accelerated and configured with Flow Control policy, do not generate HDX Insight reports.

NetScaler Insight Center does not generate reports if CloudBridge ICA connections are accelerated with flow control policy.

Does NetScaler Insight Center support Multi Stream ICA (MSI) for CloudBridge appliances?

Currently NetScaler Insight center does not support collecting data records for MSI connections.

Is the CloudBridge Plug-in supported by NetScaler Insight Center reports?

Yes. ICA connections from Plug-in-equipped systems must be accelerated with DBC compression policy.

To verify, on the Configuration tab of the CloudBridge appliance, navigate to Optimization Rules > Service Classes and in the right pane, expand ICA and click Edit. The Acceleration policy must be Disk.

Are thin clients supported by NetScaler Insight Center?

NetScaler Insight Center supports thin clients, but the client type details in the User Agent reports display incorrect values.

Can a CloudBridge datacenter appliance and NetScaler ADC be added to the same NetScaler Insight Center, present in the same datacenter location?

No. This is not supported in this release.

Can I add multiple CloudBridge datacenter appliances (present in the same datacenter location) to the same NetScaler Insight Center?

Yes.

Is the CloudBridge appliance supported with Desktop Director?

Yes. CloudBridge appliance is supported with Desktop director. However, the WAN Jitter and DC Jitter values are not supported.

Why is the DC Latency value more than ICA RTT?

Ideally ICA RTT should be greater than the sum of WAN Latency and DC latency.

If the application is not actively sending data, then it does not work as expected. This is because, the TCP RTT estimation works only on active connections. If a connection is not very active or if it is idle, the DC latency value will be more than ICA RTT or WAN Latency.
What are the limitations of using Desktop Director Plug-in for generating HDX Insight reports for CloudBridge appliances?

- Desktop director does not correlate data across user sessions with NetScaler Insight Center, if CloudBridge generates a Replacement Session GUID (instead of using an Genuine GUID).
  
  To verify, on the CloudBridge appliance, navigate to Monitoring > ICA Advanced > Conn Info.

  This occurs if the customer is using an unsupported ICA Client or XenApp or XenDesktop server. For supported versions, see Supported Software.

- Desktop Director does not support WAN Jitter and LAN Jitter values.

What are the limitations of using thin clients for monitoring CloudBridge appliances?

The limitations of using thin clients to monitor CloudBridge appliances are listed in the following table:

<table>
<thead>
<tr>
<th>Serial Number</th>
<th>Thin Client</th>
<th>Model Number</th>
<th>Firmware version</th>
<th>Citrix Receiver / ICA Client version</th>
<th>Session GUID (Genuine/Replacement) required for Desktop Director Plug-in integration</th>
<th>IC A RTT Displayed or Not</th>
<th>Published Application works with NetScaler Insight Center</th>
<th>Published Desktop works with NetScaler Insight Center</th>
<th>Product ID (shown on CloudBridge)</th>
<th>Product ID (shown on NetScaler Insight Center)</th>
<th>User Agent (shown on NetScaler Insight Center)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Dell</td>
<td>Dell Wyse WTOS Model R1DL RxDL Thin Client</td>
<td>8.0_037</td>
<td>Replacement</td>
<td>Yes</td>
<td>N/A</td>
<td>Yes</td>
<td>Yes</td>
<td>WYSE ThinOS Client, terminal based client</td>
<td>Thin OS - WYSE Client</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Dell</td>
<td>Dell Wyse WTOS Model CX0 COX Xenith</td>
<td>2.0.01</td>
<td>Replacement</td>
<td>Yes</td>
<td>N/A</td>
<td>Does not work</td>
<td>Yes</td>
<td>Citrix Unix Client</td>
<td>Citrix Unix Client</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Dell</td>
<td>Dell Wyse WTOS Model TXO TOX Xenith2</td>
<td>HF 2.0_105</td>
<td>Replacement</td>
<td>Yes</td>
<td>N/A</td>
<td>[After logon, the GUI displays RDS and workstation desktops only. It does not display any applications.]</td>
<td>Yes</td>
<td>WYSE ThinOS Client, terminal based client</td>
<td>ThinOS-WYSE client</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Dell</td>
<td>Dell Wyse WTOS Model CX0 COX Xenith2</td>
<td>HF 2.0_214</td>
<td>Replacement</td>
<td>Yes</td>
<td>N/A</td>
<td>[After logon, the GUI displays RDS and workstation desktops only. It does not display any applications.]</td>
<td>Yes</td>
<td>WYSE ThinOS Client, terminal based client</td>
<td>ThinOS-WYSE client</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Dell</td>
<td>Dell Wyse WTOS Model CX0 COX CELLE</td>
<td>8.0_037</td>
<td>Replacement</td>
<td>Yes</td>
<td>No</td>
<td>Thin client is displayed but not the</td>
<td>Yes</td>
<td>WYSE ThinOS Client, terminal based client</td>
<td>Thin OS - WYSE Client</td>
<td></td>
</tr>
</tbody>
</table>

https://docs.citrix.com © 1999-2017 Citrix Systems, Inc. All rights reserved.
If I change the host name of the NetScaler appliance, will the NetScaler Insight Center inventory and Dashboard reflect the change?

Yes. NetScaler Insight Center reflects the changes every 30 minutes.

If the logon credentials of my device change, should I update that information in NetScaler Insight Center?

Yes. Fifteen seconds after the logon credentials of a device change, the NetScaler Insight Center inventory displays the state of the device as OUT-OF-SERVICE, but you can view the reports for the device. However, to continue collecting AppFlow records for the virtual servers managed by the NetScaler ADC, you must update the logon credentials in NetScaler Insight Center. For more information about updating the logon credentials in NetScaler Insight Center, see “Updating Login Credentials of Devices” in Managing NetScaler Insight Center.

If I update the login credentials, will the state of the device be "UP" immediately?

The state of the device in the NetScaler Insight Center inventory changes to "UP" after a few seconds.

My NetScaler appliance uses it's Subnet IP address (SNIP) as the source IP address for management access. Does NetScaler Insight Center collect data from the NetScaler appliances?

Yes. NetScaler Insight Center collects data from the NetScaler appliance. When adding the NetScaler appliance to NetScaler Insight Center inventory, specify the SNIP address used for management access as the IP address of the appliance.

How do I view the reports?

By default, the Dashboard page displays a performance chart of the devices monitored by NetScaler Insight Center. You can click on the chart to move to the next level of information.

Are reports generated for all devices added to the NetScaler Insight Center inventory?

No. Only if you enable AppFlow on a CloudBridge appliance, or at least one virtual server in the NetScaler appliance does NetScaler Insight Center collect data from that appliance and generate reports.

How are the reports organized?

You can view reports for devices, applications, URLs, clients and servers on the Web Insight node, and reports for users, applications, desktops, gateways and licenses on the HDX Insight node, by clicking on the respective data-point on the Dashboard. When you access the reports from one of these data points, you get a consolidated report for that data point. For example, click Applications to display the performance chart for all applications (across all NetScaler appliances) monitored by NetScaler Insight Center.

Even when the AppFlow is enabled on a NetScaler ADC, I do not see the reports on the Dashboard. What are the possible reasons?
Even if Appflow is enabled on the virtual servers, the services bound to the virtual servers might have AppFlow logging set to disabled. In that case, you might not see the reports in the dashboard. On the NetScaler appliance, enable AppFlow logging at the service level to view the reports. For more information, see Troubleshooting Tips.

Can I generate a diagnostics bundle from NetScaler Insight Center?
Yes. You can generate a diagnostics bundle and then contact Technical Support to debug an issue.

To generate the diagnostics bundle, on the Configuration tab, navigate to Diagnostics > Technical Support.

You can choose to collect the detailed debug information for the active sessions, and also collect database related detailed statistics.

For more information, see "Contacting Technical Support" in Diagnostics.

How to generate the diagnostics bundle by using the command line interface?
You can follow the below procedure if access to the GUI fails, or if you are unable to generate the diagnostics bundle by using the GUI.

1. SSH to NetScaler Insight Center.
2. Log on by using the following credentials:
   user name: nsrecover
   password: <password of the nsroot user>
3. Run the following command to generate the technical support file:
   /mps/scripts/techsupport.pl

   After the command is executed, the location of the technical support file is displayed.
   For example, var/mps/tech_support/InsightCenter__14Dec2015_05_55_28.tar.gz.

If there are multiple XenApp 6.5 and XenDesktop 7.0 farms, can I uniquely identify AppFlow data for each farm and display the unique data through Desktop Director?
HDX Insight integrated with Desktop Director in a XenDesktop 7.0 farm is limited to one HDX Insight collector per Desktop Director instance. You must have as many Desktop Director instances as you have farms, and configure each Desktop Director to monitor a different farm to obtain the HDX Insight data.

Can NetScaler Insight Center generate custom reports to display specific browser version information for each connection made?
No. This report is not available in NetScaler Insight Center at this time.

Is there a way to filter reports based on domain name?
No. This report is not available in NetScaler Insight Center at this time.
Understanding NetScaler Insight Center

Sep 07, 2016

In mobile, cloud, and virtual desktop environments, applications are deployed in a dynamic and distributed manner. In such an environment, monitoring the applications and diagnosing the application issues can be a challenge, which can affect the user experience and employee productivity.

NetScaler Insight Center, a virtual appliance that runs on XenServer, VMware ESX, or on Microsoft Hyper-V addresses the application visibility challenge by collecting detailed information about web-application and virtual-desktop traffic, such as flow, user-session-level information, web page performance data, and database information flowing through the NetScaler ADCs, NetScaler Gateway appliances, or CloudBridge appliances at your site and providing actionable reports. It enables IT administrators to troubleshoot as well as proactively monitor customer issues in matter of minutes.

To help you analyze the performance of the applications running on your appliances, NetScaler Insight Center provides insight into all of the components that might affect application performance, and generates performance reports.

NetScaler Insight Center has the following components:

- **Web Insight** that delivers data analytics for web traffic flowing through NetScaler ADCs.
- **HDX Insight** that delivers data analytics for XenApp and XenDesktop traffic flowing through NetScaler ADCs, NetScaler Gateway appliances, or CloudBridge appliances. HDX Insight collects reports when NetScaler ADCs are deployed in transparent mode, and when NetScaler Gateway appliances are deployed in single-hop mode or double-hop mode.
- **WAN Insight** that delivers data analytics for both accelerated and unaccelerated traffic flowing through CloudBridge appliances.
- **Gateway Insight** provides visibility into the failures that users encounter when logging on, regardless of the access mode. You can view a list of users logged on at a given time, along with the number of active users, number of active sessions, and bytes and licenses used by all users at any given time.
- **Security Insight** provides a single-pane solution to help you assess your application security status and take corrective actions to secure your applications.

Note: NetScaler Insight Center was earlier called NetScaler Insight. At the time of rebranding, the release number was changed from 1.0 to 10.1 aligning with a NetScaler release.

Web Insight provides visibility into web applications and allows IT administrators to monitor all web applications being served by NetScaler ADCs. Web Insight captures data about web traffic that flows between the clients and the servers, generates AppFlow records by doing deep inspection of the data, and presents the records as visual reports. These reports provide critical information such as user and server response time, enabling IT organizations to improve web application performance.

Key features of Web Insight include application-specific reports, URL-specific reports, and cache server-specific reports that provide visibility into cache performance. Web Insight also provides visibility into HTTP request methods, HTTP response status, client operating system, and user agents.

Information about client-side parameters enables you to evaluate user experience. Along with other capabilities, you can identify the top web applications accessed by clients and track their peak usage.

The administrators of web servers can use Web insight to answer any of the following questions:

- While accessing a particular application like SharePoint, which clients are experiencing high latency?
- In the past hour, which applications have had the most hits?
- For any given client, what are the applications and URLs that have been accessed?
- What operating system and browser is a particular client using?
- Which applications or servers are sending the most error-related responses?

HDX Insight provides administrators of Citrix XenApp and Citrix XenDesktop environments an easy way to monitor users and the performance of the applications hosted on NetScaler ADCs, NetScaler Gateway appliances, or CloudBridge appliances. HDX Insight captures data about the ICA traffic that flows between the clients and the servers, generates AppFlow records by doing deep inspection of the data, and presents the records as visual reports.
Note: HDX is built on top of the Citrix ICA protocol. ICA is a Citrix proprietary protocol used in XenApp/XenDesktop traffic. It is composed of virtual channels. A virtual channel is a bidirectional, error-free connection used for the exchange of generalized packet data between a Citrix host for online delivery (XenApp or XenDesktop) and the Citrix Receiver online plug-in. Connections for sound, graphics, client drive mapping, printing, and end user experience monitoring are a few examples of the virtual channels.

With HDX Insight, administrators can troubleshoot issues while accessing a particular published application through XenApp or XenDesktop.

For example, the administrators of Citrix XenApp and Citrix XenDesktop environments can use HDX Insight to answer the following questions:

- For a given XenDesktop user, what is the average client and server-side latency, and the average jitter?
- Which part of the network, the first Demilitarized zone (DMZ) or the second DMZ is causing a bad user experience?
- Which XenDesktop or XenApp users are consuming the most bandwidth over a given time period?
- Which virtual channels are consuming the most bandwidth over a given time period?
- What are the top applications across all XenApp users, by up-time and total number of launches over a given time period?
- What is the DC latency at the datacenter end of the CloudBridge appliance?

NetScaler Insight Center supports collecting information from NetScaler ADCs when they are deployed in Transparent mode or LAN User Mode. In this mode, the user is local to the XenApp and XenDesktop applications. NetScaler appliance is directly part of the traffic flow. No NetScaler Gateway is used.

NetScaler Gateway appliances can be deployed in different modes. HDX Insight supports collecting ICA reports from NetScaler Gateway appliances when they are deployed in any of the following modes:

- Single-Hop Mode: In this mode, a NetScaler Gateway appliance is used to connect to the XenApp and XenDesktop applications.
- Double-Hop Mode: In this mode, two NetScaler Gateway appliances are deployed to connect to the XenApp and XenDesktop applications.

NetScaler Insight Center also collects information from CloudBridge datacenter and branch appliances. For details, see NetScaler Insight Center in a CloudBridge Setup.

Note: NetScaler Insight Center can also be integrated with Desktop Director. In that case, to enable HDX Insight data collection, you must configure the NetScaler Insight Center virtual appliance in Desktop Director. For more information, see Configure HDX Insight.

A CloudBridge setup supports delivery of a large number of applications by greatly improving the efficiency of data flow across the network. However, maintaining maximum efficiency requires monitoring your network. For example, poor performance of critical applications can increase the latency in application delivery, and a particular branch office using maximum bandwidth can cause delays at other branch offices.

The WAN Insight feature of NetScaler Insight Center gives CloudBridge administrators an easy way to monitor the accelerated and unaccelerated WAN traffic that flows through CloudBridge datacenter and CloudBridge branch appliances, and it provides end-to-end visibility that includes client-specific data, application-specific data, and branch-specific data. With the ability to identify and monitor all the applications, clients, and branches on the network, you can effectively deal with the issues that degrade performance.

The WAN Insight feature provides powerful capabilities for failure analysis of your network, branches and applications. Live and historical reports enable you to be aware of performance issues before users raise complaints.
As a CloudBridge administrator, you can use WAN Insight to answer questions such as:

- Which client in a branch office is consuming the most bandwidth?
- What compression ratio is achieved at a particular branch?
- What is the latency at the CloudBridge datacenter appliance?

To view WAN Insight reports, you must first add the CloudBridge appliance to NetScaler Insight Center, and then enable AppFlow.
How NetScaler Insight Center is Deployed in a Network

May 04, 2017

NetScaler Insight Center monitors NetScaler ADCs when these appliances are deployed in transparent mode. It monitors NetScaler Gateway appliances when these appliances are deployed in single-hop mode or double-hop mode. Currently, in a CloudBridge deployment, NetScaler Insight Center does not monitor branch office traffic.

This topic includes the following details:
- NetScaler Insight Center in a NetScaler Appliance Transparent Mode
- NetScaler Insight Center in a NetScaler Gateway Single-Hop Mode
- NetScaler Insight Center in a NetScaler Gateway Double-Hop Mode
- NetScaler Insight Center in a NetScaler LAN User Mode
- NetScaler Insight Center in a CloudBridge Setup
- NetScaler Insight Center in a Multi-Hop Setup
- NetScaler Insight Center in a NetScaler Gateway Multi-Hop Mode

When a NetScaler ADC is deployed in transparent mode the clients can access the servers directly, with no intervening virtual server. The user is local to the server, and no NetScaler Gateway is used. That is, the ICA traffic is not transmitted over a VPN.

The following figure shows the network deployment of a NetScaler Insight Center when a NetScaler ADC is deployed in a transparent mode:

Figure 1. NetScaler Insight Center deployed in Transparent Mode

The NetScaler ADC resides between the clients and the servers. Typically, the NetScaler Insight Center and NetScaler ADC reside on the same subnet.
To monitor NetScaler ADCs deployed in this mode, you must add NetScaler Insight Center as an AppFlow collector on each NetScaler ADC, configure an Appflow policy to collect all or specific ICA traffic that flows through the ADC, and then view the reports on the NetScaler Insight Center dashboard. For details, see Enabling Data Collection for Monitoring NetScaler ADCs Deployed in Transparent Mode.

Updated: 2015-05-14

When NetScaler Gateway is deployed in single-hop mode, the NetScaler Gateway is at the edge of the network and proxies ICA connections to the desktop delivery infrastructure. This is the simplest and most common deployment. This mode provides security if an external user tries to access the internal network in an organization.

For more details, see Deploying NetScaler Gateway in the DMZ.

The following figure shows the network deployment of a NetScaler Insight Center when a NetScaler Gateway is deployed in a single-hop mode:

Figure 2. NetScaler Insight Center deployed in single-hop mode

In this mode, users access the NetScaler ADCs through a virtual private network (VPN). The setup requires two firewalls and a NetScaler Gateway to be deployed in a Demilitarized zone (DMZ) to secure access to the XenApp or XenDesktop environments. The NetScaler Gateway and the NetScaler Insight Center reside in the same subnet.

To monitor NetScaler Gateway appliances deployed in this mode, you must first add the NetScaler Gateway to NetScaler Insight Center inventory, enable AppFlow on NetScaler Insight Center and then view the reports on the NetScaler Insight Center dashboard.
The NetScaler Gateway double-hop mode provides additional protection to an organization's internal network because an attacker would need to penetrate multiple security zones or Demilitarized zones (DMZ) to reach the servers in the secure network.

For more details about double-hop mode, see Deploying NetScaler Gateway in a Double-Hop DMZ

If you want to analyze the number of hops (NetScaler Gateway appliances) through which the ICA connections pass, and also the details about the latency on each TCP connection and how it fairs against the total ICA latency perceived by the client, you must install NetScaler Insight Center so that the NetScaler Gateway appliances report these vital statistics.

The following image illustrates the network deployment of a NetScaler Insight Center in a NetScaler gateway double-hop setup.

Figure 3. NetScaler Insight Center deployed in double-hop mode

The NetScaler Gateway in the first DMZ handles user connections and performs the security functions of an SSL VPN. This NetScaler Gateway encrypts user connections, determines how the users are authenticated, and controls access to the servers in the internal network.

The NetScaler Gateway in the second DMZ serves as a NetScaler Gateway proxy device. This NetScaler Gateway enables the ICA traffic to traverse the second DMZ to complete user connections to the server farm.

The NetScaler Insight Center can be deployed either in the subnet belonging to the NetScaler Gateway appliance in the first DMZ or the subnet belonging to the NetScaler Gateway appliance second DMZ.

In the above image, the NetScaler Insight Center and NetScaler Gateway in the first DMZ are deployed in the same subnet.
How NetScaler Insight Center Collects Statistics in a NetScaler Gateway Double-Hop Mode

In a double-hop mode, NetScaler Insight Center collects TCP records from one appliance and ICA records from the other appliance.

After you add the NetScaler Gateway appliances to the NetScaler Insight center inventory and enable data collection, each of the appliances export the reports by keeping track of the hop count and connection chain ID.

For NetScaler Insight Center to identify which appliance is exporting records, each appliance is specified with a hop count and each connection is specified with a connection chain ID. Hop count represents the number of NetScaler Gateway appliances through which the traffic flows from a client to the servers. The connection chain ID represents the end-to-end connections between the client and server.

NetScaler Insight Center uses the hop count and connection chain ID to co-relate the data from both the NetScaler Gateway appliances and generates the reports.

To monitor NetScaler Gateway appliances deployed in this mode, you must first add the NetScaler Gateway to NetScaler Insight Center inventory, enable AppFlow on NetScaler Insight Center and then view the reports on the NetScaler Insight Center dashboard.

External users who access XenApp or XenDesktop applications must authenticate themselves on the NetScaler Gateway. Internal users, however, might not require to be redirected to the NetScaler Gateway. Also, in a transparent mode deployment, the administrator must manually apply the routing policies, so that the requests are redirected to the NetScaler appliance.

To overcome these challenges, and for LAN users to directly connect to XenApp and XenDesktop applications, you can deploy the NetScaler appliance in a LAN user mode by configuring a cache redirection virtual server, which acts as a SOCKS proxy on the NetScaler Gateway appliance.

The following figure shows the network deployment of a NetScaler Insight Center virtual appliance when a NetScaler appliance is deployed in LAN user mode:

Figure 4. NetScaler Insight Center deployed in LAN User Mode
NetScaler Insight Center and NetScaler Gateway appliance reside in the same subnet.

To monitor NetScaler appliances deployed in this mode, first add the NetScaler appliance to the NetScaler Insight inventory, enable AppFlow and then view the reports on the dashboard.

CloudBridge appliances optimize WAN links, and gives users maximum responsiveness and throughput at any distance. NetScaler Insight Center monitors the traffic flowing through the CloudBridge appliances deployed at the datacenter, and provides key insights into the WAN user experience.

For accelerating traffic over the link, CloudBridge appliances work in pairs, one at the datacenter and the other at the branch office. NetScaler Insight Center is deployed in the datacenter to monitor datacenter CloudBridge appliances.

The following figure shows the network deployment of a NetScaler Insight Center when CloudBridge appliances are deployed in between a client and a server:

Figure 5. Network Deployment of NetScaler Insight Center monitoring CloudBridge Datacenter appliance
In this setup, you must add both the branch appliance and the datacenter appliance to the NetScaler Insight Center inventory, and enable AppFlow for ICA traffic on the datacenter appliance.

Figure 6. Network Deployment of NetScaler Insight Center Monitoring a CloudBridge Datacenter Appliance and a CloudBridge Branch Appliance

In this setup, you must add both the branch appliance and the datacenter appliance to the NetScaler Insight Center inventory, enable AppFlow for ICA traffic on the branch appliance, and enable AppFlow for TCP, ICA, and WAN traffic on the datacenter appliance.

Figure 7. Network Deployment of NetScaler Insight Center Monitoring CloudBridge Plug-ins

In this setup, you must add both the branch appliance and the datacenter appliance to the NetScaler Insight Center inventory, enable AppFlow for ICA traffic on the branch appliance, and enable AppFlow for TCP, ICA, and WAN traffic on the datacenter appliance.
To accelerate the ICA proxy mode in NetScaler Gateway, you must configure and deploy the CloudBridge appliance.

In this setup, you must add the branch CloudBridge appliance, the datacenter CloudBridge appliance and the NetScaler Gateway appliance(s) to the NetScaler Insight Center inventory.

After you add the appliances to the NetScaler Insight center inventory and enable data collection, each of the appliances exports the reports by keeping track of the hop count and connection chain ID.

For NetScaler Insight Center to identify which appliance is exporting records, each appliance is specified in terms of hop count and each connection is specified with a connection chain ID. Hop count represents the number of appliances through which the traffic flows from a client to the servers. The connection chain ID represents the end-to-end connections between the client and server.

NetScaler Insight Center uses the hop count and connection chain ID to co-relate the data from the appliances and generates the reports.

You must enable connection chaining on the CloudBridge appliances to co-relate the data from the appliances. For details, see Figure 8. Network Deployment of NetScaler Insight Center monitoring CloudBridge Datacenter appliances and NetScaler Gateway appliance deployed in Single-Hop mode


Figure 9. Network Deployment of NetScaler Insight Center monitoring CloudBridge Datacenter appliances and NetScaler Gateway deployed in Double-Hop mode
In this setup, you must add both the branch appliance and the datacenter appliance to the NetScaler Insight Center inventory. Enable AppFlow for ICA on the branch appliance. On the datacenter CloudBridge appliance, enable AppFlow for TCP, ICA and WAN traffic. On one of the NetScaler Gateway appliance enable AppFlow for ICA, and enable AppFlow for TCP traffic on the other NetScaler Gateway appliance. For details see Enabling Data Collection for Monitoring CloudBridge Appliances and NetScaler Gateway Appliances in Double-Hop Mode.

With the multi-hop feature of NetScaler Insight Center, you can analyze the number of hops (NetScaler appliances, NetScaler Gateway appliances, or CloudBridge appliances) through which your ICA connections pass. You can also analyze the latency on each TCP connection and how it compares to the total ICA latency perceived by the client. The following figure shows the deployment of NetScaler Insight Center in a multi-hop setup.

The following image illustrates the network deployment of a NetScaler Insight Center in a NetScaler gateway multi-hop setup.

Figure 10. NetScaler Insight Center deployed in Multi-Hop Mode

In this type of setup, you must enable the multi-hop feature on NetScaler Insight Center, enable AppFlow on the NetScaler appliances, and enable connection chaining. Enabling the multi-hop feature is straightforward:
On the Configuration tab, click System. Then, in the right pane, click Configure Multi-Hop, and select the Multi-Hop check box.

However, if you enable NetScaler Insight Center to start collecting the ICA details from all the appliances, the collected details are redundant. All the appliances report the same metrics. To overcome this situation, you must enable AppFlow for ICA on one of the NetScaler Gateway appliances (preferably, the first appliance), and then enable AppFlow for TCP on the other appliances. One appliance then exports ICA AppFlow records, and the others export TCP AppFlow records. This also saves time in parsing the ICA traffic.

If you enable NetScaler Insight Center to start collecting the ICA details from all the appliances, the details collected are redundant. That is all the appliances report the same metrics. To overcome this situation, you must enable AppFlow for ICA on one of the NetScaler Gateway appliance (preferably, the first appliance), and then enable AppFlow for TCP on the other appliances. By doing so, one of the appliances export ICA AppFlow records and the other appliances export TCP AppFlow records. This also saves the processing time on parsing the ICA traffic.

To enable data collection on the first and second NetScaler Gateway appliances, see Enabling Data Collection for NetScaler Gateway Appliances Deployed in Double-Hop Mode.

To enable data collection on the third NetScaler appliance, see Enabling Data Collection for Monitoring NetScaler ADCs Deployed in Transparent Mode

To enable connection chaining on all the NetScaler and NetScaler Gateway appliances in the network, type: set appFlow param -connectionChaining ENABLED

Note: If you are accessing the XenApp or XenDesktop application through the third NetScaler appliance (third hop), then enable AppFlow for ICA on that NetScaler appliance.
Before You Begin

Apr 20, 2017

Before you install NetScaler Insight Center you must understand the software requirements, browser requirements, port information, license information, and limitations.

This topic includes the following details:
- Supported Software
- Ports
- Increased Storage Space
- Licensing Information
- Limitations

NetScaler Insight Center is compatible with the following products. Note that NetScaler Insight Center should be running a version that is either the same as or higher than the software version running on NetScaler or NetScaler Gateway devices.

<table>
<thead>
<tr>
<th>Product/NetScaler Insight Center Component</th>
<th>Web Insight</th>
<th>HDX Insight</th>
</tr>
</thead>
<tbody>
<tr>
<td>NetScaler</td>
<td>9.3, build 61.2 and later</td>
<td>10.1 build 112.15 and later</td>
</tr>
<tr>
<td></td>
<td>10.0, build 73.5 and later</td>
<td></td>
</tr>
<tr>
<td></td>
<td>10.1, build 112.15 and later</td>
<td></td>
</tr>
<tr>
<td>XenApp</td>
<td>-</td>
<td>6.5, build 6682 with HRP01</td>
</tr>
<tr>
<td>XenDesktop</td>
<td>-</td>
<td>5.6, build 56060</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7.0, build 3018</td>
</tr>
</tbody>
</table>

Note: The NetScaler Gateway feature (branded as Access Gateway Enterprise for versions 9.3 and 10) must be available on the NetScaler appliance. NetScaler Insight Center does not support standalone Access Gateway Standard appliances. NetScaler Insight Center can generate reports for applications that are published on XenApp or XenDesktop and accessed through Citrix Receiver. However, this capability depends on the operating system on which the receiver is installed. Currently, NetScaler ADC does not parse ICA traffic for applications or desktops that are accessed through Citrix Receiver running on iOS, or Android operating systems.

The following table lists the supported CloudBridge versions:

<table>
<thead>
<tr>
<th>CloudBridge Version</th>
<th>NetScaler Insight Center Version</th>
<th>NetScaler Version</th>
<th>Supportable Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.3.0+</td>
<td>10.5.55.8</td>
<td>10.5.55.8</td>
<td>HDX Insight</td>
</tr>
</tbody>
</table>
The following table lists the supported operating systems:

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Receiver version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>4.0 Standard Edition</td>
</tr>
<tr>
<td>Linux</td>
<td>13.0.265571 and later</td>
</tr>
<tr>
<td>MAC</td>
<td>11.8, build 238301 and later</td>
</tr>
<tr>
<td>HTML5</td>
<td>1.5*</td>
</tr>
<tr>
<td>Chromeapp</td>
<td>1.5*</td>
</tr>
</tbody>
</table>

* Applicable with CloudBridge release 7.4 and later.

The following table lists the supported web browsers:

<table>
<thead>
<tr>
<th>Web Browser</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internet Explorer</td>
<td>Internet Explorer 9 or later</td>
</tr>
<tr>
<td>Google Chrome</td>
<td>Chrome 19 or later</td>
</tr>
<tr>
<td>Safari</td>
<td>Safari 5.1.1 or later</td>
</tr>
</tbody>
</table>
The following Thin Clients support HDX Insight for NetScaler Insight Center release 11.0 build 65.35 and later:

- WYSE Windows based Thin Clients
- WYSE Linux based Thin Clients
- WYSE ThinOS based Thin Clients
- 10Zig Ubuntu based Thin Clients

NetScaler Insight Center also supports the following thin clients for monitoring CloudBridge deployments.

- Dell Wyse WTOS Model R10L Rx0L Thin Client
- NComputing N400
- Dell Wyse WTOS Model CX0 C00X Xenith
- Dell Wyse WTOS Model TX0 T00X Xenith2
- Dell Wyse WTOS Model CX0 C10LE
- Dell Wyse WTOS Model R00LX Rx0L HDX Thin Client
- Dell Wyse Enhanced Suse Linux Enterprise, Model DxoD, D50D
- Dell Wyse ZX0 Z90D7 (WEST) Thin Client

However, there are some limitations while using these thin clients. For details, see FAQs.

NetScaler Insight Center uses the NetScaler ADC's NetScaler IP (NSIP) address to communicate with the ADC. For communication purposes, the following ports must be open between the NetScaler ADC and NetScaler Insight Center.

### Table 4. Ports

<table>
<thead>
<tr>
<th>Component</th>
<th>Type</th>
<th>Port</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>NetScaler Insight Center</td>
<td>TCP</td>
<td>80/443</td>
<td>For NITRO communication from NetScaler Insight Center to NetScaler ADC or CloudBridge appliance</td>
</tr>
<tr>
<td></td>
<td>TCP</td>
<td>22</td>
<td>For SSH communication from NetScaler Insight Center to NetScaler or CloudBridge appliance</td>
</tr>
<tr>
<td></td>
<td>UDP</td>
<td>4739</td>
<td>For AppFlow communication from NetScaler to NetScaler Insight Center or CloudBridge appliance</td>
</tr>
<tr>
<td></td>
<td>ICMP</td>
<td>No reserved port</td>
<td>To detect the network reachability from NetScaler Insight Center to NetScaler or CloudBridge appliance</td>
</tr>
</tbody>
</table>

You can now increase the storage space of NetScaler Insight Center to more than 512 GB.

To increase the storage space of NetScaler Insight Center installed on a XenServer platform
1. Log on to XenCenter, and in the left-pane, expand XenServer and right-click the NetScaler Insight Center IP address for
which you want to increase the storage space.

2. Click Shut Down.

3. In the right-pane, click the Storage tab, and then click Attach Disk to add the local storage

4. In the left-pane, right-click the NetScaler Insight Center IP address and click Start.

To increase the storage space of NetScaler Insight Center installed on a VMware ESX platform

1. Log on to vSphere client and click Inventory.

2. Expand the virtual machine IP address, right-click the NetScaler Insight Center IP address, and then click Power Off.

3. In the right pane, click Resource Allocation and, in the Memory pane, click Edit.

4. On the Hardware tab, click Memory, click Add to add a new local storage space, and click OK.

5. In the left-pane, right-click the NetScaler Insight Center IP address and click Power On.

The data collected by the NetScaler Insight Center depends on the version and licenses of the NetScaler appliance being monitored.

Web Insight

Web Insight reports are displayed for NetScaler appliances running releases 9.3, 10, 10.1, 10.5, 11.0, and 11.1 as shown in Table 1, where 📉 indicates that the reports do not include response time, load time, render time, server processing time, client network latency, server network latency, or waterfall charts.

<table>
<thead>
<tr>
<th>License/ Version</th>
<th>9.3</th>
<th>10</th>
<th>10.1</th>
<th>10.5</th>
<th>11.0</th>
<th>11.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>📉</td>
<td>📉</td>
<td>📉</td>
<td>📉</td>
<td>📉</td>
<td>📉</td>
</tr>
<tr>
<td>Enterprise</td>
<td>📉</td>
<td>📉</td>
<td>📉</td>
<td>📉</td>
<td>📉</td>
<td>📉</td>
</tr>
<tr>
<td>Platinum</td>
<td>📉</td>
<td>📉</td>
<td>📉</td>
<td>📉</td>
<td>📉</td>
<td>📉</td>
</tr>
</tbody>
</table>

HDX Insight

HDX Insight reports are displayed only for NetScaler Platinum and Enterprise appliances running release 10.1, 10.5, 11.0, and 11.1.

<table>
<thead>
<tr>
<th>License/Duration</th>
<th>5 minutes</th>
<th>1 Hour</th>
<th>1 Day</th>
<th>1 Week</th>
<th>&gt; 1 Month</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>❌</td>
<td>❌</td>
<td>❌</td>
<td>❌</td>
<td>❌</td>
</tr>
<tr>
<td>Enterprise</td>
<td>✔</td>
<td>✔</td>
<td>❌</td>
<td>❌</td>
<td>❌</td>
</tr>
</tbody>
</table>
Note that from the NetScaler Insight Center 11.0 release, HDX Insight data is available for more than a month with the NetScaler Platinum license.

For appliances running a Platinum edition of XenApp or XenDesktop, HDX Insight reports can also be integrated with Director. For information about XenApp and XenDesktop licenses, see XenApp and XenDesktop 7.6 Feature Pack 3 Features.

You do not need a license for NetScaler Insight Center to monitor CloudBridge appliances.

Important: On NetScaler appliances running release 10.1 or later, you must install a Platinum license if you want to use third party collectors to extract HDX Insight reports.

Note: For information about reports, see Viewing Reports.

The limitations of NetScaler Insight Center are listed below:

- NetScaler Insight Center support IPv6 address for Management access only.

  * Applicable with CloudBridge release 7.3.1.

  * Applicable with CloudBridge release 7.3.1.
Installing NetScaler Insight Center Single Server Deployment

Jan 07, 2016

To monitor web and ICA traffic, you first install NetScaler Insight Center on one of the hypervisors and then add a device to the NetScaler Insight Center inventory. For Web Insight, you just need to enable data collection and start viewing reports. For HDX Insight, on NetScaler ADC and NetScaler Gateway, choose a mode first, then enable data collection to view reports. For CloudBridge appliances, directly enable data collection to view reports.

NetScaler Insight Center is a virtual appliance that must be deployed either on a Citrix XenServer server, VMware ESX server, or Microsoft Hyper-V.

Based on the platform you choose to install NetScaler Insight Center and your requirement to monitor web traffic or ICA traffic, the workflow changes accordingly. The following diagram describes this workflow.

After you have installed NetScaler Insight Center on one of the hypervisors, perform the following steps:

- Add Devices
- Enable Data Collection
- View Reports

The following diagram describes the workflow of NetScaler Insight Center:

Figure 1. Network Deployment of NetScaler Insight Center monitoring NetScaler ADC
Installing NetScaler Insight Center on XenServer

May 04, 2017
To install NetScaler Insight Center virtual appliances on Citrix XenServer, you use XenCenter.

This topic includes the following details:
- Prerequisites for Installing NetScaler Insight Center
- Installation Procedure

You install NetScaler Insight Center as a virtual appliance on a XenServer server. Before installing the NetScaler Insight Center virtual appliance, verify that the following requirements have been met:

- XenServer version 5.6 or later is installed on hardware that meets the minimum requirements.
- XenCenter is installed on a management workstation that meets the minimum requirements. You have to use XenCenter to install NetScaler Insight Center on XenServer.
- You have downloaded the NetScaler Insight Center.xva image file.

XenServer Requirements for NetScaler Insight Center

The following table lists the virtual computing resources that XenServer must provide for each NetScaler Insight Center virtual appliance.

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAM</td>
<td>3 GB or more</td>
</tr>
<tr>
<td>Virtual CPU</td>
<td>2 or more</td>
</tr>
<tr>
<td>Storage space</td>
<td>120 GB required*</td>
</tr>
<tr>
<td>Virtual Network Interfaces</td>
<td>1</td>
</tr>
<tr>
<td>Throughput</td>
<td>1 Gbps or 100 Mbps</td>
</tr>
</tbody>
</table>

For production use of NetScaler Insight Center, Citrix recommends that you set CPU priority (in virtual machine properties) to the highest level, to improve scheduling behavior and network latency.

On a XenApp or XenDesktop server running version 6.5, make sure that the **ICA round trip calculations for Idle Connections** option is enabled. If the option is not enabled, enable it and execute the `gpupdate` command. Also, the EUEM service must be running on the server.

Note: Verify that correct date, time, and time zone is configured on XenServer before NetScaler Insight Center is installed. For information about XenServer, see [XenServer product documentation](https://docs.citrix.com).
XenCenter System Requirements

XenCenter is a Windows client application. It cannot run on the same machine as the XenServer host. The following table describes the minimum system requirements.

Table 2. Minimum System Requirements for XenCenter Installation

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Windows 7, Windows XP, Windows Server 2003, or Windows Vista</td>
</tr>
<tr>
<td>.NET framework</td>
<td>Version 2.0 or later</td>
</tr>
<tr>
<td>CPU</td>
<td>750 megahertz (MHz), Recommended: 1 gigahertz (GHz) or faster</td>
</tr>
<tr>
<td>RAM</td>
<td>1 GB, Recommended: 2 GB</td>
</tr>
<tr>
<td>Network Interface Card</td>
<td>100 megabits per second (Mbps) or faster NIC</td>
</tr>
</tbody>
</table>

The number of NetScaler Insight Center instances that you can install depends on the memory available on the XenServer server.

To install NetScaler Insight Center

1. Start XenCenter on your workstation.
2. On the Server menu, click Add.
3. In the Add New Server dialog box, in the Hostname text box, type the IP address or DNS name of the XenServer that you want to connect to.
4. In the User Name and Password text boxes, type the administrator credentials set up during the XenServer installation, and then click Add. The XenServer server name appears in the navigation pane with a green circle, which indicates that the server is connected.
5. In the navigation pane, right-click the name of the XenServer server on which you want to install NetScaler Insight Center, and then click Import.
6. In the Import dialog box, from the Import Source node, browse to the location where you saved the NetScaler Insight Center xva image file. Make sure that the Exported VM option is selected, and then click Next.
7. Select the XenServer server on which you want to install the virtual appliance, and then click Next.
8. Select the local storage repository in which to store the virtual appliance, and then click Import to begin the import process.
   Note: Citrix recommends using local storage repository to store the virtual appliance.
9. You can add, modify, or delete virtual network interfaces as required. When finished, click Next.
10. Click Finish to complete the import process.
   Note: To view the status of the import process, click the Logs tab.
   When the import is complete, the kernel reboots.
11. Select the Console tab to display the NetScaler Insight Center Initial Network Configuration options for specifying the
initial IPv4 address, subnet mask (Netmask), and Gateway IP address for the NetScaler Insight Center virtual server. Note: If the wizard closes and you want to update the network details, run the networkconfig command from the command line interface.

12. If you want to install another NetScaler Insight Center virtual appliance, repeat steps 5 through 11.

After provisioning NetScaler Insight Center, you cannot increase the amount of storage space allocated to it, even if more space becomes available.
Installing NetScaler Insight Center on VMware ESX

Oct 30, 2015

To install NetScaler Insight Center virtual appliances on VMware ESX, use VMware vSphere client.

This topic includes the following details:
- Prerequisites for Installing NetScaler Insight Center
- Installation Procedure

Before you begin installing a virtual appliance, verify that the following requirements have been met:

- Install VMware ESX version 4.1 or later hardware that meets the minimum requirements.
- Install VMware Client on a management workstation that meets the minimum system requirements.
- Install VMware OVF Tool (required for VMware ESX version 4.1) on a management workstation that meets the minimum system requirements.
- Download the NetScaler Insight Center set up files.

**VMware ESX Hardware Requirements**

The following table lists the virtual computing resources that VMware must provide for each NetScaler Insight Center virtual appliance.

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAM</td>
<td>3 GB or more</td>
</tr>
<tr>
<td>Virtual CPU</td>
<td>2 or more</td>
</tr>
<tr>
<td>Storage space</td>
<td>120 GB required</td>
</tr>
<tr>
<td>Virtual Network Interfaces</td>
<td>1</td>
</tr>
<tr>
<td>Throughput</td>
<td>1 Gbps or 100 Mbps</td>
</tr>
</tbody>
</table>

The number of NetScaler Insight Center instances that you can install depends on the memory available on the VMware server.

**To install NetScaler Insight Center**

1. Start the VMware vSphere client on your workstation.
2. In the IP address / Name text box, type the IP address of the VMware ESX server that you want to connect to.
3. In the User Name and Password text boxes, type the administrator credentials, and then click Login.
4. On the File menu, click Deploy OVF Template.
5. In the Deploy OVF Template dialog box, in Deploy from a file or URL, browse to the location where you saved the NetScaler Insight Center setup files, select the .ovf file, and click Next.
   Note: If a warning message appears with the following text: The operating system identifier is not supported on the selected host, check to see if the VMware server supports FreeBSD operating system.
6. On the OVF Template Details page, click Next.
7. Type a name for the NetScaler Insight Center virtual appliance, and then click Next.
8. Specify the Disk Format by selecting either Thin provisioned format or Thick provisioned format.
   Note: Citrix recommends that you select Thick provisioned format.
9. Map the networks shown in the OVF template to the networks that you configured on the ESX host.
10. Click Next to start installing the NetScaler Insight Center virtual appliance on VMware ESX. When installation is complete, a pop-up window informs you of the successful installation.
11. Click Finish to complete the installation process.
    Note: To view the status of the installation process, click the Logs tab.
12. You are now ready to start the NetScaler Insight Center virtual appliance. In the navigation pane, select the virtual appliance that you just installed and, from the right-click menu, select Power On.
13. Select the Console tab to display the NetScaler Insight Center Initial Network Configuration options for specifying the initial IPv4 address, subnet mask (Netmask), and Gateway IP address for the NetScaler Insight Center virtual appliance. Once the installation is complete, the VMware client reboots.
14. If you want to install another NetScaler Insight Center virtual appliance, repeat steps 4 through 10.
Installing NetScaler Insight Center on Microsoft Hyper-V

May 04, 2017
To install NetScaler Insight Center virtual appliances on Hyper-V, use Hyper-V Manager client.

This topic includes the following details:
- Prerequisites for Installing NetScaler Insight Center
- Installation Procedure

Before you begin installing a virtual appliance, verify that the following requirements have been met:
- Install Microsoft Hyper-V Manager version 6.1 or 6.2 (for Windows server 2012) hardware that meets the minimum requirements.
- Install Hyper-V Manager client on a management workstation that meets the minimum system requirements.
- Download the NetScaler Insight Center setup files.

Microsoft Hyper-V Hardware Requirements

The following table lists the virtual computing resources that Microsoft Hyper-V must provide for each NetScaler Insight Center virtual appliance.

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAM</td>
<td>3 GB or more</td>
</tr>
<tr>
<td>Virtual CPU</td>
<td>2 or more</td>
</tr>
<tr>
<td>Storage space</td>
<td>120 GB req</td>
</tr>
<tr>
<td></td>
<td>• Hyper-V 6.1 version: 20 GB required</td>
</tr>
<tr>
<td></td>
<td>• Hyper-V 6.2 version: 120 GB required, 240 GB recommended</td>
</tr>
<tr>
<td>Virtual Network Interfaces</td>
<td>1</td>
</tr>
<tr>
<td>Throughput</td>
<td>1 Gbps or 100 Mbps</td>
</tr>
</tbody>
</table>

The number of NetScaler Insight Center instances that you can install depends on the memory available on the Hyper-V server.

To install NetScaler Insight Center
1. Start Hyper-V Manager client on your workstation.
2. On the Action menu, click Import Virtual Machine.
3. Import the Hyper-V image.
   - In Hyper-V version 6.1, in the Import Virtual Machine dialog box, in Location box, browse to the folder in which you saved the NetScaler Insight Center Hyper-V image, select the folder, and click Import.
   - In Hyper-V version 6.2, do the following:
     1. In the Import Virtual Machine dialog box, click Next. Then, in the Location box, browse to the folder in which you saved the NetScaler Insight Center Hyper-V image, select the folder, and click Import.
     2. In the Choose Import Type pane, select Copy the virtual machine (create a new unique ID) option and click Next.
     3. In the Choose Folders to Store Virtual Hard Disks pane, select the location in which you want to store the virtual hard disk, and then click Next.

   The NetScaler Insight Center Hyper-V image appears in the right pane.
4. Right-click the NetScaler Insight Center Hyper-V image and click Start.
5. Right-click the NetScaler Insight Center Hyper-V image again, and then click Settings.
6. In the left pane of the dialog box that appears, navigate to Hardware > VM_Bus Network Adaptor, and in the right pane, from the Network drop-down list, select the appropriate network.
7. Click Apply, and then click OK.
8. Select the Console tab to display the NetScaler Insight Center Initial Network Configuration options for specifying the initial IPv4 address and subnet mask.

Verification

Open any browser that NetScaler Insight Center supports, type the NetScaler Insight Center IP address, and provide the username and password.

The browser displays the NetScaler Insight Center configuration utility.
Accessing NetScaler Insight Center

Oct 30, 2015
After installing NetScaler Insight Center, you can access it from the configuration utility, by typing the IP address of the NetScaler Insight Center virtual appliance in the address bar of the browser.

Enter the logon credentials that you specified when you installed the NetScaler Insight Center appliance. Note: The default username and password to log on to NetScaler Insight Center are nsroot and nsroot, respectively. After you validate your credentials, the Welcome screen appears. Click Get Started and follow the instructions to add at least one NetScaler ADC, one NetScaler Gateway, or one CloudBridge appliance to the NetScaler Insight Center inventory and start monitoring the devices. To add additional devices, see Adding Devices.

To programmatically access the NetScaler Insight Center and enable data collection, see NITRO API.
Adding Devices

Sep 07, 2016

In addition to the NetScaler ADC, NetScaler Gateway, or CloudBridge appliance that you added to the inventory when you accessed NetScaler Insight Center for the first time, you must add any additional appliances that you want to monitor.

Points to remember

- Only nCore NetScaler appliances running version software 9.3 or later can be added to the inventory. You cannot add standalone NetScaler Gateway appliances.
- NetScaler Insight Center can monitor appliances in a high availability setup. Citrix recommends that you add both the appliances (primary and secondary) to the NetScaler Insight Center appliance. When the primary appliance fails, the secondary appliance generates the performance reports. You do not have to explicitly enable AppFlow on the secondary appliance.
- You cannot monitor a NetScaler cluster setup.
- Make sure that both the NetScaler appliance and the NetScaler Insight Center appliance have either HTTP access or HTTPS access enabled. For details about configurations, see "Configuring Security Settings" in Managing System Settings.
- Citrix recommends not adding a NetScaler appliance to the inventory if the appliance's user access level is set to read only.
- For a NetScaler SD-WAN WANOP device type, enter the primary IP address of the NetScaler SD-WAN WANOP appliance.

To add a device

1. On the Configuration tab, navigate to Inventory and click Add. All devices added to NetScaler Insight Center are shown on the Inventory page.
2. Enter the source IP address from which the NetScaler or CloudBridge appliance sends AppFlow records. Also enter the user name and password required for access to the device.
   Points to Note:
   - If the NetScaler appliance uses a Subnet IP (SNIP) address as the source IP address for AppFlow records, specify that the SNIP address as the NetScaler IP address.
   - Select the Gateway option if, in a double-hop setup, one of the appliances that you are adding is a NetScaler Gateway. For details on double-hop mode, see How NetScaler Insight Center is Deployed in a NetScaler Gateway Double-Hop Mode.
3. Click Add.
   Note: You can delete devices from the Inventory list by selecting the row that lists the NetScaler appliance and clicking Delete.
   When the appliance is added, information about the appliance appears in the Inventory list.

After you add the devices, you must enable data collection and then view reports on the NetScaler Insight Center dashboard.

https://docs.citrix.com © 1999-2017 Citrix Systems, Inc. All rights reserved. p.36
Enabling Data Collection

May 04, 2017

You must enable data collection to start gathering information about the traffic flowing through the NetScaler ADCs or CloudBridge appliances.

To monitor NetScaler ADCs, NetScaler Insight Center gathers metrics from load balancing, content switching, cache redirection, and NetScaler Gateway virtual servers. To enable data collection, you must enable AppFlow on each virtual server from which you want to collect data. When enabling AppFlow, you must specify policy expressions to identify the traffic for which you want the NetScaler Insight Center virtual appliance to retrieve data. The NetScaler ADC then generates AppFlow records for traffic that matches the expression.

For information on policy expressions, see Policies and Expressions.

When you enable data collection, NetScaler Insight Center starts collecting information about the applications represented by the virtual servers and presents the collected information as performance reports on the dashboard.

To enable data collection on CloudBridge devices, you must enable AppFlow on the NetScaler Insight Center graphical user interface for the required CloudBridge appliance. After you enable AppFlow, NetScaler Insight Center starts collecting the information.

Points to remember

- Make sure that the services bound to the virtual servers also have AppFlow logging enabled.
- The timestamp of the CloudBridge appliance must be in sync with the NTP server.
- If you want to use NTP server time on the NetScaler Insight Center, make sure that you configure NTP before enabling AppFlow on the CloudBridge appliances or virtual servers of the NetScaler ADCs. For information about synchronizing the local time of an NetScaler Insight Center appliance with the NTP server, see Configuring an NTP Server.

Note:

- Web Insight supports HTTP, SSL and TCP virtual servers and HDX Insight supports VPN virtual servers.
- If AppFlow is enabled for a virtual server on more than one NetScaler Insight Center virtual appliance, the one on which the AppFlow was most recently enabled collects the information. For example, if AppFlow is enabled for virtual server abc on a NetScaler Insight Center virtual appliance at 10.102.60.89 on 1/3/2013, and on 3/3/2013 AppFlow is enabled for virtual server abc on another virtual appliance at 10.102.56.78, the virtual appliance at 10.102.60.89 stops retrieving information from virtual server abc.
- You cannot enable AppFlow from a NetScaler Insight Center for a NetScaler ADC or CloudBridge appliance on which AppFlow is already enabled for four AppFlow collectors. Each NetScaler Insight Center functions as an AppFlow collector, and you can put only four AppFlow collectors on one NetScaler ADC or on one CloudBridge appliance.
- Citrix does not recommend adding IPv6 NetScaler appliances and virtual servers, or IPv6 CloudBridge appliances. NetScaler Insight Center does not support IPv6.
- Before enabling data collection on cache redirection servers, enable cache redirection on the NetScaler ADC.
- If you enable cache redirection on any of the NetScaler ADCs listed in the inventory, the dashboard does not display Applications node for Web insight. Instead, NetScaler Insight Center displays the reports for all the domains accessed by the client.
Enabling Web Insight Data Collection

May 04, 2017

When AppFlow is enabled for Web Insight data collection, the NetScaler Insight Center retrieves the performance reports of web applications (load balancing and content switching virtual servers) that are bound to the NetScaler ADC.

To enable data collection on a virtual server for Web Insight

1. On the Configuration tab, click Inventory.
2. From the inventory list, select the IP address of the ADC on which you want to enable data collection.
3. On the NetScaler Insight Center Inventory Setup screen, in the Application List pane, from the View drop-down list, select the type of virtual server (Load Balancing, Cache Redirection, or Content Switching).
   Note: Before enabling data collection on cache redirection servers, enable cache redirection on the NetScaler ADC.
   The virtual servers of the specified type populate a table that includes the following information:
   - IP Address—IP address of the virtual server
   - Name—Name of the virtual server
   - State—Current operational state of the virtual server. Can be UP or DOWN
   - Type—Service type of the virtual server
   - Insight—Data-collection status of the virtual server (ENABLED or DISABLED)
4. Select a virtual server for which you want to enable data collection.
   Note: You can enable data collection on a virtual server only if the operational state of the virtual server is UP.
5. From the Action drop-down list, select Enable AppFlow.
6. In the Enable AppFlow dialog box, from the Select Expression drop-down list, specify the traffic to be filtered by selecting one of the available expressions or by manually typing the expression. You can also use multiple expressions by using the logical operators AND (&&) or OR (||).
   The following are examples of some expressions that can be used:
   - To collect information about HTTP requests where URL contains the word images, specify the expression
     HTTP.REQ.URL.CONTAINS("images")
   - To collect information about HTTP virtual servers which have greater than 15000 connections, specify the expression
     HTTP.REQ.LB_VSERVER.CONNECTIONS.GE(15000)
   - To collect information about HTTP requests where URL suffix is not json and css, specify the expression
     HTTP.REQ.URL.SUFFIX.EQ("json").NOT && HTTP.REQ.URL.SUFFIX.EQ("css").NOT
   - To collect information about HTTP requests where hostname contains the word abc.com and HTTP requests where cookie contains the word JSESSIONID, specify the expression
     HTTP.REQ.HOSTNAME.CONTAINS("abc.com")&&HTTP.REQ.COOKIE.CONTAINS("JSESSIONID")
   - To collect the information for all the traffic that flows through the virtual server, specify the expression true
   For more information on expressions, see "Policies and Expressions".
   Note: After enabling data collection on a virtual server, if you want to edit the expression that you selected, select the virtual server, and then select Edit AppFlow Expression from the Action drop-down list.
7. Select the HTML Injection check box. When this option is selected, the web insight reports will include information about load time and render time, which is useful for comparing the performance of web applications.
   Note: On NetScaler 10 appliances, the HTML Injection feature is available only for Platinum licenses. On NetScaler 10.1 appliances, it is available for all licenses.
8. Click OK to save the configuration. If data collection is enabled, the Insight column in the Application List table for that virtual server displays the word Enabled.

Note: If AppFlow logging is not enabled for the respective services or service groups on the NetScaler appliance, the NetScaler Insight Center dashboard does not display the records, even if the Insight column shows Enabled.

9. To return to the inventory list, from the Action drop-down, select Return to Inventory list.
Enabling HDX Insight Data Collection

May 04, 2017

HDX Insight collects data about virtual desktop connections. For CloudBridge appliances, it collects the traffic flowing at the datacenter end, generates AppFlow records and presents them as visual reports.

This release of NetScaler Insight Center is compatible with the following XenApp and XenDesktop version and builds.

Table 1. Software Versions and Builds

<table>
<thead>
<tr>
<th>Software</th>
<th>Version</th>
<th>Build</th>
</tr>
</thead>
<tbody>
<tr>
<td>XenApp</td>
<td>6.5</td>
<td>6682 with HRP01</td>
</tr>
<tr>
<td>XenDesktop</td>
<td>5.6</td>
<td>56060</td>
</tr>
<tr>
<td></td>
<td>7.0 and higher versions</td>
<td>-</td>
</tr>
</tbody>
</table>
Enabling Data Collection for Monitoring NetScaler ADCs Deployed in Transparent Mode

May 04, 2017

After you add the NetScaler ADC to the NetScaler Insight Center inventory, you must enable AppFlow for data collection. Enabling data collection depends on the device and the mode. If a NetScaler appliance is deployed in transparent mode in a XenApp/XenDesktop environment, the ICA traffic is not transmitted over a VPN. In that case, you have to add NetScaler Insight Center as an AppFlow collector on each NetScaler appliance, and you must configure an Appflow policy to collect all or specific ICA traffic that flows through the appliance.

Note:
- You cannot enable data collection on a NetScaler ADC deployed in transparent mode by using the NetScaler Insight Center configuration utility.
- For detailed information about the commands and their usage, see Command Reference.
- For information on policy expressions, see Policies and Expressions.

To configure data collection on a NetScaler appliance by using the command line interface

At the command prompt, do the following:

1. Log on to an appliance.
2. Specify the ICA ports at which the NetScaler appliance listens for traffic.
   ```
   set ns param -icaPorts <port>...
   ```
   Example:
   ```
   set ns param -icaPorts 2598 1494
   ```
   Note:
   - You can specify up to 10 ports with this command.
   - The default port number is 2598. You can modify the port number as required.
3. Add NetScaler Insight Center as an appflow collector on the NetScaler appliance.
   ```
   add appflow collector <name> -IPAddress <ip_addr>
   ```
   Example:
   ```
   add appflow collector MyInsight -IPAddress 192.168.1.101
   ```
   Note: A NetScaler appliance supports a maximum four Appflow collectors. If there are already four Appflow collectors configured, you cannot add another AppFlow collector (in this case, NetScaler Insight Center) to the NetScaler appliance. Delete an existing Appflow collector to add a new collector. To view the appflow collectors configured on the NetScaler appliance, use the show appflow collector command.
4. Create an appflow action and associate the collector with the action.
   ```
   add appflow action <name> -collectors <string>...
   ```
   Example:
   ```
   add appflow action act -collectors MyInsight
   ```
5. Create an appflow policy to specify the rule for generating the traffic.
   ```
   add appflow policy <policyname> <rule> <action>
   ```
   Example:
add appflow policy pol true act

6. Bind the appflow policy to a global bind point.
   bind appflow global <policyname> <priority> -type <type>

   Example:
   bind appflow global pol 1 -type ICA_REQ_DEFAULT

   Note: The value of type should be ICA_REQ_OVERRIDE or ICA_REQ_DEFAULT in order to apply to ICA traffic.

7. Set the value of the flowRecordInterval parameter for Appflow to 60 seconds.
   set appflow param -flowRecordInterval 60

   Example:
   set appflow param -flowRecordInterval 60

8. Save the configuration. save ns config
Enabling Data Collection for NetScaler Gateway Appliances Deployed in Single-Hop Mode

May 04, 2017

In single-hop mode, users access the NetScaler appliances through a virtual private network (VPN).

To start collecting the reports, you must add the NetScaler Gateway appliance to the NetScaler Insight Center inventory and enable AppFlow on NetScaler Insight Center.

To enable data collection

1. On the Configuration tab, click Inventory.
2. From the inventory list, select the IP address of the appliance on which you want to enable data collection.
3. On the NetScaler Insight Center Inventory Setup screen, in the Application List pane, from the View drop-down list, select VPN. A list of the SSL VPN virtual servers configured on the appliance populates a table with the following information about each virtual server:
   - IP Address—IP address of the virtual server
   - Name—Name of the virtual server
   - State—Current operational state of the virtual server. Can be UP or DOWN.
   - Type—Service type of the virtual server.
   - Insight—Data-collection status of the virtual server (ENABLED or DISABLED).
4. Select the VPN virtual server for which you want to enable data collection.
   Note: You can enable data collection on a virtual server only if the operational state of the virtual server is UP.
5. From the Action drop-down list, select Enable Appflow.
6. In the Enable AppFlow dialog box, from the Select Expression drop-down list, specify the traffic to be filtered.
   Note: Currently, the only expression supported is true.
   For more information on expressions, see Policies and Expressions.
7. From the Export Option drop-down list, select ICA.
8. Click OK to save the configuration. If data collection is enabled, the Insight column in the Application List table displays as enabled.
   Note: If AppFlow logging is not enabled for the respective services or service groups on the NetScaler appliance, the NetScaler Insight Center dashboard does not display the records, even if the Insight column shows Enabled.
9. To return to the inventory list, from the Action drop-down, select Return to Inventory list.

Note: The following commands are executed in the background when you enable AppFlow in single-hop mode. These commands are explicitly specified here for troubleshooting purposes.
- add appflow collector <name> -IPAddress <ip_addr>
- add appflow action <name> -collectors <string>
- set appflow param -flowRecordInterval <secs>
- disable ns feature AppFlow
- enable ns feature AppFlow
- add appflow policy <name> <rule> <expression>
- set appflow policy <name> -rule <expression>
- bind vpn vserver <vsname> -policy <string> -type <type> -priority <positive_integer>
- set vpn vserver <name> -appflowLog ENABLED
• save ns config
Enabling Data Collection for NetScaler Gateway Appliances Deployed in Double-Hop Mode

Oct 30, 2015

To enable data collection you must perform the following operations:

- Enable data collection on NetScaler Insight Center to start gathering the traffic information
- Configure NetScaler Gateway appliances to export the data

If you enable NetScaler Insight Center to start collecting the ICA details from both the appliances, the details collected are redundant. That is both the appliances report the same metrics. To overcome this situation, you must enable AppFlow for ICA on one of the first NetScaler Gateway appliance, and then enable AppFlow for TCP on the second appliance. By doing so, one of the appliances export ICA AppFlow records and the other appliance exports TCP AppFlow records. This also saves the processing time on parsing the ICA traffic.

To enable data collection for ICA traffic

1. On the Configuration tab, click **Inventory**.
2. From the inventory list, select the IP address of the appliance on which you want to enable data collection.
3. On the NetScaler Insight Center Inventory Setup screen, in the Application List pane, from the View drop-down list, select **VPN**. A list of the SSL VPN virtual servers configured on the appliance populates a table with the following information about each virtual server:
   - **IP Address**—IP address of the virtual server
   - **Name**—Name of the virtual server
   - **State**—Current operational state of the virtual server. Can be UP or DOWN.
   - **Type**—Service type of the virtual server.
   - **Insight**—Data-collection status of the virtual server (ENABLED or DISABLED).
4. Select the SSL VPN virtual server for which you want to enable data collection.
   - Note: You can enable data collection on a virtual server only if the operational state of the virtual server is UP.
5. From the Action drop-down list, select **Enable Appflow**.
6. In the Enable Appflow dialog box, from the Select Expression drop-down list, specify the traffic to be filtered.
   - Note: Currently, the only expression supported is true.
   - For more information on expressions, see **Policies and Expressions**.
7. From the Export Option drop-down list, select **ICA**.
8. Click **OK** to save the configuration. If data collection is enabled, the Insight column in the Application List table displays as enabled.
   - Note: If AppFlow logging is not enabled for the respective services or service groups on the NetScaler appliance, the NetScaler Insight Center dashboard does not display the records, even if the Insight column shows Enabled.
9. To return to the inventory list, from the Action drop-down, select Return to Inventory list.

To enable data collection for TCP traffic

1. On the Configuration tab, click **Inventory**.
2. From the inventory list, select the IP address of the appliance on which you want to enable data collection.

3. On the NetScaler Insight Center Inventory Setup screen, in the Application List pane, from the **View** drop-down list, select VPN. A list of the SSL VPN virtual servers configured on the appliance populates a table with the following information about each virtual server:
   - **IP Address**—IP address of the virtual server
   - **Name**—Name of the virtual server
   - **State**—Current operational state of the virtual server. Can be UP or DOWN.
   - **Type**—Service type of the virtual server.
   - **Insight**—Data-collection status of the virtual server (ENABLED or DISABLED).

4. Select the SSL VPN virtual server for which you want to enable data collection.
   Note: You can enable data collection on a virtual server only if the operational state of the virtual server is UP.

5. From the Action drop-down list, select **Enable Appflow**.

6. In the Enable AppFlow dialog box, from the Select Expression drop-down list, specify the traffic to be filtered.
   Note: Currently, the only expression supported is true.
   For more information on expressions, see Policies and Expressions.

7. From the Export Option drop-down list, select TCP.

8. Click **OK** to save the configuration. If data collection is enabled, the Insight column in the Application List table displays as enabled.
   Note: If AppFlow logging is not enabled for the respective services or service groups on the NetScaler appliance, the NetScaler Insight Center dashboard does not display the records, even if the Insight column shows Enabled.

9. To return to the inventory list, from the Action drop-down, select Return to Inventory list.

After you install the NetScaler Gateway appliances, you must configure the following settings on the NetScaler gateway appliances to export the reports to NetScaler Insight Center:

- Configure virtual servers of the NetScaler Gateway appliances in the first and second DMZ to communicate with each other.
- Bind the NetScaler Gateway virtual server in the second DMZ to the NetScaler Gateway virtual server in the first DMZ.
- Enable double hop on the NetScaler Gateway in the second DMZ.
- Disable authentication on the NetScaler Gateway virtual server in the second DMZ.
- Enable one of the NetScaler Gateway appliances to export ICA records
- Enable the other NetScaler Gateway appliance to export TCP records:
- Enable connection chaining on both the NetScaler Gateway appliances.

**Configuring NetScaler Gateway Using the command line interface**

1. Configure the NetScaler Gateway virtual server in the first DMZ to communicate with the NetScaler Gateway virtual server in the second DMZ.
   
   ```
   add vpn nextHopServer <name> <nextHopIP> <nextHopPort> [-secure (ON|OFF)] [-imgGifToPng] ...
   ```

   ```
   add vpn nextHopServer nh1 10.102.2.33 8443 –secure ON
   ```

2. Bind the NetScaler Gateway virtual server in the second DMZ to the NetScaler Gateway virtual server in the first DMZ.
   Run the following command on the NetScaler Gateway in the first DMZ:

   ```
   bind vpn vserver <name> -nextHopServer <name>
   ```

   ```
   bind vpn vserver vs1 -nextHopServer nh1
   ```
3. Enable double hop and AppFlow on the NetScaler Gateway in the second DMZ.
   set vpn vserver <name> [-doubleHop { ENABLED |DISABLED }] [- appflowLog { ENABLED |DISABLED }]
   set vpn vserver vpnhop2 –doubleHop ENABLED –appFlowLog ENABLED
4. Disable authentication on the NetScaler Gateway virtual server in the second DMZ.
   set vpn vserver <name> [-authentication {ON |OFF}]
   set vpn vserver vs -authentication OFF
5. Enable one of the NetScaler Gateway appliances to export TCP records.
   bind vpn vserver <name> [-policy <string> -priority <positive_integer>] [-type <type>]
   bind vpn vserver vpn1 -policy appflowpol1 -priority 101 -type OTHERTCP_REQUEST
6. Enable the other NetScaler Gateway appliance to export ICA records:
   bind vpn vserver <name> [-policy <string> -priority <positive_integer>] [-type <type>]
   bind vpn vserver vpn2 -policy appflowpol1 -priority 101 -type ICA_REQUEST
7. Enable connection chaining on both the NetScaler Gateway appliances:
   set appFlow param [-connectionChaining {ENABLED |DISABLED}]
   set appflow param -connectionChaining ENABLED

Configuring NetScaler Gateway Using the configuration utility

1. Configure the NetScaler Gateway in the first DMZ to communicate with the NetScaler Gateway in the second DMZ and bind the NetScaler Gateway in the second DMZ to the NetScaler Gateway in the first DMZ.
   1. On the Configuration tab expand NetScaler Gateway and click Virtual Servers.
   2. In the right pane, double-click the virtual server, and in the Advanced group, expand Published Applications.
   3. Click Next Hop Server and bind a next hop server to the second NetScaler Gateway appliance.
2. Enable double hop on the NetScaler Gateway in the second DMZ.
   1. On the Configuration tab expand NetScaler Gateway and click Virtual Servers.
   2. In the right pane, double-click the virtual server, and in the Basic Settings group, click the edit icon.
   3. Expand More, select Double Hop and click OK.
3. Disable authentication on the virtual server on the NetScaler Gateway in the second DMZ.
   1. On the Configuration tab expand NetScaler Gateway and click Virtual Servers.
   2. In the right pane, double-click the virtual server, and in the Basic Settings group, click the edit icon.
   3. Expand More, and uncheck Enable Authentication.
4. Enable one of the NetScaler Gateway appliance to export TCP records.
   1. On the Configuration tab expand NetScaler Gateway and click Virtual Servers.
   2. In the right pane, double-click the virtual server, and in the Advanced group, expand Policies.
   3. Click the + icon and in the from the Choose Policy drop-down list, select AppFlow and from the Choose Type drop-down list, select Other TCP Request.
   4. Click Continue.
   5. Add a policy binding, and click Close.
5. Enable the other NetScaler Gateway appliance to export ICA records:
   1. On the Configuration tab expand NetScaler Gateway and click Virtual Servers.
   2. In the right pane, double-click the virtual server, and in the Advanced group, expand Policies.
   3. Click the + icon and in the from the Choose Policy drop-down list, select AppFlow and from the Choose Type drop-
down list, select Other TCP Request.
4. Click Continue.
5. Add a policy binding, and click Close.
6. Enable connection chaining on both the NetScaler Gateway appliances.
   1. On the Configuration tab, navigate to System > Appflow.
   2. In the right Pane, in the Settings group, click on Change Appflow Settings.
   3. Select Connection Chaining and Click OK.
Enabling Data Collection for Monitoring NetScaler ADCs Deployed in LAN User Mode

May 04, 2017

After you add the NetScaler appliance to the NetScaler Insight Center inventory, you must enable AppFlow for data collection.

Note:
- You cannot enable data collection on a NetScaler ADC deployed in LAN User mode by using the NetScaler Insight Center configuration utility.
- For detailed information about the commands and their usage, see Command Reference.
- For information on policy expressions, see Policies and Expressions.

To configure data collection on a NetScaler appliance by using the command line interface

At the command prompt, do the following:

1. Log on to an appliance.
2. Add a forward proxy cache redirection virtual server with the proxy IP and port, and specify the service type as HDX.
   ```
   add cr vserver <name> <servicetype> [<ipaddress> <port>] [-cacheType <cachetype>] [-cltTimeout <secs>]
   ```
   Example
   ```
   add cr vserver cr1 HDX 10.12.2.2 443 -cacheType FORWARD -cltTimeout 180
   ```
   Note: If you are accessing the LAN network by using a NetScaler Gateway appliance, add an action to be applied by a policy that matches the VPN traffic.
   ```
   add vpn trafficAction <name> <qual> [-HDX ( ON | OFF )]
   ```
   Example
   ```
   add vpn trafficAction act1 tcp -HDX ON
   ```
   ```
   add vpn trafficPolicy <name> <rule> <action
   ```
   Example
   ```
   add vpn trafficPolicy pol1 "REQ.IP.DESTIP == 10.102.69.17" act1
   ```
3. Add NetScaler Insight Center as an appflow collector on the NetScaler appliance.
   ```
   add appflow collector <name> [-IPAddress <ip_addr>]
   ```
   Example
   ```
   add appflow collector MyInsight -IPAddress 192.168.1.101
   ```
   Note: A NetScaler appliance supports a maximum four Appflow collectors. If there are already four Appflow collectors configured, you cannot add another AppFlow collector (in this case, NetScaler Insight Center) to the NetScaler appliance. Delete an existing Appflow collector to add a new collector. To view the appflow collectors configured on the NetScaler appliance, use the show appflow collector command.
4. Create an appflow action and associate the collector with the action.
   ```
   add appflow action <name> [-collectors <string> ...]
   ```
   Example:
   ```
   add appflow action act -collectors MyInsight
5. Create an appflow policy to specify the rule for generating the traffic.
   add appflow policy <policyname> <rule> <action>

   **Example:**
   add appflow policy pol true act

6. Bind the appflow policy to a global bind point.
   bind appflow global <policyname> <priority> -type <type>

   **Example:**
   bind appflow global pol 1 -type ICA_REQ_DEFAULT
   Note: The value of type should be ICA_REQ_OVERRIDE or ICA_REQ_DEFAULT in order to apply to ICA traffic.

7. Set the value of the flowRecordInterval parameter for Appflow to 60 seconds.
   set appflow param -flowRecordInterval 60

   **Example:**
   set appflow param -flowRecordInterval 60

8. Save the configuration.
   save ns config
Enabling Data Collection for CloudBridge Datacenter Appliances

May 04, 2017

After you add the CloudBridge appliance to the inventory, you must enable AppFlow on NetScaler Insight Center to start collecting the reports.

To enable data collection for CloudBridge appliances

1. On the Configuration tab, click Inventory.
2. From the inventory list, select the IP address of the CloudBridge appliance on which you want to enable data collection.
3. On the Configure CloudBridge screen, select AppFlow to enable data collection, and choose HDX, to collect information for ICA traffic.
Enabling Data Collection for Monitoring CloudBridge Datacenter Appliances and Branch Appliances

May 04, 2017

After you add the CloudBridge appliance to the inventory, you must enable AppFlow on NetScaler Insight Center to start collecting the reports.

**On the branch appliances**

1. On the Configuration tab, click **Inventory**.
2. From the inventory list, select the IP address of the CloudBridge appliance on which you want to enable data collection.
3. On the Configure CloudBridge screen, select AppFlow to enable data collection, and choose TCP for HDX to collect information for ICA traffic.

**On the datacenter appliance**

1. On the Configuration tab, click **Inventory**.
2. From the inventory list, select the IP address of the CloudBridge appliance on which you want to enable data collection.
3. On the Configure CloudBridge screen, select AppFlow to enable data collection, and choose HDX to collect information for ICA traffic. If you want to monitor WAN traffic, enable TCP and WANOpt.
Enabling Data Collection for Monitoring CloudBridge Plug-Ins

May 04, 2017
After you add the CloudBridge appliance to the inventory, you must enable AppFlow on NetScaler Insight Center to start collecting the reports.

On the branch appliance

1. On the Configuration tab, click Inventory.
2. From the inventory list, select the IP address of the CloudBridge appliance on which you want to enable data collection.
3. On the Configure CloudBridge screen, select AppFlow to enable data collection, and choose TCP for HDX to collect information for ICA traffic.

On the datacenter appliance

1. On the Configuration tab, click Inventory.
2. From the inventory list, select the IP address of the CloudBridge appliance on which you want to enable data collection.
3. On the Configure CloudBridge screen, select AppFlow to enable data collection, and choose HDX to collect information for ICA traffic. If you want to monitor WAN traffic enable TCP and WANOpt.
Enabling Data Collection for Monitoring CloudBridge Appliances and NetScaler Gateway Appliances in Single-Hop Mode

May 04, 2017

After you add the CloudBridge appliance to the inventory, you must enable AppFlow on NetScaler Insight Center to start collecting the reports.

On the branch appliance

1. On the Configuration tab, click Inventory.
2. From the inventory list, select the IP address of the CloudBridge appliance on which you want to enable data collection.
3. On the Configure CloudBridge screen, select AppFlow to enable data collection, and choose TCP for HDX to collect information for ICA traffic.

On the datacenter appliance

1. On the Configuration tab, click Inventory.
2. From the inventory list, select the IP address of the CloudBridge appliance on which you want to enable data collection.
3. On the Configure CloudBridge screen, select AppFlow to enable data collection, and choose TCP and WANOpt to collect information for ICA traffic.

On the NetScaler Gateway appliance

1. On the Configuration tab, click Inventory.
2. From the inventory list, select the IP address of the NetScaler Gateway appliance on which you want to enable data collection.
3. On the NetScaler Insight Center Inventory Setup screen, in the Application List pane, from the View drop-down list, select VPN.
4. Select the VPN virtual server for which you want to enable data collection.
5. From the Action drop-down list, select Enable Appflow.
6. In the Enable AppFlow dialog box, from the Select Expression drop-down list, specify the traffic to be filtered.
7. From the Export Option drop-down list, select ICA.
8. Click OK to save the configuration. If data collection is enabled, the Insight column in the Application List table shows that NetScaler Insight Center is enabled.
9. To return to the inventory list, from the Action drop-down, select Return to Inventory list.

Enabling Connection Chaining on CloudBridge Appliances and NetScaler Gateway Appliances

If the network topology includes both CloudBridge and NetScaler Gateway appliances, you must enable connection chaining on the all the appliances.

To enable connection chaining on the CloudBridge appliances by using the command line interface

1. Enable connection chaining
enable connection-chaining

Example:
Admin> enable connection-chaining
Done
admin> show connection-chaining
Connection Chaining : on
Done
admin> disable connection-chaining
Done
admin> show connection-chaining
Connection Chaining : off
Done

To enable connection chaining on the CloudBridge appliances by using the configuration utility

1. On the Configuration tab, expand Appliance Settings and click AppFlow.
2. In the right pane, enable Connection Chain ID.

To enable connection chaining on the NetScaler Gateway appliance by using the command line interface

1. Enable connection chaining
   enable connection-chaining

Example:
set appFlow param [-connectionChaining (ENABLED|DISABLED)]

To enable connection chaining on the NetScaler Gateway appliance by using the configuration utility

2. In the right pane, in the Settings group, click on Change Appflow Settings.
3. Select Connection Chaining and click OK.
Enabling Data Collection for Monitoring CloudBridge Appliances and NetScaler Gateway Appliances in Double-Hop Mode

May 04, 2017

After you add the CloudBridge appliance to the inventory, you must enable AppFlow on NetScaler Insight Center to start collecting the reports.

On the branch appliance

1. On the Configuration tab, click Inventory.
2. From the inventory list, select the IP address of the CloudBridge appliance on which you want to enable data collection.
3. On the Configure CloudBridge screen, select AppFlow to enable data collection, and choose TCP for HDX to collect information for ICA traffic.

On the datacenter appliance

1. On the Configuration tab, click Inventory.
2. From the inventory list, select the IP address of the CloudBridge appliance on which you want to enable data collection.
3. On the Configure CloudBridge screen, select AppFlow to enable data collection, and choose TCP and WANOpt to collect information for ICA traffic.

On the NetScaler Gateway appliance

If you enable NetScaler Insight Center to start collecting the ICA details from both the NetScaler Gateway appliances the collected details are redundant. That is, both appliances report the same metrics. To correct this situation, enable AppFlow for ICA on the first NetScaler Gateway appliance, and then enable AppFlow for TCP on the second appliance. One appliance then exports ICA AppFlow records, and the other exports TCP AppFlow records. This arrangement also reduces processing time for parsing the ICA traffic.

To enable data collection, see Enabling Data Collection on NetScaler Insight Center.

Enabling Connection Chaining on CloudBridge Appliances

If the network topology includes both CloudBridge and NetScaler Gateway appliances, you must enable connection chaining on the CloudBridge appliances.

To enable connection chaining on the CloudBridge appliances by using the command line interface

1. Enable connection chaining
   enable connection-chaining

   Example:
   Admin> enable connection-chaining
   Done
   admin> show connection-chaining
   Connection Chaining : on
   Done
admin> disable connection-chaining
Done
admin> show connection-chaining
Connection Chaining : off
Done

To enable connection chaining on the CloudBridge appliances by using the configuration utility

1. On the Configuration tab, expand Appliance Settings and click AppFlow.
2. In the right pane, enable Connection Chain ID.

To enable connection chaining on the NetScaler Gateway appliance by using the command line interface

1. Enable connection chaining
   enable connection-chaining

   Example:
   set appFlow param [-connectionChaining (ENABLED|DISABLED)]

To enable connection chaining on the NetScaler Gateway appliance by using the configuration utility

2. In the right pane, in the Settings group, click on Change AppFlow Settings.
3. Select Connection Chaining and click OK.
Enabling WAN Insight Data Collection

May 04, 2017
After you add the CloudBridge appliance to the NetScaler Insight Center inventory, you must enable AppFlow on NetScaler Insight Center for WAN Insight data collection.

To enable data collection for WAN Insight

1. On the Configuration tab, click Inventory.
2. From the inventory list, select the IP address of the appliance on which you want to enable data collection.
3. On the Configure CloudBridge screen, select AppFlow to enable data collection, and choose TCP and WANOpt, to collect information for WAN traffic.
Viewing the Reports

May 04, 2017

NetScaler Insight Center reports provide a detailed view of the performance of the devices. With the help of these reports, you can analyze the devices being monitored by NetScaler Insight Center and track performance issues.

When you enable data collection, NetScaler Insight Center collects traffic data, analyzes the collected data, and presents it as reports on the dashboard, in various formats as displayed in the following figure.

Figure 1. An example of the various visual representations

The data collected from the devices is aggregated to display the data collected during the last 5 minutes, 1 hour, 1 day, 1 week, and 1 month. You can choose to view the data for a particular period.

The list of parameters displayed in the report depends on the metrics selected at the top right corner of the page. When you select an entity, duration, and metric from the drop-down-list, NetScaler Insight Center displays the relevant values in multiple formats.

For example, if you select Devices from the Web Insight node, select Day as duration and select Hits as the metric to display, then the dashboard displays a bar chart. Below the chart is a tabular representation of the data. In the table you can click on an entry to display a more detailed report, with all of the applicable values shown as both a bar chart and a pie chart.

Note: By default, the dashboard bases the performance chart for the NetScaler ADCs or CloudBridge appliances on the number of hits. To display more details of an appliance's performance, click on its host name, or click on the chart. All components that affect the performance of the appliance are represented in charts. For details on exporting reports, see Exporting Reports.

Updated: 2015-05-12

After an ICA connection is established between a client and a NetScaler Gateway appliance, errors can prevent the appliance from exporting the AppFlow records to NetScaler Insight Center.

In such cases, the NetScaler Insight Center dashboard displays the reasons for which the NetScaler appliance does not export the AppFlow records. Following are some examples:

- An unsupported version of Citrix receiver is installed.
- NetScaler appliance failure
- Internal memory errors
- Protocol parsing errors

After an ICA connection is established between a client and a NetScaler Gateway appliance, errors can prevent the appliance from exporting the AppFlow records to NetScaler Insight Center.
Unable to identify the ICA stream because of signature mismatch.

You can view the skipped flows are displayed in the HDX Insight > Gateways node.

Updated: 2015-05-29

You can identify the root cause of a terminated ICA session by viewing the session termination reason on the HDX Insight node. The session TCP metrics, such as ICA RTT and WAN Latency, are shown along with the termination reason.

An ICA session might get terminated due to the following reasons:

- User Terminated Session: While connected to a XenApp or XenDesktop server, you manually log off from the session.
- ICA Session Timeout: You have specified a timeout value for ICA sessions, and the NetScaler appliances does not send any AppFlow records to NetScaler Insight Center for the specified length of time. For more information about ICA session timeout, see Managing System Settings.
- Session Reliability Timeout: You have specified a session reliability timeout value on a XenServer server, and the NetScaler appliance does not send any AppFlow records to NetScaler Insight Center for the specified length of time.

You can view the terminated session details on the HDX Insight > Users node.
Web Insight Reports

May 04, 2017

For application traffic, the reports generated by NetScaler Insight Center are available on the Web Insight node on the Dashboard. The reports include the following categories of entities:

- **Devices.** Displays the reports for all NetScaler appliances accessed by the clients.
- **Applications.** Displays the reports for all applications used by the clients across all the NetScaler appliances.
- **Domains.** Displays the reports for all domains accessed by the clients.
  
  Note: This category is displayed if you enable cache redirection on any of the NetScaler ADCs listed in the inventory.
- **URLs.** Displays the reports for all the application URLs accessed by the clients.
- **Clients.** Displays the reports for all clients accessing the applications across all the NetScaler appliances.
- **Servers.** Displays the reports for all the servers responding to the client requests.

Web Insight reports consolidate the following data:

- Applications managed by the selected NetScaler appliances
- Top five clients details
- Top five servers details
- HTTP request methods used by the clients
- HTTP Response Status
- Operating Systems used by the clients
- User agents (browsers) used by the clients
- Cache Performance details

Note: You can click on a chart to view details of the selected component.

The following table lists the Web Insight metrics available with different licenses:

<table>
<thead>
<tr>
<th>Metrics</th>
<th>Description</th>
<th>NS 10 Platinum edition, and NS 10.1 all editions</th>
<th>NS 10 (Standard and Enterprise editions, and NS 9.3 (All editions)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Devices</td>
<td>Hits - Number of requests received by NetScaler.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Bandwidth - Total bytes processed by NetScaler appliance.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Applications</td>
<td>Hits - Number of requests received by application.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Bandwidth - Total bytes sent to the application.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Response Time - Elapsed time between the end of an enquiry and the beginning of a response from the application.</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

Table 1. Web Insight Metrics with Applicable Licenses

https://docs.citrix.com © 1999-2017 Citrix Systems, Inc. All rights reserved.
Response time consists of Client Network Latency, Server Processing Time and Server Network Latency.

<table>
<thead>
<tr>
<th>URLs</th>
<th>Hits</th>
<th>Number of requests received for a URL.</th>
<th>Yes</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load time</td>
<td>Elapsed time, from when the browser starts to receive the first byte of a response until the user starts to interact with the page. At this stage, some of the page content might not yet have been loaded.</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Render Time</td>
<td>Elapsed time, from when the browser starts to receive the first byte of a response until either all page content has been rendered or the page load action has timed out.</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Waterfall Chart</td>
<td>A chart that displays the reports for web pages with embedded objects that are accessed by clients. It includes details about load time, render time, response time and number of embedded objects.</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** To view the waterfall chart:
1. Navigate to Dashboard > URLs
2. Select a particular URL and click Page Analysis.

<table>
<thead>
<tr>
<th>Clients</th>
<th>Requests</th>
<th>Number of requests sent by the client.</th>
<th>Yes</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Render time</td>
<td>Elapsed time, from when the browser starts to receive the first byte of a response until either all page content has been rendered or the page load action has timed out.</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Client Network Latency</td>
<td>Latency caused by client-side network.</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Servers</th>
<th>Hits</th>
<th>Number of requests received by the servers.</th>
<th>Yes</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bandwidth</td>
<td>Total bytes received by the servers.</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Server Processing</td>
<td>Elapsed time, from when the server starts to receive the first byte of a request from the NetScaler</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Time</td>
<td>appliance until the NetScaler appliance receives the first byte to response.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>--------------------------------------------------------------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Server Network Latency</td>
<td>Latency caused by server network.</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td><strong>HTTP Request Methods</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hits</td>
<td>Number of requests received, distributed with respect to various request methods.</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Bandwidth</td>
<td>Total bytes received, with respect to HTTP request methods.</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td><strong>HTTP Response Status</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hits</td>
<td>Number of responses sent, segregated with respect to HTTP response status.</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Bandwidth</td>
<td>Total bytes received, segregated with respect to HTTP response status.</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Render Time</td>
<td>Average render time experienced by clients segregated with respect to HTTP status responses.</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td><strong>Operating Systems</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hits</td>
<td>Number of client requests received, segregated with respect to user agents used.</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Bandwidth</td>
<td>Total bytes received from clients, segregated with respect to OS used.</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Render Time</td>
<td>Average Render time experienced by clients, segregated with respect to OS used.</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td><strong>User Agents</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hits</td>
<td>Number of client requests received, segregated with respect to the user agents used.</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Bandwidth</td>
<td>Total bytes received, from clients segregated with respect to user agents used.</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Render Time</td>
<td>Averaged Render time experienced by clients, segregated with respect to user agents used.</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

Cache Redirection Insight which is a classification of Web Insight reports provide visibility into cache performance and
includes the following details:

- **Cache Hits**: Number of requests served by the cache server.
- **Cache miss**: Number of requests that the cache server could not serve and was served by the origin server.
- **Cache bypass**: Number of requests that bypassed the cache server and was served by the origin server.
- **Cache hits bandwidth consumed**: Bandwidth consumed while serving request from the cache server.
- **Cache miss bandwidth consumed**: Bandwidth consumed when the cache server could not serve the request and was served by the origin server.
- **Cache bypass bandwidth consumed**: Bandwidth consumed when the requests bypassed the cache server and was served by the origin server.
For virtual desktop traffic, the reports generated by NetScaler Insight Center are available on the HDX Insight node of the Dashboard. The HDX Insight reports provide complete visibility of the ICA traffic. The reports include the following categories of entities:

- **Users.** Displays the reports for all the users accessing the applications in a selected time slot.
- **Applications.** Displays the reports for total number of applications, and the total number of times the applications were launched, within the specified time slot.
- **Gateways.** Displays the reports on the NetScaler appliances that act as gateways for incoming traffic.
- **Desktops.** Displays the reports for the desktops used in the selected time frame.
- **Licenses.** Displays the reports for total SSL VPN licenses used within the specified time slot.

Note: The Licenses value does not apply to CloudBridge appliances.

The following table lists HDX Insight metrics:

<table>
<thead>
<tr>
<th>Metrics</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Users</strong></td>
<td></td>
</tr>
<tr>
<td>WAN Latency</td>
<td>Average latency caused by the client side network.</td>
</tr>
<tr>
<td>DC Latency</td>
<td>Average latency caused by the server network.</td>
</tr>
<tr>
<td>ICA RTT</td>
<td>Average ICA RTT is the screen lag that the user experiences while interacting with an application or desktop hosted on XenApp or XenDesktop, respectively.</td>
</tr>
<tr>
<td>Bandwidth</td>
<td>Rate at which data is transferred over the ICA session.</td>
</tr>
<tr>
<td>Client Side NS Latency</td>
<td>Average latency caused by a NetScaler appliance when ICA traffic flows from client network to server network.</td>
</tr>
<tr>
<td>Server Side NS Latency</td>
<td>Average latency caused by a NetScaler appliance when ICA traffic flows from server network to client network.</td>
</tr>
<tr>
<td>Host Delay</td>
<td>Average delay in ICA traffic that passes through the NetScaler ADCs, caused by server network.</td>
</tr>
<tr>
<td>Client side zero window size event</td>
<td>This counter indicates how many times the client advertised a zero TCP window (in this interval).</td>
</tr>
<tr>
<td>Server side zero window size event</td>
<td>This counter indicates how many times the server advertised a zero TCP window</td>
</tr>
<tr>
<td>window size event</td>
<td>(in this interval).</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td><strong>Client side fast RTO</strong></td>
<td>This counter indicates how many times the retransmit timeout got invoked on the client side connection (in this interval).</td>
</tr>
<tr>
<td><strong>Server side fast RTO</strong></td>
<td>This counter indicates how many times the retransmit timeout got invoked on the server side connection (in this interval).</td>
</tr>
<tr>
<td><strong>Client side CB</strong></td>
<td>Checks whether CloudBridge is present on the client side in the ICA session path.</td>
</tr>
<tr>
<td><strong>Server side CB</strong></td>
<td>Checks whether CloudBridge is present on the server side in the ICA session path.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Applications</th>
<th><strong>Total Session Launch Count</strong></th>
<th>Total number of active sessions started during a given time interval.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Launch Duration</strong></td>
<td>Average time taken to launch an application.</td>
</tr>
<tr>
<td></td>
<td><strong>Apps</strong></td>
<td>Total number of applications active during a time period on the network.</td>
</tr>
<tr>
<td></td>
<td><strong>Client Type</strong></td>
<td>Type of client which accesses the applications.</td>
</tr>
<tr>
<td></td>
<td><strong>Client Version</strong></td>
<td>The receiver version.</td>
</tr>
<tr>
<td></td>
<td><strong>EUEM Session</strong></td>
<td>Indicates the availability of EUEM data when an EUEM channel is established between the client and server.</td>
</tr>
<tr>
<td></td>
<td><strong>Session Reconnects</strong></td>
<td>Number of times the session reconnected.</td>
</tr>
<tr>
<td></td>
<td><strong>MSI</strong></td>
<td>Indicates if the connection is multi-stream ICA.</td>
</tr>
<tr>
<td></td>
<td><strong>ACR (Automatic Client Reconnects)</strong></td>
<td>Total number of times a client automatically reconnects users to disconnected sessions.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Desktop</th>
<th><strong>Bandwidth</strong></th>
<th>Average rate at which data is transferred over the ICA session.</th>
</tr>
</thead>
</table>

<p>| Gateways | <strong>Total Session Launch Count</strong> | Total number of unique user sessions created during a given time interval. |</p>
<table>
<thead>
<tr>
<th>Total Application Launch Count</th>
<th>Total number of unique applications launched during a given time interval.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Licenses</td>
<td>Licenses in use for SSL VPN and ICA traffic.</td>
</tr>
</tbody>
</table>
WAN Insight Reports

May 04, 2017

For WAN traffic, the reports generated by NetScaler Insight Center are available on the WAN Insight node of the dashboard. The reports include the following categories of entities:

- **Applications.** Displays the reports for all the applications in a selected time slot.
- **Branches.** Displays the reports for all the CloudBridge branch appliances.
- **Clients.** Displays reports for all the clients accessing CloudBridge appliances.

The following table lists WAN Insight metrics:

<table>
<thead>
<tr>
<th>Metric Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average RTT (ms) (WAN Latency)</td>
<td>Delay, in milliseconds, that the user experiences while interacting with an application.</td>
</tr>
<tr>
<td>Compression Ratio</td>
<td>Data compression ratio achieved between the branch office and datacenter appliances in a particular duration.</td>
</tr>
<tr>
<td>Bytes Sent over WAN</td>
<td>Number of bytes that the CloudBridge appliance sends over the WAN network.</td>
</tr>
<tr>
<td>Bytes Received Over WAN</td>
<td>Number of bytes that the CloudBridge appliance receives from the WAN network.</td>
</tr>
<tr>
<td>Active Accelerated Connections</td>
<td>Number of active WAN connections being accelerated.</td>
</tr>
<tr>
<td>Active Unaccelerated Connections</td>
<td>Number of active WAN connections not being accelerated.</td>
</tr>
<tr>
<td>Packets Sent</td>
<td>Number of packets that the CloudBridge appliance sends over the network.</td>
</tr>
<tr>
<td>Packets Received</td>
<td>Number of packets that the CloudBridge appliance receives from the network.</td>
</tr>
<tr>
<td>LAN RTO</td>
<td>Number of times the CloudBridge appliance has timed out retransmission to the LAN network.</td>
</tr>
<tr>
<td>WAN RTO</td>
<td>Number of times the CloudBridge appliance has timed out retransmission to the WAN network.</td>
</tr>
<tr>
<td>Retransmit Packets (LAN)</td>
<td>Number of packets the CloudBridge appliance retransmitted to the LAN network.</td>
</tr>
<tr>
<td>Metric Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Retransmit Packets (WAN)</td>
<td>Number of packets the CloudBridge appliance retransmitted to the WAN network.</td>
</tr>
</tbody>
</table>
Exporting reports

From NetScaler Insight Center, you can save the Web Insight reports or HDX Insight reports in PDF, JPEG, PNG, or CSV format on your local computer. You can also schedule the export of the reports to specified email addresses at various intervals.

Note:
- Users with read only access cannot export reports.
- Geo map reports are exported only if the NetScaler Insight Center server has internet connectivity.

**To export a report**
1. On the Dashboard tab, in the right pane, click the export button.
2. Under Export Now, select the required format, and then click Export.

**To schedule export**
1. On the Dashboard tab, in the right pane, click the export button.
2. Under Schedule Export, specify the details and click Schedule.

To display the export schedule, navigate to Configuration > NetScaler Insight Center > Export Schedules. To edit a schedule, select a report, and then click Edit. After editing, click Save.

Note: Configure the email server settings before scheduling the report by navigating to System > Notifications > Email and by clicking Add.

**To add an email server or an email distribution list**
1. On the Configuration tab, navigate to System > Notifications > Email.
2. In the right pane, select Email Server, to add an email server or select Email Distribution list to create an email distribution list.
3. Specify the details and click Create.
Upgrading NetScaler Insight Center

Sep 07, 2016
To upgrade NetScaler Insight Center to a new build, you must first download the application build file. If you are using a scale-out deployment, upgrading the NetScaler Insight Center server will automatically upgrade the other components of the deployment (agents, connectors, and database nodes).

Note: Citrix recommends not to downgrade NetScaler Insight Center.

1. Upload the latest software image to the NetScaler Insight Center application.
   1. On the Configuration tab, navigate to NetScaler Insight Center > Software Images.
   2. In the details pane, from the Action drop-down list, select Upload.
   3. In the Upload NetScaler Insight Center Software Image dialog box, click Browse and navigate to the folder that contains the build file, and then double-click the build file.
   4. Click Upload.

   Note: You can create a backup of the software image by selecting an image and then selecting the Download option from the Action drop-down list.

2. Upgrade NetScaler Insight Center to a new version.
   1. On the Configuration tab, navigate to System.
   2. In the System pane, under System Administration, click Upgrade Netscaler Insight Center
   3. In the Upgrade Netscaler Insight Center dialog box, in Software Images, select the file of the build to which you want to upgrade.
   4. Click OK.
Web insight

May 04, 2017

Web Insight enables visibility into enterprise web applications and allows IT administrators to monitor all web applications being served by the NetScaler ADC by providing integrated and real-time monitoring of applications. Web Insight provides critical information such as user and server response time, enabling IT organizations to monitor and improve application performance.

This topic includes the following details:

- Monitoring Cache Server Performance
- Identifying the root cause of slow performance issues
- Display the usage of web applications across different geographical locations on a map

Updated: 2014-06-18

A NetScaler deployment can optimize cache server utilization to reduce bandwidth consumption and speed up data retrieval. The NetScaler ADC analyzes incoming requests, sends cacheable requests to cache servers, and sends non-cacheable requests or dynamic HTTP requests to origin servers. NetScaler Insight Center analyzes the traffic flowing through NetScaler ADC to cache servers and origin servers, and provides useful information about the cache performance, such as:

- Bandwidth saved while serving requests from the cache server instead of the origin server.
- Bandwidth consumed when requests bypassed the cache server and were served from the origin server.
- Number of times a URL was accessed from the cache server instead of the origin server.

To analyze the performance of the cache server, you can view the following metrics:

- Cache Hits: Number of requests served by the cache server.
- Cache misses: Number of requests served by the origin server because they could not be served by the cache server.
- Cache bypass: Number of requests served by the origin server because the cache server was bypassed.
- Cache hits bandwidth consumed: Bandwidth consumed by serving requests from the cache server.
- Cache miss bandwidth consumed: Bandwidth consumed by serving requests from the origin server when they could not be served from the cache server.
- Cache bypass bandwidth consumed: Bandwidth consumed by serving requests from the origin server when the cache server was bypassed.

If cache servers are deployed in a network, and cache redirection is enabled on the NetScaler ADC, and appflow logging is enabled for cache redirection, NetScaler Insight Center gathers details such as bandwidth saved and cache servers utilized across a cache farm.

1. Amount of bandwidth saved in a NetScaler deployment

   The main reason to deploy cache servers is to decrease the bandwidth consumed in retrieving data from the origin servers. A cache redirection report on bandwidth consumed by cache hits versus cache bypasses and cache misses over a period of time can provide a picture of bandwidth saved. The report includes the following details:

   - Bandwidth consumed by origin server versus cache farm
   - Bandwidth consumed by origin server
   - Bandwidth consumed by cache farm
   - Percentage of bandwidth saved by NetScaler ADC
2. **Cache Servers utilized in a cache farm**
   
   You can also view the cache redirection statistics to administer the cache servers. Cache redirection reports provides statistics about cache server utilization in a cache farm.

   For example, you can view the request distribution across cache servers in a cache farm when clients access different domains. The report also shows the bandwidth served by the cache farm, which in turn shows the percentage bandwidth saved by serving content from the cache farm.

   You can view the following details
   - Number of requests distributed across multiple cache servers
   - Responses served locally by the cache farm or cache hit of a cache server
   - Average server processing time for requests served from the cache farm
   - Bandwidth served locally by cache farm
   - Cache misses across the cache farm

3. **Top domains and URLs requested**
   
   Cache redirection reports provide a complete picture of how domains or URLs are being accessed. These reports include the following information about cache performance:

   - Domains or URLs accessed, and the number of requests for each domain or URL
   - Top domains or URLs accessed during specific time intervals
   - Top domains or URLs as determined by number of clients
   - Distribution of domains or URLs with respect to number of requests versus the bandwidth consumed
   - Top Domains by number of requests served from cache farm and origin farm

4. **Usage of Top Clients**
   
   Cache redirection reports give administrators the ability to view cache server usage by clients across different domains and URLs. The reports include the following details:

   - Top clients by total number of requests received
   - Top clients by bandwidth consumed
   - URLs accessed by top clients
   - Domains accessed by top clients
   - Top clients with respect to requests served from cache server versus the origin server

**Example**

A cache redirection report displays the bandwidth consumed for each specific URL accessed by a client. To view the report:

1. On the **Dashboard** tab, expand **Web Insight**, click **URLs**, and then select the desired URL.
2. On the left side of the graph, the dashboard displays the data for cache-hits bandwidth consumed, cache-miss bandwidth consumed, and cache-bypass bandwidth consumed.
Scenario 1

Consider a scenario where two clients are accessing the same SharePoint server, but one client is experiencing slow performance.

The client might be experiencing slow performance while accessing the SharePoint server due to latency on the client network or latency on the server network.

To identify the root cause of the issue, analyze the following metrics:
- Client Network Latency
- Server processing time
- Server Network Latency

To view the client metrics
2. In the list of applications select SharePoint.
3. Scroll to the Clients graph.
4. Select the Client Network latency from the drop-down list.
   Note the Client Network Latency values for the clients.
5. In the Servers graph, select Server Processing Time and Server Network Latency and note its value.

Summary

In this example, the Client Network Latency for client 1 (192.168.1.102) and client 2 (192.168.1.100) is 1 second and 103 milliseconds respectively. The server processing time and the server network latency is low.

This implies that the client is experiencing the slow performance due to latency on the client network and not due to server latency or server processing time.

Scenario 2

Consider another scenario where a client is experiencing slow performance while accessing a URL (Main.html).

The client might be experiencing slow performance while accessing the URL due to high Client Render Time, Client Network Latency, or high application Response Time.

To identify the root cause of the issue, analyze the following metrics:
- Client Render
- Client Network Latency

To view the client metrics
1. On the Dashboard tab, expand Web Insight and click URLs.
2. In the URLs dashboard select Render Time from the drop-down.
3. Select the /Main.html URL and scroll down to the Clients graph and check the render time for client 192.168.1.105.
4. In the Clients graph, select Client Network Latency and check the Client network latency value.

Summary

In this example, the Render time is 1 second and the Client Network Latency is 105 milliseconds.
This implies that the slow performance experienced by the is due to the high render time of the client.

The Page Analysis pane shows the embedded objects that are contributing to the high render time.

**Scenario 3**

Client experiences slow performance while accessing Outlook Web Access (OWA).

The client might be experiencing slow performance while accessing OWA due to latency on the client network or latency on the server network.

To identify the root cause of the issue, analyze the following metrics:

- Client Network Latency
- Server processing time
- Server Network Latency

**To view the client and server metrics**

1. On the **Dashboard** tab, expand **Web Insight**, click **Applications**, and then click OWA application.
2. Scroll down to Servers graph, select **Server Processing Time**.
3. In the **Clients** graph, select **Client Network Latency** and select **Server Network latency** in the **Servers** graph.
4. Verify if the **Server Processing Time** is consistently higher than **Client Network Latency** and **Server Network Latency**.

**Summary**

In this example, the **Server processing Time** is 1.25 seconds, the **Client Network latency** is 125 milliseconds and **Server Processing Time** is 40 milliseconds.

This implies that user is experiencing slow performance while accessing OWA due to the high server processing time.

Updated: 2015-04-27

Geo maps functionality in NetScaler Insight Center displays the usage of web applications across different geographical locations on a map. Administrators can use this information to understand the trends in application usage and for capacity planning.

Geo map provides information about the following metrics specific to a country, state, and city:

- Total Hits: Total number of times an application is accessed.
- Bandwidth: Total bandwidth consumed while serving client requests
- Response Time: Average time taken to send responses to client requests.

Geo maps provide information which can be used to address several use cases such as the following:

- Which region has the maximum number of clients accessing an application?
- Which region has the highest response time?
- Which region is consuming the most bandwidth?

The following image provides a snapshot of the geo map:
To view the web application traffic on the geo map, you must first download the geo database file, upload it in NetScaler Insight Center, and then enable geo data collection.

Note:
- In the above image, asterisk (*) indicates client IP addresses that were not resolved by the geo database file.
- NetScaler Insight Center does not display geo maps for 5-minute and weekly interval.

To view web application traffic on the geo map, you must download the geo database file, upload it to NetScaler Insight Center, and then enable geo database collection.

**To download the geo database file**

Download the geo database file from the location [http://geolite.maxmind.com/download/geoip/database/GeoLiteCity.dat.gz](http://geolite.maxmind.com/download/geoip/database/GeoLiteCity.dat.gz) and extract the GeoLiteCity.dat file from GeoLiteCity.dat.gz.

Note: Currently, Maxmind Geo IP city binary file is the only supported database format.

**To upload the geo database file**

1. On the Configuration tab, expand NetScaler Insight Center, and click Geo Database Files.
2. From the Action drop-down menu, select Upload.
3. In the Upload Geo Database File window, click Browse.
4. Navigate to the location of the geo database GeoLiteCity.dat file, and then click Upload.

**To enable Geo data collection**

1. On the Configuration tab, click Inventory.
2. From the inventory list, select the IP address of the NetScaler appliance for which you want to enable geo data collection.
3. In the NetScaler Insight Center Inventory Setup pane, select the Enable geo data collection check box.

After you enable geo data collection, the map is available in Web Insight reports for a single application or all applications, or all clients.
Cache Insight

Jun 30, 2016

You can monitor the NetScaler Integrated Caching (IC) using NetScaler Insight Center. If you have enabled NetScaler integrated caching, you then will have a cache to serve the duplicate user requests more quickly, the integrated cache provides in-memory storage on the Citrix NetScaler appliance and serves Web content to users without requiring a round trip to an origin server. Cache Insight enables you to see and monitor the various actions performed by the NetScaler cache. For example, you can view the cache analytics on the devices, applications, content type, URLs, etc on your NetScaler Cache.

You can find the following metrics details in the NetScaler Insight Center:

- **Integrated Cache Utilization.** Data, in bytes, sent from the NetScaler cache to serve requests.
- **Integrated Cache Hits.** Number of client requests served from the NetScaler cache.
- **Integrated Cache Refreshes.** Number of revalidations of cache data during a specified time frame.
- **Integrated Cache Misses (Storable).** Number of client requests that could not be served from the cache.
  
  **Note:** The response received from the origin server for this requests will be stored in the integrated cache.

- **Integrated Cache Misses (Non-Storable).** Number of client requests that could not be served from the cache.
  
  These requests might be affected by a policy, response size, minimum hits, or so on, specifying not to store the data in the cache.
- **Uncached Resources.** Reasons not storing an object in the cache (for example, policy, size of object, cache bypass).

---

**Note**

Integrated Cache Metrics are not supported on NetScaler Insight center with NetScaler appliances running on version 10.5 and below.

---

<table>
<thead>
<tr>
<th>NetScaler Version</th>
<th>NetScaler Insight Center version</th>
<th>Supportable Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>11.1</td>
<td>11.1</td>
<td>• Cache Metrics</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Web Insight Reports</td>
</tr>
<tr>
<td>Below 11.0 66.x (Eg 65.x)</td>
<td>11.1</td>
<td>• Cache Metrics</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Web Insight Reports</td>
</tr>
<tr>
<td>11.0 66.x</td>
<td>11.1</td>
<td>Web Insight Reports</td>
</tr>
<tr>
<td>11.0 66.x</td>
<td>Any version below 11.1</td>
<td>Web Insight Reports</td>
</tr>
</tbody>
</table>
Configuring Cache Insight

Important Notes:

- You need to install an Integrated Cache (IC) license on the NetScaler appliance before you enable this feature.
- You need to set a memory limit for the NetScaler cache after enabling the integrated caching.
- Cache Metrics are displayed as a part of Web Insight reports. You need to enable AppFlow for Web Insight to enable Cache Insight.

When you enable integrated caching, the NetScaler appliance begins caching server responses. If you have not configured any policies or content groups, the built-in policies store cached objects in the default content groups. You can configure new policies to allow or restrict objects and object types to cache in NetScaler Integrated Cache.

To Install Integrated Cache License by using the command line interface

1. Obtain a license code from Citrix, go to the command line interface, and log in.
2. At the command line interface, copy the license file to the /nsconfig/license folder.
3. Reboot the NetScaler appliance by using the following command:

```
reboot
```

For information about licenses, see information about obtaining NetScaler licenses at http://support.citrix.com/article/ctx121062.

To enable integrated caching by using the command line interface

At the command prompt, type the following command to enable integrated caching:

```
enable ns feature IC
```

To enable integrated caching by using the configuration utility
Navigate to Configuration > System > Settings, click Configure Basic Features, and select Integrated Caching.

Note
You can enable the Appflow feature either from NetScaler Insight Center or from the NetScaler appliance.

To enable the AppFlow feature from NetScaler Insight Center
1. On the Configuration tab, click Inventory.
2. From the inventory list, select the IP address of the ADC on which you want to enable data collection.
3. On the NetScaler Insight Center Inventory Setup screen, in the Application List pane, from the View drop-down list, select the type of virtual server (Load Balancing, Cache Redirection, or Content Switching).
4. Select a virtual server for which you want to enable data collection.

Note
You cannot enable data collection on a virtual server if the operational state of the virtual server is other than UP.

5. From the Action drop-down list, select Enable Appflow.

To enable the AppFlow feature from the NetScaler command line
At the command prompt, type:

```
enable ns feature AppFlow
```

To enable the AppFlow feature by using the configuration utility
Navigate to Configuration > System > Settings, click Configure Advanced Features and select AppFlow.

To set memory limit by using the command line interface
At the command prompt, type one of the following commands to enable or disable integrated caching:

```
enable ns feature AppFlow
```
set cache parameter [-memLimit <MBytes>]

To set memory limit by using the configuration utility

Navigate to Configuration > Optimization > Integrated Caching, click Change Cache Settings, and in the Cache Global Settings set the Memory Usage Limit (MB) field.

For an overview of enabling the integrated caching on a NetScaler appliance, see Setting Up the Integrated Cache.

Note

Enabling cache insight parameter is supported only on CLI.

To enable cache insight parameter

At the command prompt, type one of the following commands to enable or disable integrated caching:

```
appflow param --cacheInsight ENABLED
```
You can configure new policies in a NetScaler appliance to handle data that the built-in policies cannot process. You configure separate policies for caching, preventing caching from occurring, and for invalidating cached data.

**To configure a policy for caching by using the command line interface**

At the NetScaler command prompt, type:

```
add cache policy <policyName> -rule <expression> -action CACHE|MAY_CACHE|NOCACHE|MAY_NOCACHE [-storeInGroup <contentGroupName>] [-undefAction NOCACHE|RESET]
```

**Examples:**

```
> add cache policy image_cache -rule "http.req.url.contains("jpg") || http.req.url.contains("jpeg")" -action CACHE -storeInGroup myImages_group -undefAction NOCACHE


> add cache policy my_form_policy -rule "http.req.header("Host")contains("my.company.com") && http.req.method.eq("GET") && http.req.url.query.contains("v=7")" -action CACHE -storeInGroup my_form_event

> add cache policy viewproducts_policy -rule "http.req.url.contains("viewproducts.aspx")" -action CACHE -storeInGroup Product_Details
```

**To configure a policy for caching by using the configuration utility**

1. In a web browser, type the IP address of the NetScaler appliance (for example, http://192.168.100.1).

2. In the **User Name** and **Password** fields, enter the administrator credentials.

3. Navigate to **Optimization** > **Integrated Caching** > **Policies**, and create the new policy.

   For an overview of Configuring a Policy in the Integrated Cache, see [Configuring a Policy in the Integrated Cache](https://docs.citrix.com).

**Viewing the Integrated Cache Metrics**

NetScaler Insight Center cache metrics provide a detailed view of the performance of the NetScaler Integrated Caching. With the help of these metrics, you can analyze and optimize your NetScaler integrated cache and track performance issues.

**To monitor Cache Metrics in NetScaler Insight Center**

1. On the **Dashboard** tab, navigate to **Web Insight** and click the node for which to display the metrics.

2. In the right pane, select a timeframe from the drop-down list. You can further customize the time frame by using the timeframe slider. Click **Go**.
3. Select the type of metrics you want to see from the drop-down list at the right of the dialog box. The metrics displays bar graphs, which you can click for details.

Reduction of origin server load

You can reduce the load on your origin server by using integrated caching. The integrated cache provides in-memory storage on the Citrix NetScaler appliance and serves web content to users without requiring a round trip to an origin server. The cache metrics show the number of bytes that the origin servers did not have to process.

The total bytes served by the cache can be calculated by the formula \((\text{Bandwidth} - \text{Integrated Cache Utilization})\). You can configure policies to enhance the IC performance.

Improving server time

As a NetScaler administrator monitoring the cached objects through NetScaler Insight Center, if you notice that a large number of requests are served by the backend servers, you can configure a policy to cache frequently requested objects. If a policy is already configured not to cache those objects, you will be notified in the Uncached Details section.

For example, if 25 users request the same object, and the object is cacheable, the first user request is classified as \text{Integrated Cache Miss (Storable)}, and the object returned in the response is stored in the cache memory. The subsequent requests for the same object are served by the integrated cache. This reduces the origin server's load by 24 times. It also reduces the response time, because it eliminates 24 round trips to and from the origin server.
Analysis of all types of requests

In various situations, origin-server header values might not allow some otherwise cacheable objects to be cached in the NetScaler Integrated Cache (IC). With strict header checking, any requests for these types of objects become cache misses. Too many cache misses for cacheable data might decrease server performance to the point that the purpose and utility of integrated caching is lost.

Monitoring how many cacheable requests were cache hits, and observing the content type of cache hits (for example, text file or .js file) can produce a granular analysis that facilitates a solution.

Another possibility is that caching large objects (for example, images larger than 1 MB, or 3.5 MB videos) might consume a large portion of the IC memory, causing numerous requests for smaller cacheable objects to become cache misses. Configuring a policy to not store such objects can reduce the load on the origin servers.

What can a NetScaler Administrator determine by viewing the Integrated Cache Metrics?

As a NetScaler administrator, you can monitor the NetScaler cache through NetScaler Insight Center. You can view the details such as efficiency of the cache (Integrated Cache Hits), cache misses (Integrated Cache Misses (Storable)), non-storable cache misses (Integrated Cache Misses (non-Storable)), and so on.

With Cache insight, you can view the cache misses that have occurred and can determine whether or not the objects were cacheable. You can also view the policy names that resulted in the failures.

For example, if 70% of the requests resulted in cache misses (Integrated Cache Misses (Storable) and Integrated Cache Misses (Non-Storable)), and 50% of those requests were for objects that can be cached, you can view the Uncached details to identify the policy or configuration causing the cache misses, and take remedial action.
HDX Insight

Jan 12, 2017
HDX Insight provides end-to-end visibility for ICA traffic passing through NetScaler ADC.

HDX Insight enables administrators to view real-time client and network latency metrics, historical reports, End-to-end performance data, and troubleshoot performance issues.

Availability of both real-time and historical visibility data enables NetScaler Insight Center to support a wide variety of use cases.

The following Thin Clients support HDX Insight for NetScaler Insight Center release 11.0 build 65.35 and later:

- WYSE Windows based Thin Clients
- WYSE Linux based Thin Clients
- WYSE ThinOS based Thin Clients
- 10Zig Ubuntu based Thin Clients

This document includes the following details:

- Identifying the root cause of slow performance issues
- Geo Maps for HDX Insight

Scenario 1

User is experiencing delays while accessing XenApp and XenDesktop.

The delays might be due to latency on the server network, ICA traffic delays caused by the server network, or latency on the client network.

To identify the root cause of the issue, analyze the following metrics:

- WAN Latency
- DC Latency
- Host Delay

To view the client metrics
1. On the Dashboard tab, navigate to HDX Insight > Users.
2. Scroll down and select the user name.
3. On the Current Application Sessions table, hover the mouse over the RTT value and note the host delay, DC latency, and WAN latency values.

On the Current Application Sessions table, click the hop diagram symbol to display information about the connection between the client and the server, including latency values.

Figure 1. Current Application Session
Summary

In this example, the **DC Latency** is 1 millisecond, the **WAN latency** is 592 milliseconds and **Host Delays** is 0 seconds.

This indicates that the user is experiencing delay due to latency caused by the client network.

Scenario 2

User is experiencing delay while launching an application on XenDesktop or XenApp

The delay might be due to latency on the server network, ICA-traffic delays caused by the server network, latency on the client network, or time taken to launch an application.

To identify the root cause of the issue, analyze the following metrics:

- **WAN latency**
- **DC Latency**
- **Application Launch Duration**

To view the user metrics

1. On the **Dashboard** navigate to **HDX Insight> Users**.
2. Scroll down and click on the user name.
3. In the graphical representation, note the WAN Latency, DC Latency and RTT values for the particular session.
4. In the Current Application Sessions table, click the first session ID.
5. Scroll down, and in the Applications pane, from the dropdown list, select **Launch Duration** to view the time taken for the application to launch.
Summary

In this example, the **DC Latency** is 1 millisecond, the **WAN latency** is 13 milliseconds, and the **Launch Duration** value of 2.37 seconds. This indicates that the cause for the delay in launching the application is high application launch time.

The NetScaler Insight Center geo maps functionality displays the usage of applications across different geographical locations on a map. Administrators can use this information to understand the trends in application usage across various geographical locations.

You can configure NetScaler Insight Center to display the geo maps for a particular geographical location or LAN by specifying the private IP range (start and end IP address) for the location.

**To configure a geo map for private IP block**

On the Configuration tab, navigate to NetScaler Insight Center > Private IP Block to configure geo maps for a particular location.

**Use Case**

Consider a scenario in which organization ABC has 2 branch offices, one in Santa Clara and the other in India.

The Santa Clara users use the NetScaler Gateway appliance at SClara.x.com to access VPN traffic. The Indian users use the NetScaler Gateway appliance at India.x.com to access VPN traffic.

During a particular time interval, say 10 AM to 5 PM, the users in Santa Clara connect to SClara.x.com to access VPN traffic. Most of the users access the same NetScaler Gateway, causing a delay in connecting to the VPN, so some users connect to India.x.com instead of SClara.x.com.

A NetScaler administrator analyzing the traffic can use the geo map functionality to show the traffic in Santa Clara office.
The map shows that the response time in the Santa Clara office is very high, because the Santa Clara office has only one NetScaler Gateway appliance through which users can access VPN traffic. The administrator might therefore decide to install another NetScaler Gateway, so that users have two local NetScaler Gateway appliances through which to access the VPN.

If NetScaler instances have Enterprise license, thresholds set on NetScaler Insight center for HDX Insight will not be triggered since analytical data is collected for only 1 hour.
In a NetScaler Gateway deployment, visibility into a user’s access details is essential for troubleshooting access failure issues. As the network administrator, you want to know when a user is not able to log on to NetScaler Gateway, and you want to know the user activity and the reasons for logon failure, but that information is typically not available unless the user sends a request for resolution.

Gateway Insight provides visibility into the failures that users encounter when logging on, regardless of the access mode. You can view a list of users logged on at a given time, along with the number of active users, number of active sessions, and bytes and licenses used by all users at any given time. You can view the end-point analysis (EPA), authentication, single sign-on (SSO), and application launch failures for a user. You can also view the details of active and terminated sessions for a user.

Gateway Insight also provides visibility into the reasons for application launch failure for virtual applications. This enhances your ability to troubleshoot any kind of logon or application launch failure issues. You can view the number of applications launched, number of total and active sessions, and the number of total bytes and bandwidth consumed by the applications. You can view details of the users, sessions, bandwidth, and launch errors for an application.

You can view the number of gateways, number of active sessions, and total bytes and bandwidth used by all gateways associated with a NetScaler Gateway appliance at any given time. You can view the EPA, authentication, single sign-on, and application launch failures for a gateway. You can also view the details of all users associated with a gateway and their logon activity.

All log messages are stored in the NetScaler Insight Center database, so you can view error details for any time period. You can also view a summary of the logon failures and determine at what stage of the logon process a failure has occurred.

**Points To Note**

- Gateway Insight is supported in the following deployments:
  - High Availability
  - Unified Gateway
- The NetScaler Insight Center release and build must be same or later than that of the NetScaler Gateway appliance.
- One hour of Gateway Insight reports can be viewed for NetScaler instances with Enterprise license. A Platinum license is needed to view Gateway Insight reports beyond one hour.

**Limitations**

- Successful user logons, latency, and application-level details for virtual ICA applications and desktops are visible only on the HDX Insight Users dashboard.
- In a double-hop mode, visibility into failures on the NetScaler Gateway appliance in the second DMZ is not available.
- Remote Desktop Protocol (RDP) desktop access issues are not reported.
- Gateway Insight does not report DNS lookup failures.
- Gateway Insight does not report data pertaining to the following advanced authentication methods. Certificate-based, SAML, Kerberos, WebAuth, NTLM, and OAuth.

This document includes the following sections:

- Enabling Gateway Insight
### Use Cases

To enable Gateway Insight for your NetScaler Gateway appliance, you must first add the NetScaler Gateway appliance to NetScaler Insight Center. You then enable AppFlow for the virtual server representing the VPN application. For information about adding a device to NetScaler Insight Center, see Adding Devices.

**Note**: On the NetScaler Gateway appliance, you must enable AppFlow AAA Username logging to view end-point analysis (EPA) failures and you must also enable Enhanced Authentication feedback to view enhanced authentication errors such as password mismatch.

#### To enable AppFlow for a virtual server in NetScaler Insight Center

1. In the NetScaler Insight Center GUI, on the **Configuration** tab, navigate to **Inventory** and click the device for which you want to enable AppFlow.
2. Under **Application List**, in the **View** list, select **VPN**.
3. Select the virtual server for which you want to enable AppFlow, and in the **Action** list, click **Enable AppFlow**.
4. On the **Enable AppFlow** screen, in the **Select Expression** list, click **true**.
5. Next to **Export Option**, select the **HTTP** check box. (ICA is selected by default.)
6. Click **OK**.

![Enable AppFlow](image.png)

**To enable AppFlow AAA Username logging on a NetScaler Gateway appliance by using the CLI**

At the command prompt, type:

```
set appflow param -AAAUserName ENABLED
```

**To enable AppFlow AAA Username logging on a NetScaler Gateway appliance by using the GUI**

1. Navigate to **Configuration > System > AppFlow > Settings**, and then click **Change AppFlow Settings**.
2. In the **Configure AppFlow Settings** screen, select **AAA Username**, and then click **OK**.

**To enable Enhanced Authentication Feedback on a NetScaler Gateway appliance by using the CLI**
At the command prompt, type:

```
set aaa paramter -enableEnhancedAuthFeedback YES
```

To enable Enhanced Authentication Feedback on a NetScaler Gateway appliance by using the GUI

1. Navigate to Configuration > Security > AAA - Application Traffic > Authentication Settings, and then click Change authentication AAA settings.
2. In the Configure AAA Parameter screen, select Enable Enhanced Authentication Feedback, and then click OK.

In NetScaler Insight Center, you can view reports for all users, applications, and gateways associated with the NetScaler Gateway appliances, and you can view details for a particular user, application, or gateway. When you open Gateway Insight, the landing page includes tabs on which you can view overview reports. You can navigate to reports about users, applications, and gateways.

This section includes the following details:

- Overview Reports
- User Reports
- Application Reports
- Gateway Reports

### Overview Reports

In the Overview section, you can view the EPA, SSO, authentication, and application launch failures. You can also view a summary of the different session modes used by users to log on, the types of clients, and the number of users logged on every hour.

To view EPA, SSO, Authentication, and Application Launch Failures

1. In the NetScaler Insight Center GUI, navigate to Dashboard > Gateway.
2. Select the time period for which you want to view the details. You can use the time slider to further customize the selected period. Click Go.
3. Click the EPA (End Point Analysis), Authentication, SSO (Single Sign On), or Application Launch tabs to display the failure details.
To view a summary of session modes, clients, and the number of users

In the NetScaler Insight GUI, navigate to Dashboard > Gateway Insight, scroll down and, under General Summary, view the reports.
User Reports

You can view reports for all users associated with the NetScaler Gateway appliances. You can view the EPA, authentication, SSO, and application launch failures for a user. You can also view the details of active and terminated sessions for a user.

To view user details

1. In the NetScaler Insight Center GUI, navigate to Dashboard > Gateway Insight > Users.
2. Select the time period for which you want to view the user details. You can use the time slider to further customize the selected period. Click Go.

You can now view the number of active users, number of active sessions, bytes and licenses used by all users during the time period.
Scroll down to view the historical data for all the users logged on in the selected time period.

On the Users or Active Users tab, you can click on a user in the User Name column to display the EPA, authentication, SSO, and application launch failures and other details for that user.

**Application Reports**

You can view the number of applications launched, number of total and active sessions, the number of total bytes and bandwidth consumed by the applications. You can view details of the users, sessions, bandwidth, and launch errors for an application.

**To view application details**

1. In the NetScaler Insight Center GUI, navigate to Dashboard > Gateway Insight > Applications.

2. Select the time period for which you want to view the application details. You can use the time slider to further customize the selected time period. Click Go.

You can now view the number of applications launched, number of total and active sessions, the number of total bytes and bandwidth consumed by the applications.
Scroll down to view the numbers of sessions, bandwidth, and total bytes consumed by ICA and other applications.

<table>
<thead>
<tr>
<th>Name</th>
<th># Sessions</th>
<th>Bandwidth</th>
<th>Total Bytes</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.102.6.1,2,49</td>
<td>1072</td>
<td>52 bps</td>
<td>1.70 MB</td>
</tr>
<tr>
<td>cpe-mpulse.net</td>
<td>2</td>
<td>0 bps</td>
<td>1.53 KB</td>
</tr>
<tr>
<td>citrix-endostatic.com</td>
<td>1</td>
<td>0 bps</td>
<td>805</td>
</tr>
<tr>
<td>codejquery.com</td>
<td>1</td>
<td>0 bps</td>
<td>1.51 KB</td>
</tr>
<tr>
<td>engtools.citrix.net</td>
<td>2</td>
<td>0 bps</td>
<td>160</td>
</tr>
<tr>
<td>onabug.citrix.net</td>
<td>2</td>
<td>1 bps</td>
<td>86.21 KB</td>
</tr>
</tbody>
</table>

On the Other Applications tab, you can click an application in the Name column to display details of that application.

Gateway Reports

You can view the number of gateways, number of active sessions, total bytes and bandwidth used by all gateways associated with a NetScaler Gateway appliance at any given time. You can view the EPA, authentication, single sign-on, and application launch failures for a gateway. You can also view the details of all users associated with a gateway and their logon activity.

To view gateway details

1. In the NetScaler Insight Center GUI, navigate to Dashboard > Gateway Insight > Gateways.

2. Select the time period for which you want to view the gateway details. You can use the time slider to further customize the selected time period. Click Go.

You can now view the number of gateways, number of active sessions, total bytes and bandwidth used by all gateways associated with a NetScaler Gateway appliance at any given time.
Scroll down to view the gateway details such as **Gateway Domain Name**, **Virtual Server Name**, **NetScaler IP address**, **session modes**, and so on.

You can click on a gateway in the **Gateway Domain Name** column to display the EPA, authentication, single sign-on, and application launch failures and other details for a gateway.

The following use cases show how you can use Gateway Insight to gain visibility into users’ access details, applications, and gateways on NetScaler Gateway appliances.

This section includes the following use cases:

- A user is not able to log on to the NetScaler Gateway appliance or to the internal web servers.
- After successfully logging on to NetScaler Gateway, a user is not able to launch any virtual application.
After successfully installing a new web application in an enterprise network, the administrator wants to view the total bytes and bandwidth consumed by that web application. Different users might be using different NetScaler Gateway deployments or might log on to NetScaler Gateway through different access modes. The administrator should be able to view details about the deployment types and access modes.

A user is not able to log on to the NetScaler Gateway appliance or to the internal web servers.

You are a NetScaler Gateway administrator monitoring NetScaler Gateway appliances through NetScaler Insight Center, and you want to see why a user is unable to log on, or at what stage of the logon process the failure has occurred.

NetScaler Insight Center enables you to view the user logon error details in the following stages of the logon process:

- Authentication
- End-point analysis (EPA)
- Single sign-on

You can view authentication errors such as incorrect credentials or no response from the authentication server. If you have set up two-stage authentication, you can see whether the primary, secondary, or both stages of the authentication have failed.

To view the authentication failure details

1. In the NetScaler Insight Center GUI, navigate to Dashboard > Gateway Insight and, in the Search for Users text box, type the name of the user for whom you want to view the error details.
2. In the list that appears, click the user’s name in the User Name column.
3. Click the Authentication tab. You can view the number of authentication errors at any given time in the Failures graph.

You can view EPA failures at pre- or post-authentication stage.
To view EPA failure details

1. In the NetScaler Insight Center GUI, navigate to Dashboard > Gateway Insight.

2. In the Overview section, select the time period for which you want to view the EPA errors. You can use the time slider to further customize the selected time period. Click Go.

3. Click the EPA (End Point Analysis) tab. You can view the number of EPA errors at any given time in the Failures graph.

Scroll down to view details of each EPA error such as Username, NetScaler IP Address, Gateway IP Address, VPN, Error Time, Policy Name, Gateway Domain Name and more from the table on the same tab. The Error Description column in the table displays the reason for the EPA failure, and the Policy Name column displays the policy that resulted in the failure.

You can click on a user in the Username column to display the EPA errors and other details for that user.

You can view all the SSO failures at any stage for a user accessing any applications through the NetScaler Gateway appliance.

To view the SSO failure details
1. In the NetScaler Insight Center GUI, navigate to Dashboard > Gateway Insight and, in the Search for Users text box, type the user for whom you want to view the error details.

2. In the list that appears, click the user's name in the User Name column.

3. Click the SSO (Single Sign On) tab. You can view the number of SSO errors at any given time in the Failures graph.

![Graph showing SSO, Authentication, EPA, and Application Launch errors]

After successfully logging on to NetScaler Gateway, a user is not able to launch any virtual application.

For an application-launch failure, you can gain visibility into the reasons, such as inaccessible Secure Ticket Authority (STA) or XenApp server, or invalid STA ticket. You can view the time at which the error occurred, details of the error, and the resource for which STA validation failed.

**To view the application launch failure details**

1. In the NetScaler Insight Center GUI, navigate to Dashboard > Gateway Insight and, in the Search for Users text box, type the name of the user for whom you want to view the error details.

2. In the list that appears, click the user's name in the User Name column.

3. Click the Application Launch tab. You can view the number of application launch failures that occurred at any given time in the Failures graph.
After successfully installing a new web application in an enterprise network, the administrator wants to view the total bytes and bandwidth consumed by that web application.

After you have successfully launched a new application, in NetScaler Insight Center, you can view the total bytes and bandwidth consumed by that application.

**To view total bytes and bandwidth consumed by an application**

In the NetScaler Insight Center GUI, navigate to Dashboard > Gateway Insight > Applications, scroll down and, on the Other Applications tab, click the application for which you want to view the details.

You can view the number of sessions and the total number of bytes consumed by that application.
You can also view the bandwidth consumed by that application.

![Bandwidth Graph]

Different users might be using different NetScaler Gateway deployments or might log on to NetScaler Gateway through different access modes. The administrator should be able to view details about the deployment types and access modes.

With Gateway Insight, you can view a summary of the different session modes used by users to log on, including the types of clients and the number of users logged on every hour. You can also determine whether a user's deployment is a unified gateway or classic NetScaler Gateway deployment. For unified gateway deployments, you can view the content switching virtual server name and IP address and the VPN virtual server name.

To view the summary of session modes, types of clients, and number of users logged on

1. In the NetScaler Insight Center GUI, navigate to **Dashboard > Gateway Insight**.
2. In the screen that appears, scroll down. Under **General Summary**, the **Session Mode**, **Operating Systems**, **Browsers**, and **User Logon Activity** charts display the different session modes used by users to log on, the types of clients, and the number of users logged on every hour.
Security Insight

Aug 11, 2016
Web and web service applications that are exposed to the Internet have become increasingly vulnerable to attacks. To protect applications from attack, you need visibility into the nature and extent of past, present, and impending threats, real-time actionable data on attacks, and recommendations on countermeasures. Security Insight provides a single-pane solution to help you assess your application security status and take corrective actions to secure your applications.

This document includes the following information:
- How Security Insight Works
- Configuring Security Insight
- Configuring Geo Locations for Security Insight Reports
- Use Cases: Bringing Visibility into Application Security
  - Obtain an Overview of the Threat Environment
  - Determine the Threat Exposure of an Application
  - Determine Existing and Missing Security Configuration for an Application
  - Identify Applications That Require Immediate Attention
  - Determine the Number of Attacks in a Given Period of Time
  - Obtain Detailed Information about Security Breaches
  - Determine the Safety Index before Deploying the Configuration

Note
For Security Insight to work, make sure that the NetScaler Insight Center release and build is the same as that of the NetScaler appliance.

Security Insight is an intuitive dashboard-based security analytics solution that gives you full visibility into the threat environment associated with your applications. Security Insight is included in NetScaler Insight Center, and it periodically generates reports based on your Application Firewall and NetScaler system security configurations. The reports include the following information for each application:

- **Threat Index.** A single-digit rating system that indicates the criticality of attacks on the application, regardless of whether or not the application is protected by a NetScaler appliance. The more critical the attacks on an application, the higher the threat index for that application. Values range from 1 through 7.
  The threat index is based on attack information. The attack-related information, such as violation type, attack category, location, and client details, gives you insight into the attacks on the application. Violation information is sent to NetScaler Insight Center only when a violation or attack occurs. A large number of breaches and vulnerabilities lead to a high threat index value.

- **Safety Index.** A single-digit rating system that indicates how securely you have configured the NetScaler devices to protect applications from external threats and vulnerabilities. The lower the security risks for an application, the higher the safety index. Values range from 1 through 7.
  The safety index takes into consideration both the application firewall configuration and the NetScaler system security configuration. For a high safety index value, both configurations must be strong. For example, if rigorous application
Firewall checks are in place but NetScaler system security measures, such as a strong password for the nsroot user, have not been adopted, applications are assigned a low safety index value.

- **Actionable Information.** Information that you need for lowering the threat index and increasing the safety index, which significantly improves application security. For example, you can review information about violations, existing and missing security configurations for application firewall and other security features, the rate at which the applications are being attacked, and so on.

**Note**

Security Insight is not supported on NetScaler Insight center with NetScaler appliances running on version 11.0 Build 65.31 and later.

<table>
<thead>
<tr>
<th>NetScaler Version</th>
<th>NetScaler Insight Center version</th>
<th>Supportable Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>11.1 Build 47.14</td>
<td>11.1 Build 47.14</td>
<td>Security Insight</td>
</tr>
<tr>
<td>11.0 Build 65.31 and later</td>
<td>11.0 Build 65.31 and later</td>
<td>Security Insight</td>
</tr>
</tbody>
</table>

**Note**

Security Insight is supported on NetScaler instances with NetScaler Platinum license or NetScaler Enterprise with AppFirewall license only.

To configure Security Insight on a NetScaler device, first configure an application firewall profile and an application firewall policy, and then bind the application firewall policy globally.

Then, enable the AppFlow feature, configure an AppFlow collector, action, and policy, and bind the policy globally. When you configure the collector, you must specify the IP address of the NetScaler Insight Center server on which you want to monitor the reports.

**To configure security insight on a NetScaler device**

1. Run the following commands to configure an application firewall profile and policy, and bind the application firewall policy globally or to the load balancing virtual server.

   ```
   add appfw profile <name> [-defaults { basic | advanced }]
   set appfw profile <name> [-startURLAction <startURLAction> ...]
   add appfw policy <name> <rule> <profileName>
   ```
bind appfw global <policyName> <priority>

or,

bind lb vserver <lb vserver> -policyName <policy> -priority <priority>

```bash
add appfw profile pr_appfw -defaults advanced
set appfw profile pr_appfw -startURLaction log stats learn
add appfw policy pr_appfw_pol "HTTP.REQ.HEADER("Host").EXISTS"pr_appfw
bind appfw global pr_appfw_pol 1

or,

bind lb vserver outlook –policyName pr_appfw_pol –priority "20"
```

2. Run the following commands to enable the AppFlow feature, configure an AppFlow collector, action, and policy, and bind the policy globally or to the load balancing virtual server:

```bash
add appflow collector <name> -IPAddress <ipaddress>
set appflow param [-SecurityInsightRecordInterval <secs>] [-SecurityInsightTraffic ( ENABLED | DISABLED )]
add appflow action <name> -collectors <string>
add appflow policy <name> <rule> <action>
bind appflow global <policyName> <priority> [<gotoPriorityExpression>] [-type <type>]

or,
bind lb vserver <vserver> -policyName <policy> -priority <priority>
```
add appflow collector col -IPAddress 10.102.63.85

set appflow param -SecurityInsightRecordInterval 60 -SecurityInsightTraffic ENABLED

add appflow action act1 -collectors col

add appflow action af_action_Sap_10.102.63.85 -collectors col

add appflow policy pol1 true act1

add appflow policy af_policy_Sap_10.102.63.85 true af_action_Sap_10.102.63.85

bind appflow global pol1 1 END -type REQ_DEFAULT

or,

bind lb vserver Sap –policyName af_action_Sap_10.102.63.85 –priority “20”

To enable AppFlow from NetScaler Insight Center

1. In a web browser, type the IP address of the NetScaler Insight Center (for example, http://192.168.100.1).

2. In User Name and Password, enter the administrator credentials.

3. Navigate to Configuration > Inventory, and select the NetScaler appliance you want to enable AppFlow.

4. Click on the IP address of the NetScaler appliance.

5. Select the virtual servers, and click Enable AppFlow.

6. In the enable appflow field, type true, and select Security Insight.

7. Click Ok.
If you configure geo locations in NetScaler Insight Center, Security Insight reports include the exact geographic locations from which client requests originate. To enable geo locations, specify a private IP block or range of IP addresses for every geographic location in your organization. Put that information in the Geo Database file, along with the city/state/country name and the latitude and longitude coordinates of each location. Contact your Citrix representative to obtain the Geo Database file, and then upload the file to the NetScaler device.

**To configure geo locations**

1. Copy the Geo Database file, Citrix_Netscaler_InBuilt_GeoIP_DB.csv, to any location on the NetScaler appliance.
2. Open the Geo Database file with a text editor, such as vi editor, and add an entry for every location in your organization.
   The entry must be in the following format:

   `<IP address of traffic originator>,<IP address of traffic originator>,,<name of the location>,,,,,,<coordinates>,,<coordinates>`

   For example,

   `1.1.1.1,1.1.1.5,,IN,"State of Gujarat",Rajkot,,,70.7833,22.3000`

3. Run the following commands to enable geo-location logging and logging in the CEF format:

   ```
   add locationFile <Complete path with DB file>
   set appfw settings -geoLocationLogging ON
   set appfw settings -CEFLogging ON
   ```

You can use NetScaler Insight Center to monitor and manage your incoming traffic’s IP Reputation. You can configure policies to add more IPs as malicious, and create a customized block list.

To know learn about configuring and using IP Reputation, see IP Reputation.

https://docs.citrix.com © 1999-2017 Citrix Systems, Inc. All rights reserved.
Monitoring IP Reputation

The IP Reputation feature provides attack-related information about malicious IP addresses. For example, it reports IP Reputation Score, IP Reputation category, IP Reputation attack time, Device IP, and details about the Client IP address.

**IP Reputation score** indicates risk associated with an IP address. The score has the following are the ranges:

<table>
<thead>
<tr>
<th>IP Reputation Score</th>
<th>Level of Risk</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-20</td>
<td>High Risk</td>
</tr>
<tr>
<td>21 – 40</td>
<td>Suspicious</td>
</tr>
<tr>
<td>41 – 60</td>
<td>Moderate Risk</td>
</tr>
<tr>
<td>61 – 80</td>
<td>Low Risk</td>
</tr>
<tr>
<td>81 – 100</td>
<td>Trustworthy</td>
</tr>
</tbody>
</table>

To monitor IP Reputation

1. Navigate to Dashboard > Security Insight, and select the application you want to monitor.
2. In the **Threat Index** tab, select **IP Reputation**.
3. Select a severity to display more details of the attacks that were at that level. You can click on the bar graph or in the table under the graph.
4. Select the time period for which you want to view the details. You can use the time slider to further customize the selected period. Click Go.
The following use cases describe how you can use security insight to assess the threat exposure of applications and improve security measures.

**Obtain an Overview of the Threat Environment**

In this use case, you have a set of applications that are exposed to attacks, and you have configured NetScaler Insight Center to monitor the threat environment. You need to frequently review the threat index, safety index, and the type and severity of any attacks that the applications might have experienced, so that you can focus first on the applications that need the most attention. The security insight dashboard provides a summary of the threats experienced by your applications over a time period of your choosing, and for a selected NetScaler device. It displays the list of applications, their threat and safety indexes, and the total number of attacks for the chosen time period.

For example, you might be monitoring Microsoft Outlook, Microsoft Lync, SharePoint, and a SAP application, and you might want to review a summary of the threat environment for these applications.
To obtain a summary of the threat environment, log on to **NetScaler Insight Center**, and then click the **Security Insight** tab.

Key information is displayed for each application. The default time period is 1 hour.

To view information for a different time period, from the drop-down at the top-left, select a time period.
To view a summary for a different NetScaler device, under Devices, click the IP address of the NetScaler device. To sort the application list by a given column, click the column header.

Determine the Threat Exposure of an Application

After reviewing a summary of the threat environment on the Security Insight dashboard to identify the applications that have a high threat index and a low safety index, you want to determine their threat exposure before deciding how to secure them. That is, you want to determine the type and severity of the attacks that have degraded their index values. You can determine the threat exposure of an application by reviewing the application summary.

In this example, Microsoft Outlook has a threat index value of 6, and you want to know what factors are contributing to this high threat index.

To determine the threat exposure of Microsoft Outlook, on the Security Insight dashboard, click Outlook. The application summary includes a map that identifies the geographic location of the server.
Click Threat Index > Security Check Violations and review the violation information that appears.

Click Signature Violations and review the violation information that appears.
Determine Existing and Missing Security Configuration for an Application

After reviewing the threat exposure of an application, you want to determine what application security configurations are in place and what configurations are missing for that application. You can obtain this information by drilling down into the application's safety index summary.

The safety index summary gives you information about the effectiveness of the following security configurations:

- **Application Firewall**: Shows how many signature and security entities are not configured.
- **NetScaler System Security**: Shows how many system security settings are not configured.

In the previous use case, you reviewed the threat exposure of Microsoft Outlook, which has a threat index value of 6. Now, you want to know what security configurations are in place for Outlook and what configurations can be added to improve its threat index.
On the **Security Insight** dashboard, click **Outlook**, and then click the **Safety Index** tab. Review the information provided in the Safety Index Summary area.

On the **Application Firewall Configuration** node, click **Outlook_Profile** and review the security check and signature violation information in the pie charts.

Review the configuration status of each protection type in the application firewall summary table. To sort the table on a column, click the column header.
Click the **NetScaler System Security** node and review the system security settings and Citrix recommendations to improve the application safety index.

**Identify Applications That Require Immediate Attention**

The applications that need immediate attention are those having a high threat index and a low safety index.

In this example, both Microsoft Outlook and Microsoft Lync have a high threat index value of 6, but Lync has the lower of the two safety indexes. Therefore, you might have to focus your attention on Lync before improving the threat environment for Outlook.
Determine the Number of Attacks in a Given Period of Time

You might want to determine how many attacks occurred on a given application at a given point in time, or you might want to study the attack rate for a specific time period.

For example, you might want to view the number of attacks on Microsoft Lync in the past week. On the Security Insight dashboard, click Lync > Total Violations. By default, the graph is plotted for the last one hour.

To plot the graph of violations for the past week, from the time period list, select 1 Week. In this example, you see a surge in attacks from February 1.

Obtain Detailed Information about Security Breaches

You might want to view a list of the attacks on an application and gain insights into the type and severity of attacks,
actions taken by the NetScaler device, resources requested, and the source of the attacks.

For example, you might want to determine how many attacks on Microsoft Lync were blocked, what resources were requested, and the IP addresses of the sources.

On the Security Insight dashboard, click Lync > Total Violations. In the table, click the filter icon in the Action Taken column header, and then select Blocked.

For information about the resources that were requested, review the URL column. For information about the sources of the attacks, review the Client IP column.

**Determine the Safety Index before Deploying the Configuration**

Security breaches occur after you deploy the security configuration on a NetScaler device, but you might want to assess the effectiveness of the security configuration before you deploy it.

For example, you might want to assess the safety index of the configuration for the SAP application on the NetScaler device with IP address 10.102.60.27.

On the Security Insight dashboard, under Devices, click the IP address of the NetScaler device that you configured. You can see that both the threat index and the total number of attacks are 0. Threat index is a direct reflection of the number and type of attacks on the application. Zero attacks indicate that the application is not under any threat.
Click **Sap > Safety Index > SAP_Profile** and assess the safety index information that appears.

In the application firewall summary, you can view the configuration status of different protection settings. If a setting is set to log or if a setting is not configured, the application is assigned a lower safety index.
### Application Firewall Summary

<table>
<thead>
<tr>
<th>Protections</th>
<th>Configuration Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>XML Validation</td>
<td>Not Configured</td>
</tr>
<tr>
<td>XML SOAP Fault</td>
<td>Not Configured</td>
</tr>
<tr>
<td>XML Attachment</td>
<td>Not Configured</td>
</tr>
<tr>
<td>XML XSS</td>
<td>Not Configured</td>
</tr>
<tr>
<td>XML WSFI</td>
<td>Not Configured</td>
</tr>
</tbody>
</table>
Managing NetScaler Insight Center

May 04, 2017

The configuration tab provides the interface through which you can manage the NetScaler Insight Center virtual appliance. You can perform management activities such as modify the network configuration, update logon credentials of devices, configure user accounts, and manage client sessions. You can also restart NetScaler Insight Center and configure security settings. You can further configure mail notifications to receive emails whenever an alert is raised.

This topic includes the following details:

- Managing ICA Sessions
- Modifying the Network Configuration
- Updating Logon Credentials of Devices
- Modifying the Time Zone
- Configuring User Accounts
- Managing Client Sessions
- Restarting the NetScaler Insight Center
- Modifying System Security Settings
- Configuring Security Settings in NetScaler Insight Center
- Configuring Mail Notifications
- Configuring DNS Server

Updated: 2014-01-09

You can use the ICA session timeout feature to specify the time period for which an ICA session can remain in the idle state before being terminated. By default, if there is no flow of traffic, the session remains in active state for the first 2 minutes and then moves to idle state.

For example, if you set the ICA session timeout value to 5 minutes, a session in which there is no traffic remains active for 2 minutes and then enters the idle state. If there is still no traffic at the end of another 5 minutes, the session is terminated. If the session has any traffic during the (2+5=) 7-minute period, the session moves to active state.

**To set the ICA session time out value**

1. In the navigation pane, on the Configuration tab, click System.
2. In the System pane, under System Settings, click Change ICA Session Timeout.
3. In the Change ICA Session Timeout dialog box, set the Session Timeout value and click OK.

Updated: 2014-08-22

You can change the NetScaler Insight Center IP address, network mask, and gateway address that you specified for the NetScaler Insight Center virtual appliance during initial configuration.

**To modify the network configuration of NetScaler Insight Center**

On the Configuration tab, click System. Then, in the Setup NetScaler Insight Center group, click Network Configuration and enter the new value or values.
If the logon credentials of a device changes after it is added to the inventory, NetScaler Insight Center is not able to connect to that appliance. In the user interface, the State column in the Inventory list displays a yellow or red circle in the row that lists the appliance.

Note: There can be many other reasons for this state change. A change in logon credentials is just one of the possible causes. To resolve this issue, you must acquire information about the credential change from the administrator of the device and update NetScaler Insight Center.

**To update logon credentials for the NetScaler appliance**

1. On the Configuration tab, click Inventory.
2. Select the device for which you want to update the credentials, and from the Action drop-down list, select Update Login Credentials.
3. On the Update Login Credentials screen, enter the new credentials for the device.

**To modify the time zone**

On the Configuration tab, click System. Then, in the System Settings group, click Change Time Zone and select the time zone.

**To configure a user account**

On the Configuration tab, navigate to System > User Administration > Users and, in the Users pane, add or edit a user account.

**To view client sessions**

A client session is created when a user logs on to the NetScaler Insight Center virtual appliance. You can view all current client sessions in the Sessions pane, and you can end the session for a user.

To view client sessions, on the Configuration tab, in the navigation pane, expand System, and then click Sessions.

In the Sessions pane, you can view the following details:

- **User Name**—User account that is being used for the session.
• **IP Address**—IP address of the client from which the session has been created.
• **Port**—Port being used for the session.
• **Login Time**—Time at which the current session was created on NetScaler Insight Center.
• **Last Activity Time**—Time at which user activity was last detected in the session.
• **Session Expires In**—Time remaining before session expiry.

To end a client session, in the Sessions pane, click the session that you want to remove, and then click **End Session**.

**Note:** You cannot end a session from the client that initiated that session.

Updated: 2014-08-20

Restarting NetScaler Insight Center does not affect the devices monitored by NetScaler Insight Center. The devices continue to function during the restart process.

**To restart NetScaler Insight Center**

1. On the Configuration tab, in the navigation pane, click System.
2. In the System pane, under System Administration, click **Reboot NetScaler Insight Center**.
3. At the confirmation prompt, Click **Yes**.

Updated: 2014-08-22

NetScaler Insight Center applies a password policy and, optionally, a user-lockout policy to provide security against hackers and password-cracking software.

The password policy specifies the minimum length and complexity of a password. The user-lockout policy disables a user account if an incorrect password is entered a specified number of times.

You can specify the time period (user lockout interval) for how long the user account remains disabled, after which the user account is enabled automatically. A NetScaler Insight Center system administrator can enable a disabled user account within the user lockout interval.

**Note:** User lockout is disabled by default.

**To set the Password policy**

1. On the Configuration tab, navigate to System > User Administration.
2. In the User Configuration group, click **Password policy**, and set the password policy.

**To set the user-lockout policy**

1. On the Configuration tab, click System > User Administration.
2. In the User Configuration group, click **User Lockout Configuration** and set the user-lockout policy.

Updated: 2014-08-22

You must configure an email server to receive an email message each time an alert is raised. First configure an email server, and then configure a mail profile. In the mail profile, use semicolons to separate the addresses of the recipients.
To configure an email server

1. On the Configuration tab, navigate to System > Notifications > Email.
2. In the users pane, click Email Servers, and create an email server.

To configure an email distribution list

1. On the Configuration tab, navigate to System > Notifications > Email.
2. In the users pane, click Email Distribution List and then, create an email distribution list.

Updated: 2014-08-22

For security reasons, you can specify that all communication between NetScaler Insight Center and a device must be over a secure channel. You can also specify HTTPS-only access to NetScaler Insight Center user interface.

To modify system settings

On the Configuration tab, click System. Then, in the System Settings group, click Change System Settings and select the settings that you want to apply.

Note: You can specify the session timeout value for a particular user or a group. To define the user-session timeout value or group-session timeout value, on the Configuration tab, navigate to System > User Administration, click Users or Groups, click Add, and specify the value.

You can now configure a DNS server when you set up the NetScaler Insight Center. Configuring a DNS server helps resolve the host name of a server into its IP address.

For example, while creating an email server, you now have an option to specify the server name of the server rather than the IP address.

To configure a DNS server

On the Configuration tab, click System and, in the right pane, click Set Up wizard and specify the DNS server IP address.

Or

On the Configuration tab, click System, in the right pane, click Network Configuration and specify the DNS server IP address.
NetScaler Insight Center Deployment Management

Jan 07, 2016

See:

- Planning a NetScaler Insight Center Deployment
- Installing NetScaler Insight Center Scale-Out Deployment
Managing System Settings

May 04, 2017

You can perform various operations such as modifying the time zone, configuring security settings and managing ICA sessions on the NetScaler Insight Center configuration tab.

To perform these operations, on the Configuration tab, in the navigation pane, click System, and in the right pane, from the System Settings group, click the required setting.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modifying the Time Zone</td>
<td>You can modify the time zone used by the NetScaler Insight Center virtual appliance's clock. The default time zone is UTC.</td>
<td>In the System pane, in the System Settings group, click Change Time Zone.</td>
</tr>
<tr>
<td>Configuring Security Settings</td>
<td>For security reasons, you can specify that all communication between NetScaler Insight Center and a NetScaler appliance must be over a secure channel. You can also specify HTTPS-only access to NetScaler Insight Center user interface. Note: You can specify the session timeout value for a particular user or a group. To define the user session timeout value or group session timeout value, on the Configuration tab, navigate to System &gt; User Administration, click Users or Groups, click Add and then specify the values.</td>
<td>In the System pane, in the System Settings group, click Change System Settings.</td>
</tr>
<tr>
<td>Managing ICA Sessions</td>
<td>You can use the ICA session timeout feature to specify the time period for which an ICA session can remain in the idle state before being terminated. By default, if there is no flow of traffic, the session remains in active state for the first 2 minutes and then moves to Idle state. For example, if you set the ICA session timeout value to 5 minutes, a session in which there is no traffic remains active for 2 minutes and then enters the idle state. If there is still no traffic at the end of another 5 minutes, the session is terminated. If the session has any traffic during the (2+5=) 7-minute period, the session moves to active state.</td>
<td>In the System pane, in the System Settings group, click Change ICA Session Timeout and set the timeout value.</td>
</tr>
<tr>
<td>Change Database Cache Settings</td>
<td>The database cache functionality of NetScaler Insight Center stores database content locally in the cache and serves the content to users without accessing the database server. By default, this feature is enabled.</td>
<td>In the System pane, in the System Settings group, click Change Database Cache Settings and clear (reset) or enable the cache.</td>
</tr>
<tr>
<td>Change Data</td>
<td>Data record logs provide detailed information about appflow records that NetScaler Insight Center collects from NetScaler ADCs. These records are</td>
<td>In the System pane, in the System Settings group,</td>
</tr>
<tr>
<td>Task Settings</td>
<td>Description</td>
<td>Navigation</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Record Log Settings</td>
<td>useful in monitoring and troubleshooting NetScaler Insight Center issues. These AppFlow records are stored in <code>var/mps/log/mps_afdecoderlog.gz</code>. By default, this feature is enabled for HDX Insight and disabled for Web insight.</td>
<td>click Change Data Record Settings and select the required check box(es).</td>
</tr>
<tr>
<td>Change URL Parameter Settings</td>
<td>If the length of URLs displayed in the Web Insight reports is very long, you can enable the trim URL functionality to remove the query string from the URL. By default, this feature is enabled.</td>
<td>In the System pane, in the System Settings group, click Change URL Parameter Settings and clear or select the URL trimming option.</td>
</tr>
<tr>
<td>Change Database Cleanup Settings</td>
<td>When NetScaler Insight Center database saves a lot of data, the load on NetScaler Insight Center can become heavy, and the appliance might start to become unresponsive. The database cleanup setting ensures that content that is out-of-date is removed from the database.</td>
<td>In the System pane, in the System Settings group, click Change Database Cleanup Settings and enable database cleanup.</td>
</tr>
<tr>
<td>Change Database Index Settings</td>
<td>Enable the database indexing functionality to facilitate efficient querying of the NetScaler Insight Center database. Note: Disable this setting if the load on the database is higher than normal.</td>
<td>In the System pane, in the System Settings group, click Change Database Index Settings and change the setting.</td>
</tr>
<tr>
<td>Change Adaptive Threshold Setting</td>
<td>The adaptive threshold functionality in NetScaler Insight Center dynamically sets the threshold value for the maximum number of hits on each URL. If the maximum number of hits on a URL is greater than the threshold value set for the URL, a syslog message is sent to an external syslog server. The threshold value interval can be either days or weeks. Threshold-value calculation uses the following formula: Threshold value = Max hit * Threshold multiplier, where ● Max hit is the maximum number of hits on a URL. ● Threshold multiplier is a user-defined integer value (default: 2). For more details, see Appendix.</td>
<td>In the System pane, in the System Settings group, click Change Adaptive Threshold Setting.</td>
</tr>
<tr>
<td>Change HTTP Header Report Settings</td>
<td>The Web Insight report on the dashboard can include HTTP header reports, which display specified HTTP header metrics. Each set of metrics that you decide to display appears in a separate node. Following are some examples of situations in which these reports can be useful: ● An administrator wants to identify the HTTP Response codes that display 404 error messages. The Response Code report shows this information for all NetScaler ADCs being monitored.</td>
<td>In the System pane, in the System Settings group, click Change HTTP Header Report Settings, and select the reports to display. Verification</td>
</tr>
</tbody>
</table>
A browser (for example Internet Explorer 9) has some known issues, and the administrator would like to identify the number of users using that browser. The information is shown in the User Agent reports.
- An administrator would like to know the number of users who are using mobile devices to access the applications. That information is available in the Operating System reports.
- An administrator would like to see the statistics about request methods (for example GET and POST) used by clients to access the web application. The Request Status report includes that information.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limit Data Duration Persistency</td>
<td>You can limit the number of days for which the generated reports can persist in the database, after which the reports are permanently deleted.</td>
<td>In the System pane, under the System Settings group, click Limit Data Duration Persistency, and select the reports to display the settings.</td>
</tr>
<tr>
<td>Change Web Insight URL Data Collection Settings</td>
<td>If you do not want the URL reports to be displayed on the Web Insight node of the dashboard, disable the URL data collection settings.</td>
<td>In the System pane, under the System Settings group, click Change URL Data Collection Settings, and select the reports to display.</td>
</tr>
<tr>
<td>Change Dashboard Reporting Time Zone Settings</td>
<td>By default, the reports on the dashboard display your local time. You can choose to display the GMT time or your local time on the dashboard.</td>
<td>In the System pane, under the System Settings group, click Change Dashboard Reporting Time Zone Settings.</td>
</tr>
</tbody>
</table>
Configuring Authentication and Authorization Settings

Sep 29, 2016

Authentication with the NetScaler Insight Center appliance can be local or external. With external authentication, the NetScaler Insight Center appliance grants user access on the basis of the response from an external server. The NetScaler Insight Center supports simultaneous multiple external authentication methods. The external authentication methods that are supported are as follows:

- Remote Authentication Dial In User Service (RADIUS)
- Terminal Access Controller Access-Control System (TACACS)
- Lightweight Directory Access Protocol (LDAP)

The appliance also supports fallback to local authentication if all of the external authentication servers are not available to authenticate the users.

The NetScaler Insight Center appliance supports authentication requests from SSH. The SSH authentication supports only keyboard-interactive authentication requests. The authorization of SSH users is limited to Superuser privileges only. Users with readonly privileges cannot log on through SSH.

To configure authentication, specify the authentication type, and configure an authentication server.

Authorization through the NetScaler Insight Center appliance is local. The NetScaler Insight Center appliance supports two levels of authorization. Users with superuser privileges are allowed to perform any action on the appliance. Users with readonly privileges are allowed to perform only read operations. The authorization of SSH users is limited to superuser privileges only. Users with readonly privileges cannot log on through SSH.

Authorization for RADIUS and LDAP is supported by group extraction. You can set the group extraction attributes during the configuration of RADIUS or LDAP servers on the NetScaler Insight Center appliance. The extracted group name is matched with the group names on the NetScaler Insight Center appliance to determine the privileges given to the user. A user can belong to multiple groups. In that case, if any group to which the user belongs has superuser privileges, the user has superuser privileges. A Default authentication group attribute can be set during configuration. This group is considered along with the extracted groups for authorization.

In the case of TACACS authorization, the TACACS server administrator must permit a special command, superuser for a user who is to have superuser privileges and deny this command for users with readonly privileges. When a user logs on to NetScaler Insight Center, it checks if the user has permission to execute this command and if the user has permission, the user is assigned the superuser privileges else the user is assigned readonly privileges.

This topic provides you the following details:

- Configuring User Accounts
- Adding a User Group
- Setting the Authentication Type

Updated: 2014-08-22

A user logs on to the NetScaler Insight Center appliance to perform appliance management tasks. To allow a user to access the appliance, you must create a user account on the NetScaler Insight Center appliance for that user. Users are authenticated locally, on the appliance. You can also enable external authentication for the user and specify the amount
of time for which the a user can remain logged on.

**To configure a user account**

On the Configuration tab, navigate to System > User Administration > Users and, in the Users pane, add or edit a user account.

Updated: 2014-08-22

Groups are logical sets of users that need to access common information or perform similar kinds of tasks. You can organize users into groups defined by a set of common operations. By providing specific permissions to groups rather than individual users, you can save time when creating new users.

If you are using external authentication servers for authentication, groups in NetScaler Insight Center appliance can be configured to match groups configured on authentication servers. When a user belonging to a group whose name matches a group on an authentication server, logs on and is authenticated, the user inherits the settings for the group in NetScaler Insight Center appliance.

**To add a user group**

On the Configuration tab, navigate to System > User Administration > Groups, and then, create a user group.

Updated: 2014-08-22

From the NetScaler Insight Center graphical user interface (GUI), you can specify local or external authentication. External authentication is disabled for local users by default. It can be enabled by checking the Enable External Authentication option when adding the local user or modifying the settings for the user.

Important: External authentication is supported only after you set up a RADIUS, LDAP, or TACACS authentication server.

**To set the authentication type**

1. On the Configuration tab, navigate to System > Authentication.
2. In the details pane, click Authentication Configuration.
3. Set the following parameters:
   - **Server Type**—Type of authentication server configured for user authentication. Possible values: LDAP, RADIUS, TACACS, and Local.
   - **Server Name**—Name of the authentication server configured in the NetScaler Insight Center appliance. The menu lists all the servers configured for the selected authentication type.
   - **Enable fallback local authentication**—Alternatively, you can choose to authenticate a user with the local authentication when external authentication fails. This option is enabled by default.
4. Click OK.
Configuring the External Authentication Server

May 04, 2017

The NetScaler Insight Center appliance can authenticate users with local user accounts or by using an external authentication server. The appliance supports the following authentication types:

- **Local**—Authenticates to the NetScaler Insight Center appliance by using a password, without reference to an external authentication server. User data is stored locally on the NetScaler Insight Center appliance.
- **RADIUS**—Authenticates to an external RADIUS authentication server.
- **LDAP**—Authenticates to an external LDAP authentication server.
- **TACACS**—Authenticates to an external Terminal Access Controller Access-Control System (TACACS) authentication server.

To configure an external authentication, specify the authentication type, and configure an authentication server.

Updated: 2014-04-08

To configure RADIUS authentication, specify the authentication type as RADIUS, and configure the RADIUS authentication server.

NetScaler Insight Center supports RADIUS challenge response authentication according to the RADIUS specifications. RADIUS users can be configured with a one-time password on RADIUS server. When the user logs on to NetScaler Insight Center appliance, the user is prompted to specify this one time password.

To add a RADIUS server

1. On the **Configuration** tab, under **System**, expand **Authentication**, and then click **Radius**.
2. In the details pane, click **Add**.
3. In the Create Radius Server dialogue box, type or select values for the parameters:
   - **Name**—Name of the server.
   - **IP Address**—Server IP address.
   - **Port**—Port on which the RADIUS server is running. Default value: 1812.
   - **Time-out**—Number of seconds the system will wait for a response from the RADIUS server. Default value: 3.
   - **Secret Key**—Key shared between the client and the server. This information is required for communication between the system and the RADIUS server.
   - **Enable NAS IP Address Extraction**—If enabled, the system's IP address is sent to the server as the "nasip" in accordance with the RADIUS protocol.
   - **NASID**—If configured, this string is sent to the RADIUS server as the "nasid" in accordance with the RADIUS protocol.
   - **Group Prefix**—Prefix string that precedes group names within a RADIUS attribute for RADIUS group extraction.
   - **Group Vendor ID**—Vendor ID for using RADIUS group extraction.
   - **Group Attribute Type**—Attribute type for RADIUS group extraction.
   - **Group Separator**—Group separator string that delimits group names within a RADIUS attribute for RADIUS group extraction.
   - **IP Address Vendor Identifier**—Vendor ID of the attribute in the RADIUS which denotes the intranet IP. A value of 0 denotes that the attribute is not vendor encoded.
   - **IP Address Attribute Type**—Attribute type of the remote IP address attribute in a RADIUS response.
To add an LDAP server

1. On the Configuration tab, under System, expand Authentication, and then click LDAP.
2. In the details pane, click Add.
3. In the Create LDAP Server dialogue box, type or select values for the parameters:
   - Name*—Name of the server.
   - IP Address*—Server IP address.
   - Port*—Port on which the LDAP server is running. Default value: 389.
   - Time-out*—Number of seconds the system will wait for a response from the LDAP server.
   - Base DN—Base, or node where the LDAP search should start.
   - Type—Type of LDAP server. Possible values: Active Directory (AD) and Novell Directory Service (NDS).
   - Administrative Bind DN—Full distinguished name that is used to bind to the LDAP server.
   - Administrative Password—Password that is used to bind to the LDAP server.
   - Confirm Administrative Password—Password that is used to bind to the LDAP server.
   - Validate LDAP Certificate—Check this option to validate the certificate received from LDAP server.
   - LDAP Host Name—Hostname for the LDAP server. If the validateServerCert parameter is enabled, this parameter specifies the host name on the certificate from the LDAP server. A host-name mismatch causes a connection failure.
   - Server Logon Name Attribute—Name attribute used by the system to query the external LDAP server or an Active Directory.
   - Search Filter—String to be combined with the default LDAP user search string to form the value. For example, vpnallowed=true with ldaploginame samaccount and the user-supplied username bob would yield an LDAP search string of: (&(vpnallowed=true)(samaccount=bob)).
   - Group Attribute—Attribute name for group extraction from the LDAP server.
   - Sub Attribute Name—Subattribute name for group extraction from the LDAP server.
   - Security Type—Type of encryption for communication between the appliance and the authentication server. Possible values: PLAINTEXT: No encryption required.
   - TLS: Communicate using TLS protocol
   - SSL: Communicate using SSL Protocol
   - Default Authentication Group—Default group that is chosen when the authentication succeeds in addition to extracted groups.
   - Referrals—Enable following of LDAP referrals received from LDAP server.
Enable Change Password—Allow user to modify the password if the password expires. You can change the password only when the Security Type configured is TLS or SSL.

Enable Nested Group Extraction—Enable Nested Group extraction feature.

Maximum Nesting Level—Number of levels at which group extraction is allowed.

Group Name Identifier—Name that uniquely identifies a group in LDAP server.

Group Search Attribute—LDAP group search attribute. Used to determine to which groups a group belongs.

Group Search Subattribute—LDAP group search subattribute. Used to determine to which groups a group belongs.

Group Search Filter—String to be combined with the default LDAP group search string to form the search value.

4. Click Create, and then click Close.

Updated: 2014-04-08

To configure TACACS authentication, specify the authentication type as TACACS, and configure the TACACS authentication server.

To add a TACACS server

1. On the Configuration tab, under System, expand Authentication, and then click TACACS.
2. In the details pane, click Add.
3. In the Create TACACS Server dialogue box, type or select values for the parameters:
   - Name—Name of the TACAS server
   - IP Address—IP address of the TACAS server
   - Port—Port on which the TACAS Server is running. Default value: 49
   - Time-out—Maximum number of seconds the system will wait for a response from the TACAS server
   - TACACS Key — Key shared between the client and the server. This information is required for the system to communicate with the TACAS server
   - Confirm TACACS Key — Key shared between the client and the server. This information is required for the system to communicate with the TACAS server
   - Default Authentication Group—Default group that is chosen when the authentication succeeds in addition to extracted groups.
4. Click Create, and then click Close.
Working with SSL Files

May 04, 2017

Before installing an SSL certificate, you must upload the SSL files to NetScaler Insight Center. Installing an SSL certificate terminates all current client sessions with the NetScaler Insight Center, so you have to log in again for any additional configuration tasks.

This topic includes the following details:
- Uploading SSL files to the NetScaler Insight Center
- Installing an SSL Certificate
- Viewing SSL Certificate Details

Updated: 2014-08-22

For any SSL transaction, the server needs a valid certificate and the corresponding private and public key pair. The certificate file must be present on the NetScaler Insight Center virtual appliance when you install the SSL certificate on NetScaler Insight Center. You can also download the SSL Certificate and key files to a local computer as a backup.

To upload SSL certificate files to NetScaler Insight Center

1. On the Configuration tab, expand NetScaler Insight Center, and then click SSL Certificate files.
2. In the SSL Certificates pane, from the Action drop-down list, select Upload.
3. In the Upload SSL Certificate dialog box, click Browse and select the certificate file that you want to upload.

To create a backup for an SSL certificate file

On the SSL Certificates pane, select the file that you want to download, and then from the Action drop-down list, select Download and browse to the location where you want to save the file.

Updated: 2014-08-22

After installing the certificate and key files, you can install the SSL certificate.

To install an SSL certificate on NetScaler Insight Center

On the Configuration tab, click System, and in the Setup NetScaler Insight Center group, click Install SSL Certificate and install the SSL certificate.

The NetScaler Insight Center virtual appliance uses an SSL certificate for secure client connections. After installing the certificate, you can view details such as certificate's validity status, issuer, subject, days to expiration, valid from and to dates, version, and serial number.

To view the SSL certificate on NetScaler Insight Center

1. In the navigation pane, click System.
2. In the System pane, under Setup NetScaler Insight, click View SSL Certificate. The certificate details appear.
You can configure your NetScaler Insight Center virtual appliance to synchronize its local clock with the Network Time Protocol (NTP) server used by your servers and device. NetScaler Insight Center then has the same date and time settings as the other servers and appliances in your network. The clock synchronization configuration does not change if NetScaler Insight Center is restarted, upgraded, or downgraded.

The clock is synchronized immediately if you add a new NTP server or change any of the authentication parameters. You can also explicitly enable and disable NTP synchronization.

Note: If you do not have a local NTP server, you can find a list of public and open access NTP servers at the official NTP site, http://www.ntp.org. Before configuring a device or other network entity to use a public NTP server, be sure to read the Rules of Engagement page (link included on all Public Time Servers pages).

### Configuring Clock Synchronization

- **Configuring an NTP Server**
- **Enabling an NTP Synchronization**
- **Modifying the Authentication Options**

#### To add an NTP server

1. On the Configuration tab, expand System > NTP Servers.
2. In the details pane, create or modify an NTP server.

#### To enable an NTP synchronization

On the Configuration tab, navigate to System > NTP Servers, Then, in the users pane, from the Action drop-down list, select NTP Synchronization and enable NTP synchronization.

#### To modify the authentication options

On the Configuration tab, navigate to System > NTP Servers, and in users pane, from the Action drop-down list, select Authentication Parameters and modify the authentication options.
Change Adaptive Threshold Setting

May 04, 2017

The adaptive threshold functionality in NetScaler Insight Center dynamically sets the threshold value for the maximum number of hits on each URL. If the maximum number of hits on a URL is greater than the threshold value set for the URL, a syslog message is sent to an external syslog server. The threshold value can be set for an interval of one day or one week.

Threshold-value calculation uses the following formula: Threshold value = Max hit * Threshold multiplier where
- Max hit is the maximum number of hits on a URL.
- Threshold multiplier is a user-defined integer value (default: 2).

Note: The adaptive threshold functionality is supported only on NetScaler 10.1.e.

Example

In the following example, duration of the threshold is set to Day.

On day 1, a syslog message is not sent because a threshold value is not calculated by NetScaler Insight Center for the previous day.

On day 2, if the maximum number of hits on a URL is 60 and the threshold value set by NetScaler Insight Center is 30 (Max Hit on day 1 * Threshold multiplier), the threshold value of day 2 is less than the maximum number of hits on day 2. Therefore, a syslog message is sent to an external syslog server.

On day 3, if the maximum number of hits on a URL is 10 and the threshold value is 120 (maximum hit on day 2 * Threshold multiplier), the threshold value of day 3 is greater than the maximum number of hits on day 3. Therefore, a syslog message is not sent to an external syslog server.

The following table shows an example of how a threshold value is calculated:

<table>
<thead>
<tr>
<th>Day</th>
<th>URL</th>
<th>Max Hit</th>
<th>Threshold Multiplier</th>
<th>Threshold value = Max Hit * Threshold multiplier</th>
<th>Syslog sent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day 1</td>
<td>URL1</td>
<td>15</td>
<td>2</td>
<td>No threshold value is configured for Day 1</td>
<td>No</td>
</tr>
<tr>
<td>Day 2</td>
<td>URL1</td>
<td>60</td>
<td>2</td>
<td>15*2 = 30</td>
<td>Yes Day 2 Max Hit (60) &gt; Day 2 threshold value (30)</td>
</tr>
<tr>
<td>Day 3</td>
<td>URL1</td>
<td>10</td>
<td>2</td>
<td>60*2 = 120</td>
<td>No Day 3 Max hit (10) &lt; Day 3 threshold value (120)</td>
</tr>
</tbody>
</table>

Note: To configure a syslog server, see Configuring Syslog Server.

Setting the threshold value in NetScaler Insight Center

1. On the Configuration tab, navigate to NetScaler Insight Center>Thresholds.
2. Click Add.
3. In the Create Thresholds dialog box, set the following parameters:
   - Name—Threshold name
   - Resource Type—URL
   - Duration—Duration of the threshold (Day or Week)
- Threshold Multiplier—User-defined integer value

4. Click Create.
Configure DNS Server

May 04, 2017
You can now configure a DNS server when you set up the NetScaler Insight Center. Configuring a DNS server helps resolve the host name of a server into its IP address.

For example, while creating an email server, you now have an option to specify the server name of the server rather than the IP address.

To configure a DNS server

On the Configuration tab, click System and, in the right pane, click Set Up wizard and specify the DNS server IP address.

Or

On the Configuration tab, click System, in the right pane, click Network Configuration and specify the DNS server IP address.
The audit logs and task logs contain information which is useful in monitoring NetScaler Insight Center operations and troubleshooting NetScaler Insight Center issues. Additionally, you can monitor the syslog events generated by the devices in the NetScaler Insight Center inventory.

This topic includes the following details:

- Using Audit Logs
- Using Task Logs
- Monitoring Syslog Events
- Contacting Technical Support

Audit logs provide detailed information about user-initiated operations that are performed on the NetScaler Insight Center.

**To view audit logs**

1. On the Configuration tab, navigate to System > Audit.
2. View the following details of operations performed:
   - **User name**—Name of the user who performed the operation.
   - **IP Address**—IP address of the devices on which the operation was performed.
   - **Port**—Port at which the system was sending and receiving data when the operation was performed.
   - **Resource Type**—Type of resource on which the operation was performed.
   - **Resource Name**—Name of the resource used to perform the operation, and the user name used to log in.
   - **Audit Time**—Time when the audit log was generated.
   - **Operation**—Task that was performed, such as add, delete, or log out.
   - **Status**—Status of the audit, such as success or failure.
   - **Message**—Message describing the status of a task and the cause of failure (if the operation failed).

Tasks logs provide detailed information about the operations that NetScaler Insight Center performs on NetScaler appliances. The Task Logs category includes subcategories for devices and commands. The three types of logs can be described as follows:

- **Task Logs**—The operations that were performed.
- **Device Logs**—The devices on which the operations were performed.
- **Command Logs**—The NetScaler or CloudBridge commands that were executed.

**To view the task logs**

1. On the Configuration tab, navigate to Diagnostics > Task Log.
2. View the following details of tasks that were performed on the devices.
- **Name**—Name of the task that is being executed or has already been executed.
- **Status**—Status of the task, such as In progress, Completed, or Failed.
- **Executed by**—NetScaler Insight Center user who performed the operation.
- **Start time**—Time at which the task started.
- **End time**—Time at which the task ended.

3. Click a task to view the device logs. This is a list of the devices on which the operation was executed.
   - **Status**—Status of the operation, such as In progress, Completed, or Failed.
   - **IP address**—IP address of the device.
   - **Start Time**—Time at which the operation started.
   - **End Time**—Time at which the operation ended.

4. Click a device to view the command logs. This is a list of the commands that were executed on that device.
   - **Status**—Status of the operation, such as In progress, Completed, or Failed.
   - **Message**—Message describing the status of operation.
   - **Command**—The command that was executed.
   - **Start Time**—Time at which the command started.
   - **End Time**—Time at which the command ended.

Updated: 2014-08-20

You can monitor the syslog events generated by the devices in the NetScaler Insight Center inventory if you have configured the NetScaler Insight Center virtual appliance to redirect all syslog messages to the syslog servers. To monitor syslog events, you have to designate a syslog server. A syslog server is an external server that displays the log events generated by NetScaler Insight Center. After you configure the syslog server, you can view the details of the events generated by the devices.

### Designating a Syslog Server

1. On the Configuration tab, navigate to System > Syslog Servers.
2. In the Syslogs Servers pane, click Add.
3. Enter the following details in the Add SysLog Server dialog box:
   - **Name**—Name of the syslog server.
   - **IP Address**—IP address of the syslog server.
   - **Port**—Port at which the system sends and receives data when the operation is performed. By default, the port value is 514.
   - **Log Levels**—Select any of the log levels displayed.
4. Click Add. The syslog server is displayed on the Syslogs Servers pane.

Note: You can also select the date and time format to be displayed in the logs by selecting System Logs Parameters from the Action drop-down list.

### Viewing Syslogs

1. On the Configuration tab, navigate to System > System logs.
2. The following details are displayed on System Logs pane:
   - **Severity**—Severity of the issue
   - **Source**—IP address of the virtual server
   - **Date**—Time and date when the issue was logged
Citrix recommends that before contacting technical support for debugging an issue, you generate an archive of the NetScaler Insight Center data and statistics. The archive is a TAR file that you send to the technical support team.

**To create and send an archive file**

1. On the Configuration tab, navigate to Diagnostics > Technical Support.
2. In the Generate Technical Support File dialog box, select either or all of the following and click OK.
   - Collect Debug Logs
   - Collect Data Distribution Logs
   The archive file is created as a TAR file.
3. Download the file.
   1. In the Technical Support pane, select the file to be downloaded.
   2. From the Action drop-down list, select the Download option.
   3. In the File Download message box, click Save.
   4. In the Save As message box, browse to the location where you want to save the file, and then click Save.
4. Email the file to the Citrix technical support team.
Troubleshooting Tips

Jan 31, 2017

Following are some reported problems and their resolutions.

I cannot see any records on the NetScaler Insight Center dashboard.
If no reports appear on the dashboard after you have enabled AppFlow for at least one virtual server on a NetScaler ADC or NetScaler Gateway that has been added to the inventory, check the following:

- Is the NetScaler Insight Center version the same as or higher than the NetScaler ADC version?
- Does the NetScaler ADC have the required license for NetScaler Insight Center to collect data? For details, see Licensing Information.
- Are all the configurations implemented from NetScaler Insight center, and not from the NetScaler ADC?
- Did you wait for 5 minutes for the data to appear on the dashboard? If not, wait for at least 5 minutes for NetScaler Insight Center to display the data.
- Is the configuration utility displaying any repeating error messages? If so, check to see if there are any core dumps in the /var/core directory.
- Is AppFlow enabled on the NetScaler appliance?
- Is AppFlow logging enabled on the virtual servers (load balancing, content switching, or VPN virtual servers) of the NetScaler appliance?
- Is AppFlow enabled for the services and service groups that are bound to the load balancing virtual servers?
- Does the AppFlow policy for the virtual server have the highest priority for which AppFlow is most recently enabled? (If AppFlow is enabled for a virtual server on more than one NetScaler Insight Center virtual appliance, the virtual appliance on which AppFlow was most recently enabled for the NetScaler appliance collects the information). Follow the below procedure to check the priority:
  1. On the NetScaler appliance, navigate to Traffic Management.
  2. Expand Load Balancing, or expand Content Switching and then click Virtual servers.
  3. Double-click the virtual server for which you want to see if AppFlow is enabled.
  4. In the Configure Virtual Server (Load Balancing) or Configure Virtual Server (Content Switching) dialog box, on the Policies tab, click the arrow in the right corner of the dialog box.
  5. Select AppFlow from the drop-down list.
  6. Check if the AppFlow policy name has the highest priority.
- Also, from the command line interface, run the sh appflow global command to make sure that the global AppFlow policies do not override the virtual server policies.
- Are the NetScaler Insight Center virtual appliances and port values set correctly on the NetScaler appliance? To check:
  2. Under Policy manager select AppFlow policy Manager.
  3. Select a virtual server (LB virtual server or CS Virtual server).
  4. Double click Action Name and verify that if the NetScaler Insight Center IP address and port are correct.
- On the NetScaler appliance, is traffic flowing through the virtual server for which data collection was enabled in NetScaler Insight Center? Also verify that the hits counter is increasing on the AppFlow policy, by running the following command from the NetScaler command line interface:
  sh appflow policy <policyname>
- Is UDP port 4739 on the NetScaler Insight Center virtual appliance reachable from NetScaler appliance?
- To see Web Insight records, run the following command on the NetScaler command line interface to check if Log only
client-side traffic is set to NO.

show appflow param

Example

> show appflow param

AppFlow parameters

  IPFIX template refresh interval: 3600 seconds
  Appname refresh interval: 60 seconds
  IPFIX flow record export interval: 60 seconds
  IPFIX UDP Path MTU: 1472 bytes
  HTTP URL logging: ENABLED
  AAA username logging: ENABLED
  HTTP cookie logging: ENABLED
  HTTP referer logging: ENABLED
  HTTP method logging: ENABLED
  HTTP host logging: ENABLED
  HTTP user-agent logging: ENABLED
  HTTP Content-Type header logging: ENABLED
  HTTP Authorization header logging: ENABLED
  HTTP Via header logging: ENABLED
  HTTP X-Forwarded-For header logging: ENABLED
  HTTP Location header logging: ENABLED
  HTTP Setcookie header logging: ENABLED
  HTTP Setcookie2 header logging: ENABLED
  Log only client-side traffic: NO
  Connection Chaining: DISABLED

If Log only client-side traffic is set to YES, then run the following command to change the setting to NO:

set appflow param -clientTrafficOnly (YES | NO)

Example:

set appflow param -clientTrafficOnly NO

• Is NetScaler Insight Center receiving data records from the device?

To verify that NetScaler Insight Center is receiving data records,

• On the NetScaler Insight Center virtual machine, open the mps_afdecoder.log file located in /var/mps/log/ and check
to see if the file displays text similar to the following once every second:

Monday, 22 Dec 14 20:12:03 +0000 [Debug] For AFProto Thread id :: 34473829696, Elapsed time is: 1010014 microsec, Packet pick up is: 19, Packet processed is: 19, Decode rate is: 18/sec, Mean decode rate is: 13/sec, Data record processed is: 29, Data record routed is: 15

Following are descriptions of the parameters in the above text:

• Elapsed time is: Time consumed, in microseconds, since NetScaler Insight Center last displayed this text.

• Packet pick up is: Number of UDP packets that NetScaler Insight Center has received in the elapsed time.

• Packet processed is: Number of UDP packets that NetScaler Insight Center has processed in the elapsed time.

• Decode rate is and Mean decode rate is: Rate at which NetScaler Insight Center has received UDP packets.

• Data record processed is: Number of data records present in the UDP packets that were successfully decoded.

(One UDP packet can contain more than one data record).
- Data record routed is: Number of data records that were routed properly to a proper handler (such as Web Insight or HDX Insight).

  If the **Data record routed** parameter's value is consistently zero, the NetScaler Insight Center virtual machine is not receiving any valid data records. Check the device’s AppFlow configuration, or contact the technical support team to debug the issue.

- On the NetScaler Insight Center virtual machine, in the mps_afdecoder.log file located at /var/mps/log/, check to see if NetScaler Insight Center displays the data records, such as:
  - ica_session_setup, ica_session_network_update, and ica_session_update, every second for HDX Insight.
  - l7_ch_to_ns, ns_es4ns_client_load and ns_es4ns_client_render records every second for Web Insight.

  If it displays these records, the data records are being sent to NetScaler Insight Center. Otherwise, check the device's AppFlow configuration.

- Are the data record logs enabled for Web Insight and/or HDX Insight?

  To check, on the **Configuration** tab, click **System**, and in the right pane, select **Change Data Record Log Settings** and verify that the HDX Insight Logs or/and Web Insight logs option is selected.

  Note: Web Insight logs are disabled by default.

  Enable Web Insight Logs only if the value of **Data record routed** parameter in the var/mps/log/mps_afdecoder.log file is in the range of 1 to 20. If the value is more than 20, disable AppFlow on the virtual server that has high traffic. If you enable Web Insight logs for a virtual server that has high traffic, the load on the mps_afdecoder.log file can become heavy and the appliance can become unresponsive.

**NetScaler Insight Center does not display reports for a particular user name. What should I do?**

If you suspect that a particular user report is not being displayed, on the NetScaler Insight Center virtual machine, open the mps_afdecoder.log files located in /var/mps/log/ file and run the following command:

```
grep <username> < mps_afdecoder.log
```

If the output includes the user name, the user record is displayed in the reports. If the output does not display the user name, verify that the Citrix Receiver version being used is supported by NetScaler Insight Center. For details, see **Supported Software**.

**Why does the WAN latency and DC latency metrics display the values zero?**

If the latency is less than 1 millisecond, the WAN latency and DC latency values are displayed as zero.

**I am not able to add a NetScaler appliance. What are the possible reasons?**

- Make sure that NetScaler appliance you add is UP and reachable when you add it to the Inventory. If the appliance is DOWN, or OUT-OF-SERVICE, you cannot add it to the Inventory.
- Make sure that you have not added a standalone Access Gateway Standard appliance.

**The session up time value is incorrect.**

Make sure that the times set for the NetScaler appliance and NetScaler Insight Center are correct and in sync. For more information, see **Configuring Clock Synchronization**.

**The graphs are not clearly displayed or they look scrambled.**

Clear the browser cache and retry. Also make sure the NetScaler Insight Center is supported on the browser. For details, see **Accessing the NetScaler Insight Center**.

**I am unable to log on to NetScaler Insight Center through the Internet Explorer browser.**

The browser might be set in compatibility mode. To disable compatibility mode, go to **Tools > Compatibility View Settings** and clear the **Display all websites in Compatibility View** check box.
If you still cannot access NetScaler Insight Center after you disable the compatibility mode in Internet Explorer version 8 or 9, make sure that the browser mode and document mode in the browser are set to the same version. To view the configuration, press F12. Set the values to either Internet Explorer 8 or Internet Explorer 9.

Why does the RTT metric display an incorrect value? Or, The ICA RTT is shown as N/A on the NetScaler Insight Center reports. What should I do?

To debug this issue, check to see if the EUEM value on XenApp or XenDesktop is enabled or not. If EUEM is disabled, then NetScaler Insight Center does not display the ICA RTT values. If EUEM is enabled, and ICA RTT is shown as N/A, then perform each of the following diagnostic operations sequentially till the issue is resolved.

- Check if the Citrix End User Experience Monitoring (EUEM) configurations are enabled on the XenApp server:
  1. From the Citrix AppCenter, navigate to Citrix Resources > XenApp > Farm > Policies.
  2. On the Settings tab, go to ICA > End User Monitoring and make sure that the following configurations are enabled:
     - ICA Round Trip Calculation
     - ICA Round Trip Calculation Interval
     - ICA Round Trip Calculation for Idle Connections
  3. Verify the configurations.
     1. Check for ICA RTT policy entries in the registry.
        1. Open the command prompt from your Windows machine.
        2. Type regedit and press Enter.
        4. Make sure that the following configurations are available:
           - ICA Round Trip Calculation
           - ICA Round Trip Calculation Interval
           - ICA Round Trip Calculation for Idle Connections
     2. Make sure that the services for these configurations are set to Automatic.
        1. Open the command prompt from your Windows machine.
        2. Type services.msc and press Enter.
        3. In the Services dialog box, make sure that Citrix End User Experience Monitoring is listed and the Startup Type is set to Automatic.
- If you are using a virtual desktop application, make sure that the Startup Type is set to Automatic. This has to be done on the master image.
1. Open the command prompt from your Windows machine.
2. Type `services.msc` and press Enter.
3. In the Services dialog box, make sure that **Citrix End User Experience Monitoring** is listed and the Startup Type is set to Automatic.

- Make sure that the Citrix EUEM Hotfix is available.
1. Open the command prompt from your Windows machine.
2. Type `appwiz.cpl` and press Enter.
3. On the Uninstall or Change a Program dialog box, make sure that the **Citrix HotFix XA650R01W2K8R2X64064** for the XenApp 6.5 with R01 server is installed.
- Make sure that the value of `flowRecordInterval` parameter on the NetScaler ADC is set to 60 seconds. To verify, run the following command on the NetScaler appliance:
  ```bash
  show appflow param
  ```
  Confirm by checking if the following output parameter is set to 60:
  ```
  IPFIX flow record export interval: 60 seconds
  ```
  If the value is not 60, then set the value by running the following command:
  ```bash
  set appflow param -flowRecordInterval 60
  ```
- After you start the XenApp or XenDesktop traffic, wait for two or three minutes and check to see the ICA RTT value in NetScaler Insight Center reports.
- Check if NetScaler Insight Center dashboard displays session ID as NON-EUEM as shown in the following image:

![NetScaler Insight Center Report](https://docs.citrix.com)

- Make sure that the ICA connections actively send data.
- Verify the XenApp or XenDesktop versions.

### Table 1. XenApp/XenDesktop Versions and builds

<table>
<thead>
<tr>
<th>Product</th>
<th>HDX Insight</th>
</tr>
</thead>
<tbody>
<tr>
<td>XenApp</td>
<td>6.5, build 6682 with HRP01</td>
</tr>
<tr>
<td>XenDesktop</td>
<td>5.6, build 56060</td>
</tr>
<tr>
<td></td>
<td>7.0 and higher versions</td>
</tr>
</tbody>
</table>

### Table 2. Operating systems and receiver details

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Receiver version</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Operating system</td>
<td>Receiver version</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Windows 7</td>
<td>3.4 Enterprise Edition</td>
</tr>
<tr>
<td></td>
<td>4.0 Standard Edition</td>
</tr>
<tr>
<td>Windows 8</td>
<td>3.4 Enterprise Edition</td>
</tr>
<tr>
<td></td>
<td>4.0 Standard Edition</td>
</tr>
<tr>
<td>Mac</td>
<td>11.8, build 238301 and above</td>
</tr>
<tr>
<td></td>
<td>Note: Mac client does not support ICA RTT reports for CloudBridge version 7.3.0.</td>
</tr>
<tr>
<td>Linux</td>
<td>13 and above</td>
</tr>
</tbody>
</table>

- Make sure that the ICA RTT calculation for idle connections is enabled on the XenApp server. For details, see **To add settings to a policy**

Note: If none of the debugging options work, contact technical support to install the Sems Com Plugin test tool on Xenapp Server to see if you receive ICA RTT events.

**An error message is displayed when I add the NetScaler appliance to the NetScaler Insight Center inventory.**

Make sure that the GUI is accessible, by verifying that port is open for communication. To do so, run the following command from the command line interface:

```
show ns ip <ipaddress>
```

Example: show ns ip 10.102.60.31

IP: 10.102.60.31

  Netmask: 255.255.255.128
  Type: NetScaler IP
  ...
  ...
  ...
  gui: Enabled
  ...
  ...
  ...

If GUI is set to `secureonly`, then make sure that all communication between NetScaler Insight Center and a NetScaler appliance is over a secure channel. For more information, see "Modifying System Security Settings" in **Managing NetScaler Insight Center**.

Also, make sure that proper licenses are available for the NetScaler appliances that are added in NetScaler Insight Center inventory. For more information, see **Licensing Information**. Also check if the required ports are open for communication. For more details, see **Ports**.

**I am not able to clear all the AppFlow related configurations for a selected virtual server by using the NetScaler Insight Center graphical user interface.**
Log on to the NetScaler appliance by using the graphical user interface and delete the required collector and action. To delete the action name, perform the following procedure:

2. Select the AppFlow action name that you want to delete.
3. Click Remove.

To delete the collector, perform the following procedure:

1. Navigate to System > AppFlow > Collectors.
2. Select the Collector name that you want to delete.
3. Click Remove.

The following error is displayed when I upgrade the NetScaler Insight Center appliance: "Backup/ Restore operation in progress. Try after some time."

Reboot the NetScaler Insight Center appliance or run the following commands at the NetScaler Insight Center shell prompt:

```
/etc/rc.d/analyticsd stop
/etc/rc.d/analyticsd start
```

**The HDX Insight node does not appear on the NetScaler Insight Center dashboard.**

Make sure that proper licenses are available for the NetScaler appliances that are added in NetScaler Insight Center inventory. For more information, see Licensing Information. Also check if the required ports are open for communication. For more details, see Ports.

**An error message is displayed when I access NetScaler Insight Center using Internet Explorer 8.**

Some features of NetScaler Insight Center are not support on Internet Explorer 8. You can access the appliance using Internet Explorer 9. For more details on browser support, see Accessing NetScaler Insight Center.

**I cannot see the waterfall chart or the Page Analysis button on the NetScaler Insight Center dashboard.**

Check the following possible causes:

1. Is the HTML Injection check box selected?
2. Is the URL response content type of the web page in text or HTML format? NetScaler Insight Center does not display the waterfall charts if the response type is anything other than text or HTML.
3. Was the transaction for the web page successful? Make sure the response header indicates 200 OK.
4. Were the page rendering and loading successful? If either fails, the timing information is not received from the client and the waterfall charts are not displayed.
5. Check to see if the transactions are served by the NetScaler appliance (either NetScaler generated or served from NetScaler cache). If so, the waterfall charts are not displayed.
6. Is the appropriate license installed on the NetScaler appliance?

**NetScaler Insight Center does not display the HDX Insight reports for CloudBridge appliances. What should I do?**

- Check the firewall configuration and make sure that the CloudBridge appliance and NetScaler Insight Center communicate over port 4739.
- Wait for 2 to 3 minutes after the traffic is generated. NetScaler Insight Center usually takes two to three minutes to display the HDX Insight reports for a user.
- Check the CloudBridge discovery status on the NetScaler Insight Center Inventory.
- Make sure that CloudBridge ICA connections are accelerated with Disk Based Compression (DBC) policy. To verify, on the Monitoring tab, navigate to Optimization > Connections, and in the right pane check to see if the Compression Type is Disk for ICA service class.
- Also, on the Configuration tab, navigate to Optimization Rules > Service Classes and in the right pane, expand ICA and...
click Edit. The Acceleration Policy selected must be Disk.

- On the CloudBridge appliance, make sure that the configuration for Appflow HDX Data set is enabled. Also, make sure that the update Interval is set to one minute and NetScaler Insight Center collector IP or port should not be deleted. To verify, on the Configuration tab, navigate to Appliance Settings > AppFlow and verify the values on the right pane.

The HDX Insight reports display the Uptime as 'Negative.' What should I do?
Make sure that the NTP server is configured on both CloudBridge appliance and NetScaler Insight Center. To add an NTP server on NetScaler Insight Center, see Configuring Clock Synchronization.

Note: If you have configured the NTP server at a later point of time, then, run the drop_table command from the NetScaler Insight Center Command Line Interface (CLI). Then discover the appliance again and establish a new ICA connection.

How do I verify if the CloudBridge appliance is displaying the correct values?
1. On the Monitoring tab of the CloudBridge appliance, navigate to Optimization > ICA Advanced, and click the Conn Info tab to make note of the ICA session Conn ID.
   Figure 2. CloudBridge Appliance Conn Info tab

   2. On the ICA Advanced page, click the Conn Stats tab, and check to see if the EUEM ICA RTT value is non-zero for that particular ICA session ID.
   Figure 3. CloudBridge Appliance Conn Stats Table

If the configurations are correct, then for any one of those active sessions, check to see if the ICA RTT is a non-zero value for the same session ID in NetScaler Insight Center.
   Figure 4. NetScaler Insight Center Report

NetScaler Insight Center does not display the geo maps. What should I do?
If NetScaler Insight Center does not display the geo maps, then make sure to follow the below steps:
1. Make sure to upload the geo database file:
   1. On the Configuration tab, expand NetScaler Insight Center, and then click Geo Database Files.
   2. From the Action drop-down menu, select Upload.
   3. In the Upload Geo Database File window, click Browse.
   4. Navigate to the location of the geo database file, GeoLiteCity.dat, and then click Upload.
2. Enable geo data collection.
   1. On the Configuration tab, click Inventory.
   2. From the inventory list, select the IP address of the NetScaler appliance for which you want to enable geo data collection.
3. In the NetScaler Insight Center Inventory Setup pane, select the Enable geo data collection check box.
NITRO API

May 04, 2017

With the NetScaler Insight Center NITRO protocol, you can configure and monitor the NetScaler Insight Center virtual appliance programmatically.

NITRO exposes its functionality through Representational State Transfer (REST) interfaces. Therefore, NITRO applications can be developed in any programming language. Additionally, for applications that must be developed in Java or .NET or Python, NITRO APIs are exposed through relevant libraries that are packaged as separate Software Development Kits (SDKs).

Note: You must have a basic understanding of NetScaler Insight Center before using NITRO.

To use the NITRO protocol, the client application needs only the following:

- Access to a NetScaler Insight Center virtual appliance.

- To use REST interfaces, you must have a system that can generate HTTP or HTTPS requests (payload in JSON format) to the NetScaler Insight Center virtual appliance. You can use any programming language or tool.

- For Java clients, you must have a system on which Java Development Kit (JDK) 1.5 or above version is available. The JDK can be downloaded from http://www.oracle.com/technetwork/java/javase/downloads/index.html.

- For .NET clients, you must have a system on which .NET framework 3.5 or above version is installed. The .NET framework can be downloaded from http://www.microsoft.com/downloads/en/default.aspx.

- For Python clients, you must have a system with Python 2.7 or above version and the Requests library (available in <NITRO_SDK_HOME>/lib) installed.
Obtaining the NITRO Package

May 04, 2017

The NITRO package is available as a tar file on the Downloads page of the NetScaler Insight Center virtual appliance’s configuration utility. You must download and un-tar the file to a folder on your local system. This folder is referred to as <NITRO_SDK_HOME> in this documentation.

The folder contains the NITRO libraries in the lib subfolder. The libraries must be added to the client application classpath to access NITRO functionality. The <NITRO_SDK_HOME> folder also provides samples and documentation that can help you understand the NITRO SDK.

Note:
- The REST package contains only documentation for using the REST interfaces.
- For the Python SDK, the library must be installed on the client path. For installation instructions, read the <NITRO_SDK_HOME>/README.txt file.
How NITRO Works

May 04, 2017

The NITRO infrastructure consists of a client application and the NITRO Web service, which runs on a NetScaler Insight Center virtual appliance. The communication between the client application and the NITRO web service is based on REST architecture and uses HTTP or HTTPS.

Figure 1. NITRO execution flow

As shown in the above figure, a NITRO request is executed as follows:

1. The client application sends a REST request message to the NITRO web service. When using the SDKs, an API call is translated into the appropriate REST request message.
2. The web service processes the REST request message.
3. The NITRO web service returns the corresponding REST response message to the client application. When using the SDKs, the REST response message is translated into the appropriate response for the API call.

To minimize network traffic, you retrieve the whole state of a resource from the server, modify the state of the resource locally, and then upload it back to the server in one network transaction.

Note: Local operations on a resource (changing its properties) do not affect its state on the server until the state of the object is explicitly uploaded.

NITRO APIs are synchronous in nature. The client application waits for a response from the NITRO web service before executing another NITRO API.
You can use NetScaler Insight Center NITRO APIs to programmatically register a NetScaler appliance with the NetScaler Insight Center virtual appliance, gather performance data, and generate a report on this data. You can also troubleshoot NITRO operations by using the nitro_exception class.

This topic includes the following details:
- Logging on to the NetScaler Insight Center Appliance
- Registering a NetScaler Appliance
- Gathering Performance Data about an Application
- Generating Performance Reports
- Exception Handling

The first step toward using NITRO is to establish a session with the NetScaler Insight Center virtual appliance and then authenticate the session by using the administrator's credentials.

On the client system, create an object of the com.citrix.insight.nitro.service.nitro_service class by specifying the IP address of the NetScaler Insight Center virtual appliance and the protocol for connecting to the virtual appliance (HTTP or HTTPS). You then use this object to log on to the appliance.

Note: You cannot log on to a NetScaler Insight Center virtual appliance unless you have a user account on the virtual appliance. The configuration operations that you perform are limited by the administrative roles assigned to your account.

The following sample code establishes an HTTPS session with a NetScaler Insight Center virtual appliance with IP address 10.102.126.213:

```
//Specify the NetScaler Insight appliance IP address and protocol
nitro_service ns_insight_session = new nitro_service("10.102.126.213","https");
//Specify the login credentials
ns_insight_session.login("admin","verysecret");
```

Note: You must use the nitro_service object in all further NITRO operations on the appliance. By default, the connection to the appliance expires after 30 minutes of inactivity. You can modify the timeout period by specifying a new timeout period (in seconds) in the login method. For example, to modify the timeout period to 60 minutes:

```
ns_insight_session.login("admin","verysecret",3600);
```

The com.citrix.insight.nitro.resource.config.mps.managed_device class provides APIs to register a NetScaler appliance with the NetScaler Insight Center virtual appliance. You must specify the NetScaler IP (NSIP) address, the user name, and the password of the NetScaler appliance.

The following sample code registers a NetScaler appliance with IP address 10.102.29.60:

```
managed_device obj = new managed_device();
obj.set_ip_address("10.102.29.60");
obj.set_profile_username("admin");
obj.set_profile_password("verysecret");
obj.set_type("ns");
managed_device managed_device_result = managed_device.add(ns_insight_session, obj);
```

Updating a NetScaler Appliance's Login Credentials

If the login credentials of a NetScaler appliance are updated after it is registered to a NetScaler Insight Center virtual appliance, they have to be updated on the virtual appliance.

The following sample code updates the credentials of a NetScaler appliance:

```
managed_device device[] = managed_device.get(ns_insight_session);
device_profile result[] = device_profile.get_filtered(ns_insight_session,"name:"+ device[1].get_profile_name());
device_profile obj = result[0];
obj.set_username("admin");
obj.set_password("newverysecretpassword");
device_profile.update(ns_insight_session, obj);
```

To gather performance data from applications (virtual servers) available on NetScaler appliances that are registered with the NetScaler Insight Center appliance, you must:

1. Identify the application (virtual server) from which you want to collect information.
2. Specify the expression on which the virtual server information must be filtered.
3. Enable AppFlow on that application.

The appliance starts gathering performance data for the application. To display the performance data, see Generating Performance Reports.

The following sample code gets the list of all the available load balancing virtual servers that are available on the NetScaler appliance 10.102.29.60 and enables appflow on a load balancing virtual server named http_test:

```
// Get the list of all load balancing virtual servers
String filter = "ns_ip_address:10.102.20.60,type:lb";
ns_vserver_appflow_config result[] = ns_vserver_appflow_config.get_filtered(client, filter);
for (int i = 0; i < result.length; i++)
{
   System.out.println("Name: " + result[i].get_name() + ", IP Address:" + result[i].get_ip_address() + ", Type:" + result[i].get_type()+ ", Appflow State:" + result[i].get_appflowlog());
}
```

// Enable appflow on one of the virtual servers
ns_vserver_appflow_config new_obj = new ns_vserver_appflow_config();
new_obj.set_ns_ip_address("10.102.29.60");
new_obj.set_type("lb");

// Virtual server whose performance data must be gathered
new_obj.set_name("http_test");
new_obj.set_servicetype("http");

// Policy rule
new_obj.set_appflow_policy_rule("true");

// Enable appflow data collection log
new_obj.set_appflowlog("enabled");

// Enable client side data collection log
new_obj.set_es4nslog("enabled");

ns_vserver_appflow_config ns_vserver_appflow_config_result = ns_vserver_appflow_config.add(client, new_obj);

Note: To stop gathering data, disable AppFlow on the application.

The com.citrix.insight.nitro.resource.config.af.device class provides the APIs to generate and view reports about applications. You must retrieve the details of the application and specify the period for which you want the details.

The following sample code generates a report for a load balancing virtual server named http_test:

device device_obj = new device();
options option_obj =  new options();
option_obj.set_duration("last_1_month");
option_obj.set_pageno(1);
option_obj.set_pagesize(25);
option_obj.set_args("app_unit_name:http_test");
device.get_with_options(ns_insight_session, option_obj);

for (int i = 0; i < result.length; i++)
{
    System.out.println("Application: " + result[i].get_name() + ", Total requests: " + result[i].get_total_requests() + ", Total bytes: " + result[i].get_total_bytes() + ", Application response time: " + result[i].get_ap
}
You can use NetScaler Insight Center NITRO APIs to programmatically register a NetScaler appliance with the NetScaler Insight Center virtual appliance, gather performance data, and generate a report on this data. You can also troubleshoot NITRO operations by using the nitro_exception class.

This topic includes the following details:
- Logging on to the NetScaler Insight Center Appliance
- Registering a NetScaler Appliance
- Gathering Performance Data about an Application
- Generating Performance Reports
- Exception Handling

The first step toward using NITRO is to establish a session with the NetScaler Insight Center virtual appliance and then authenticate the session by using the administrator's credentials.

On the client system, create an object of the com.citrix.insight.nitro.service.nitro_service class by specifying the IP address of the NetScaler Insight Center virtual appliance and the protocol for connecting to the virtual appliance (HTTP or HTTPS). You then use this object to log on to the appliance.

Note: You cannot log on to a NetScaler Insight Center virtual appliance unless you have a user account on the virtual appliance. The configuration operations that you perform are limited by the administrative roles assigned to your account.

The following sample code establishes an HTTPS session with a NetScaler Insight Center virtual appliance with IP address 10.102.126.213:

```csharp
//Specify the NetScaler Insight appliance IP address and protocol
nitro_service ns_insight_session = new nitro_service("10.102.126.213","https");

//Specify the login credentials
ns_insight_session.login("admin","verysecret");
```

Note: You must use the nitro_service object in all further NITRO operations on the appliance.

By default, the connection to the appliance expires after 30 minutes of inactivity. You can modify the timeout period by specifying a new timeout period (in seconds) in the login method. For example, to modify the timeout period to 60 minutes:

```csharp
ns_insight_session.login("admin","verysecret",3600);
```

The com.citrix.insight.nitro.resource.config.mps.managed_device class provides APIs to register a NetScaler appliance with the NetScaler Insight appliance. You must specify the NetScaler IP (NSIP) address, the user name, and the password of the NetScaler appliance.

The following sample code registers a NetScaler appliance with IP address 10.102.29.60:

```csharp
managed_device obj = new managed_device();
obj.ip_address = "10.102.29.60";
obj.profile_username = "admin";
obj.profile_password = "verysecret";
obj.type = "ns";
managed_device managed_device_result = managed_device.add(ns_insight_session, obj);
```

Updating NetScaler Appliance's Logon Credentials

If the login credentials of a NetScaler appliance are updated after it is registered to a NetScaler Insight Center appliance, they have to be updated in the Insight appliance.

The following sample code updates the credentials of a NetScaler appliance:

```csharp
managed_device_device_result = managed_device.get(ns_insight_session);
device_profile result[] = device_profile.get_filtered(ns_insight_session,"name:" + device[1].profile_name);
device_profile obj = result[0];
obj.username = "admin";
obj.password = "newverysecretpassword";
device_profile.update(ns_insight_session, obj);
```

To gather performance data from applications (virtual servers) available on NetScaler appliances that are registered with the NetScaler Insight Center appliance, you must:

1. Identify the application (virtual server) from which you want to collect information.
2. Specify the expression with which to filter the virtual server information.

The appliance starts gathering performance data about the application. To display the performance data, see Generating Performance Reports.

The following sample code gets the list of all the available load balancing virtual servers that are available on the NetScaler appliance 10.102.29.60 and enables appflow on a load balancing virtual server named http_test:

```csharp
// Get the list of all load balancing virtual servers
String filter = "ns_ip_address:10.102.20.60,type:lb";
ns_vserver_appflow_config result[] = ns_vserver_appflow_config.get_filtered(client, filter);
for (int i = 0; i < result.length; i++)
{
    Console.WriteLine("Name: " + result[i].name + ", IP Address: " + result[i].ip_address + ", Type: " + result[i].type + ", Appflow State: " + result[i].appflowlog);
}
```

To enable appflow on one of the virtual servers:
ns_vserver_appflow_config new_obj = new ns_vserver_appflow_config();
new_obj.ns_ip_address = "10.102.29.60";
new_obj.type = "lb";

// Virtual server whose performance data must be gathered
new_obj.name = "http_test";
new_obj.servicetype = "http";

// Policy rule
new_obj.appflow_policy_rule = "true";

// Enable appflow data collection log
new_obj.appflowlog = "enabled";

// Enable client side data collection log
new_obj.es4nslog = "enabled";

ns_vserver_appflow_config ns_vserver_appflow_config_result = ns_vserver_appflow_config.add(client, new_obj);

Note: To stop gathering data, disable AppFlow on the application.

Updated: 2014-03-24

The com.citrix.insight.nitro.resource.config.af.device class provides the APIs to generate and view reports of applications. You must retrieve the details and specify the period for which you want the details.

The following sample code generates a report for a load balancing virtual server named http_test:

device device_obj = new device();

options option_obj = new options();
option_obj.duration = "last_1_month";
option_obj.pageno = 1;
option_obj.pagesize = 25;
option_obj.args = "app_unit_name:http_test";

device.get_with_options(ns_insight_session, option_obj);

for (int i = 0; i < result.length; i++)
{
    Console.WriteLine("Application: " + result[i].name + ", Total requests: " + result[i].total_requests + ", Total bytes: " + result[i].total_bytes + ", Application response time: " + result[i].application_response_time);
}

The status of a NITRO request is captured in the com.citrix.insight.nitro.exception.nitro_exception class. This class provides the following details about the exception:

- **Session ID.** The session in which the exception occurred.
- **Error code.** The status of the NITRO request. An error code of 0 indicates that the NITRO request is successful. A non-zero error code indicates an error in processing the NITRO request.
- **Error message.** A brief description of the exception.

Note: For a list of error codes, see the errorlisting.html file available in the \<NITRO_SDK_HOME>\doc\folder.
Python SDK

May 04, 2017

You can use NetScaler Insight Center NITRO APIs to programmatically register a NetScaler appliance with the NetScaler Insight Center virtual appliance, gather performance data, and generate a report on this data. You can also troubleshoot NITRO operations by using the nitro_exception class.

This topic includes the following details:
- Logging on to the NetScaler Insight Center Appliance
- Registering a NetScaler Appliance
- Gathering Performance Data about an Application
- Generating Performance Reports
- Exception Handling

Updated: 2014-06-16

The first step toward using NITRO is to establish a session with the NetScaler Insight Center virtual appliance and then authenticate the session by using the administrator's credentials.

On the client system, create an object of the insightsrc.com.citrix.insight.nitro.service.nitro_service class by specifying the IP address of the NetScaler Insight Center virtual appliance and the protocol for connecting to the virtual appliance (HTTP or HTTPS). You then use this object to log on to the appliance.

Note: You cannot log on to a NetScaler Insight Center virtual appliance unless you have a user account on the virtual appliance. The configuration operations that you perform are limited by the administrative roles assigned to your account.

The following sample code establishes an HTTPS session with a NetScaler Insight Center virtual appliance with IP address 10.102.126.213:

```python
# Specify the NetScaler Insight appliance IP address and protocol
ns_insight_session = nitro_service("10.102.126.213","https")

# Specify the login credentials
ns_insight_session.login("admin","verysecret")
```

Note: You must use the nitro_service object in all further NITRO operations on the appliance.

Note: By default, the connection to the appliance expires after 30 minutes of inactivity. You can modify the timeout period by specifying a new timeout period (in seconds) in the login method. For example, to modify the timeout period to 60 minutes:

```python
ns_insight_session.login("admin","verysecret",3600)
```

Updated: 2014-06-16

The insightsrc.com.citrix.insight.nitro.resource.config.mps.managed_device class provides APIs to register a NetScaler appliance with the NetScaler Insight Center virtual appliance. You must specify the NetScaler IP (NSIP) address, the user name, and the password of the NetScaler appliance.

The following sample code registers a NetScaler appliance with IP address 10.102.29.60:

```python
obj = managed_device()
obj.ip_address = "10.102.29.60"
obj.profile_username = "admin"
obj.profile_password = "verysecret"
obj.type = "ns"
managed_device_result = managed_device.add(ns_insight_session, obj)
```

Updating a NetScaler Appliance's Login Credentials

If the login credentials of a NetScaler appliance are updated after it is registered to a NetScaler Insight Center virtual appliance, they have to be updated on the virtual appliance.

The following sample code updates the credentials of a NetScaler appliance:

```python
device = managed_device.get(ns_insight_session)
result = device_profile.get_filtered(ns_insight_session,"name:" + device[1].profile_name)
obj = result[0]
obj.username = "admin"
obj.password = "newverysecretpassword"
device_profile.update(ns_insight_session, obj)
```

Updated: 2014-06-12

To gather performance data from applications (virtual servers) available on NetScaler appliances that are registered with the NetScaler Insight Center appliance, you must:

1. Identify the application (virtual server) from which you want to collect information.
2. Specify the expression on which the virtual server information must be filtered.
3. Enable AppFlow on that application.

The appliance starts gathering performance data for the application. To display the performance data, see Generating Performance Reports.

The following sample code gets the list of all the available load balancing virtual servers that are available on the NetScaler appliance 10.102.29.60 and enables appflow on a load balancing virtual server named "http_test":

```python
# Get the list of all load balancing virtual servers
filter = "ns_ip_address:10.102.20.60,type:lb"
result = ns_vserver_appflow_config.get_filtered(client, filter)
for i in range(len(result)):
    print "Name : " + result[i].name + " , IPAddress : " + result[i].ip_address + " , Type : " + result[i].type + " , Appflow State : " + result[i].appflowlog

# Enable appflow on one of the virtual servers
new_obj = ns_vserver_appflow_config()
new_obj.ns_ip_address = "10.102.29.60"
new_obj.type = "lb"

# Virtual server whose performance data must be gathered
new_obj.name = "http_test"
new_obj.service_type = "http"

# Policy rule
new_obj.appflow_policy_rule = "true"

# Enable appflow data collection log
new_obj.appflowlog = "enabled"

# Enable client side data collection log
new_obj.es4nslog = "enabled"

ns_vserver_appflow_config_result = ns_vserver_appflow_config.add(client, new_obj)

Note: To stop gathering data, disable AppFlow on the application.

Updated: 2014-06-16

The insightsrc.com.citrix.insight.nitro.resource.config.af.device class provides the APIs to generate and view reports about applications. You must retrieve the details of the application and specify the period for which you want the details.

The following sample code generates a report for a load balancing virtual server named "http_test":

device_obj = device()
option_obj = options()
option_obj.duration = "last_1_month"
option_obj.pageno = 1
option_objpagesize = 25
option_obj.args = "app_unit_name:http_test"

result = device.get_with_options(ns_insight_session, option_obj)
for i in range(len(result)):
    print "Application: " + result[i].name + " , Total requests: " + result[i].total_requests + " , Total bytes: " + result[i].total_bytes + " , Application response time: " + result[i].application_response_time

Updated: 2014-06-16

The status of a NITRO request is captured in the insightsrc.com.citrix.insight.nitro.exception.nitro_exception class. This class provides the following details about the exception:

- **Session ID.** The session in which the exception occurred.
- **Error code.** The status of the NITRO request. An error code of 0 indicates that the NITRO request is successful. A non-zero error code indicates an error in processing the NITRO request.
- **Error message.** A brief description of the exception.

Note: For a list of error codes, see the errorlisting.html file available in the <NITRO_SDK_HOME>/doc/api_reference folder.
REST Web Service

Dec 08, 2015

REST (REpresentational State Transfer) is an architectural style based on simple HTTP requests and responses between the client and the server. REST is used to query or change the state of objects on the server side. In REST, the server side is modeled as a set of entities where each entity is identified by a unique URL.

Each resource also has a state on which the following operations can be performed:

- **Create.** Clients can create new server-side resources on a "container" resource. You can think of container resources as folders, and child resources as files or subfolders. The calling client provides the state for the resource to be created. The state can be specified in the request by using XML or JSON format. The client can also specify the unique URL that identifies the new object. Alternatively, the server can choose and return a unique URL identifying the created object. The HTTP method used for Create requests is POST.

- **Read.** Clients can retrieve the state of a resource by specifying its URL with the HTTP GET method. The response message contains the resource state, expressed in JSON format.

- **Update.** You can update the state of an existing resource by specifying the URL that identifies that object and its new state in JSON or XML using the PUT HTTP method.

- **Delete.** You can destroy a resource that exists on the server-side by using the DELETE HTTP method and the URL identifying the resource to be removed.

In addition to these four CRUD operations (Create, Read, Update, and Delete), resources can support other operations or actions. These operations use the HTTP POST method, with the request body in JSON specifying the operation to be performed and parameters for that operation.

This topic includes the following details:

- Logging on to the NetScaler Insight Center Appliance
- Registering a NetScaler Appliance
- Gathering Performance Data about an Application
- Generating Performance Reports
- Exception Handling

The first step toward using NITRO is to establish a session with the NetScaler Insight Center virtual appliance and then authenticate the session by using the administrator's credentials. You must specify the username and password in the login object. The session ID that is created must be specified in the request header of all further operations in the session.

Note: You cannot log on to the NetScaler Insight Center virtual appliance unless you have a user account on the appliance. The configuration operations that you can perform are limited by the administrative roles assigned to your account.

To connect to a NetScaler Insight virtual appliance with IP address 10.102.126.213 by using the HTTPS protocol:

- **URL.** https://10.102.126.213/nitro/v2/config/login/
- **HTTP Method.** POST
- **Request.**
  - **Header**
    - Content-Type: application/vnd.com.citrix.insight.login+json
    - Note: Content types such as 'application/x-www-form-urlencoded' that were supported in earlier versions of NITRO can also be used. You must make sure that the payload is the same as used in earlier versions. The payloads provided in this documentation are only applicable if the content type is of the form 'application/vnd.com.citrix.insight.login+json'.
  - **Payload**
    - 
      "login":
      
      "username":"admin",


"password":"verysecret"

]
]

}  

}  

- **Response.**
  - **Header**
    HTTP/1.0 201 Created
    Set-Cookie:
    NITRO_AUTH_TOKEN=##87305E9C51B06C848F0942; path=/nitro/v2

Note: You must use the session ID in all further NITRO operations on the virtual appliance.

Note: By default, the connection to the virtual appliance expires after 30 minutes of inactivity. You can modify the timeout period by specifying a new timeout period (in seconds) in the login object. For example, to modify the timeout period to 60 minutes, the request payload is:

```json
{
  "login":
  {
    "username":"admin",
    "password":"verysecret",
    "timeout":3600
  }
}
```

You can also connect to the appliance to perform a single operation, by specifying the username and password in the request header of the operation. For example, to connect to an appliance while registering a NetScaler appliance:

- **URL.** https://10.102.126.213/nitro/v2/config/managed_device/
- **HTTP Method.** POST
- **Request.**
  - **Header**
    X-NITRO-USER:admin
    X-NITRO-PASS:verysecret
    Content-Type:application/vnd.com.citrix.insight.managed_device+json
  - **Payload**
    ```json
    {
      "managed_device":
      {
        "ip_address":"10.102.29.60",
        "profile_username":"admin",
        "profile_password":"verysecret",
        "type":"ns"
      }
    }
    ```
  - **Response.**
    - **Header**
      HTTP/1.0 201 Created

To disconnect from the virtual appliance, use the DELETE method:

- **URL.** https://10.102.126.213/nitro/v2/config/login/
- **HTTP Method.** DELETE
- **Request.**
  - **Header**
    Cookie:NITRO_AUTH_TOKEN=tokenvalue
    Content-Type:application/vnd.com.citrix.insight.login+json
To register a NetScaler appliance with the NetScaler Insight Center appliance, you must specify the NetScaler IP (NSIP) address, the user name, and the password of the NetScaler appliance in the managed_device object.

To register a NetScaler appliance with NSIP address 10.102.29.60:

- **URL**: https://10.102.126.213/nitro/v2/config/managed_device/
- **HTTP Method**: POST
- **Request**
  - **Header**
    - Cookie:NITRO_AUTH_TOKEN=tokenvalue
    - Content-Type:application/vnd.com.citrix.insight.managed_device+json
  - **Payload**
    ```json
    {
      "managed_device":
      {
        "ip_address":"10.102.29.60",
        "profile_username":"admin",
        "profile_password":"verysecret",
        "type":"ns"
      }
    }
    ```

To retrieve a list of NetScaler appliances configured on an Insight appliance:

- **URL**: http://10.102.126.213/nitro/v2/config/managed_device/
- **HTTP Method**: GET
- **Request**
  - **Header**
    - Cookie:NITRO_AUTH_TOKEN=tokenvalue

Among other parameters, the response payload provides an identity for each NetScaler appliance. You must use this ID to identify a NetScaler in further operations.

**Updating NetScaler Appliance’s Login Credentials**

If the login credentials of a NetScaler appliance are updated after it is registered to a NetScaler Insight Center appliance, they have to be updated on the Insight appliance.

To update the password of a NetScaler appliance with IP address 10.102.29.60:

- **URL**: https://10.102.126.213/nitro/v2/config/device_profile/
- **HTTP Method**: PUT
- **Request**
  - **Header**
    - Cookie:NITRO_AUTH_TOKEN=tokenvalue
    - Content-Type:application/vnd.com.citrix.insight.device_profile+json
  - **Payload**
    ```json
    {
      "device_profile":
      {
        "username":"admin",
        "password":"verysecret-new",
        "id":"507be920475294e414f90889"
      }
    }
    ```
Note: The ID of the NetScaler appliance must be obtained by using the GET HTTP method on the http://10.102.126.213/nitro/v2/config/managed_device/ URL.

To gather performance data from an appliance, you must select the virtual server, specify the filter condition, and then enable Appflow on the appliance in the ns_vserver_appflow_config object. The appliance then starts gathering performance data for the applications (services) bound to the virtual server.

Note: This operation gathers the performance data but does not display.

To gather performance data of an application linked to virtual server with name “http_test”:

- **URL**: http://10.102.126.213/nitro/v2/config/ns_vserver_appflow_config/
- **HTTP Method**: PUT
- **Request**
- **Header**
  - Cookie:NITRO_AUTH_TOKEN=tokenvalue
  - Content-Type:application/vnd.com.citrix.insight.ns_vserver_appflow_config+json
- **Payload**
  ```json
  {
    "ns_vserver_appflow_config": {
      "appflow_policy_rule":"TRUE",
      "appflowlog":"enabled",
      "es4nslog":"enabled",
      "name":"http_test",
      "state":"UP",
      "ns_ip_address":"10.102.29.60",
      "ip_address":"10.102.126.237",
      "type":"lb",
      "servicetype":"HTTP"
    }
  }
  ```

To generate a report of the performance data of an application (a virtual server), you must specify the period for which you want the data in the URL.

To generate a report of the performance data for a device with IP address 10.102.71.201, for the past one month:

- **URL**: http://10.102.60.45/nitro/v2/appflow/user_agent?
  - args=device_ip_address:10.102.71.201&asc=no&order_by=total_requests&pagesize=25&type=total_requests&duration=last_1_month

  where,
  - asc=no: Displays records in descending order.
  - order_by=total_requests: Orders records on the basis of the total requests.
  - pagesize=25: Displays 25 records per page.
  - type=total_requests: Total requests to be displayed.
  - duration=last_1_month: Records of the last one month must be displayed.
- **HTTP Method**: GET
- **Response Payload**
  ```json
  {
    "user_agent": [
      
    ]
  }
  ```
The response header provides the status of an operation by using HTTP status codes and the response payload provides the requested resource object (for GET method) and error details (for unsuccessful operation). NITRO does not provide a response payload for successful POST, PUT and DELETE methods. For successful GET method, the response payload consists only the requested resource object.

For a more detailed description of the error codes, see the API reference available in the `<NITRO_SDK_HOME>/doc` folder.